Panasonic

Operating Instructions
Geometric & Setup Management Software

Geometry Manager Pro Ver. 7.0

Windows

Thank you for purchasing this Panasonic product.

m Before using this software, please read the instructions carefully.
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Precautions and Disclaimers

® Precautions regarding security
When using the “Geometric & Setup Management Software” (Geometry Manager Pro), security breaches of the type
described below are conceivable.

® Leakage of your private information via this software

® lllegal operation of this software by a malicious third-party

® Harm to or cessation of operation of this software by a malicious third-party

Be sure to implement sufficient security measures.
® Make sure the password is as hard to guess as possible.
® Change the password periodically.
® Panasonic Connect Co., Ltd. and its affiliated companies never directly ask customers for their password. Do not give out
your password even if directly asked by a third-party representing themselves as Panasonic Connect Co., Ltd.
Run Windows Update regularly to keep your computer up to date.
Always use on a network that has safety protection such as a firewall implemented.
Set the password for the computer you are using in order to set limits on user accessibility.

® This software makes use of the following software.
A portion of this software is based in part on the work of the Independent JPEG Group.

® The illustrations and display examples used in this manual may differ from the actual product.

@® Panasonic Connect Co., Ltd. cannot be held liable for damages arising from data corruption or loss as a result of using this
projector.



What You Can Do with “Geometry Manager Pro”

Using this software allows you to perform real-time geometric compensation and other fine adjustments and corrections that
cannot be handled on the projector side.

Even when you use this software, however, some functions and expanded functions may be limited if projector and computer
activation are not completed.

&= “Activation” (page 12)

& “Functions which are expanded as a result of activation” (page 32)

In addition, the correction and adjustment functions may be limited with some models.

B Geometry correction

When projecting images onto a screen surface that is not perfectly flat (such as the
wall of a building) or projecting them onto a screen surface at an angle, the images
become distorted.

When projecting images in these kinds of special environments, the geometry
correction function serves to correct the images to counter the shape of the screen
surface.

m Edge blending

This function serves to correct the brightness and makes the joins between the
images less visible when the images projected from a multiple number of projectors
are combined to form a single image.

B Uniformity

This function makes it possible to correct color irregularities in projected images
— for example, those resulting from irregularities in the screen surface or from
surrounding light and shade.

B Masking

This function makes it possible to mask certain parts of the projected images,
projecting only the required parts.

H Auto Screen Adjustment (AUTO ADJUST)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the
shape of the screen through use of a camera.

® Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” must be
installed to use the Auto Screen Adjustment function.
® To use the Auto Screen Adjustment function, prepare a camera separately. & “Camera connection” (page 115)

m Other functions

Lens adjustment, color matching, color adjustment, and input signal adjustment can be performed.
Some of the projector’'s menu operations can also be carried out on a computer screen.



Check Your Computer

System requirements

The computer must meet the following requirements in order to use the supplied software.

OS: Microsoft Windows 11 (Windows 11 Home/Pro 64bit)
Windows 10 (Windows 10 Home/Pro 64bit)
Compatible with English, Japanese or Chinese language versions of the above operating systems.
CPU: At least minimum required by OS
Memory: At least minimum required by OS
Available disk space:
16 GB or greater (Further available space is necessary to save projector information)
Other requirements:
A display with a resolution of 1 600 x 900 pixel or higher using High Color (16 bit) or higher
LAN port for a wired LAN (10Base-T/100Base-TX / 1000Base-T)
USB 2.0-compatible port or higher (when using the Auto Screen Adjustment function with a camera)

® Please understand that operation is not guaranteed if this software application is used in a system environment other than
that specified above or on a home-built computer.

Proper operation cannot be guaranteed for all computers even if they satisfy the above requirements.

Necessary Environment for Computers to be Connected

Be sure to check the following settings when connecting projectors to the computer via a wired LAN connection.

Computer with a built-in LAN function
® |s your LAN switched on?

Computer without a built-in LAN function
® |s your LAN adapter properly recognized?

Please install the LAN adapter driver beforehand.

For details on how to install the driver, please refer to instructions accompanying the LAN adapter.
® |s your LAN adapter switched on?

@ |t may not be possible to establish a connection with the projector if security (firewall) software or utility software for LAN
adapter are installed.
&~ “Frequently Asked Questions” (page 161)

® Operation is not guaranteed for all LAN adapters and built-in LAN adapters in the computers.

® An Internet connection is required to perform activation.



Installing/Uninstalling Software

Installation

Quit any applications running in Windows before starting installation. Failure to do so may result in improper installation.

Installing “Geometric & Setup Management Software” (Geometry Manager Pro)

1 Download the software.

® Download “Geometry Manager Pro”.
Log in to PASS*! on the following website, click [Software Download], and follow the on-screen instructions to
download the software.
https://panasonic.net/cns/projector/pass/
You must be registered with PASS to log in to it.
*1 PASS: Panasonic Professional Display and Projector Technical Support Website.

To enable use of the Auto Screen Adjustment function, download the “Auto Screen Adjustment plug-in software” as well.

&= “Installing the “Auto Screen Adjustment plug-in software” (page 8)

2 The installer starts up.

Double-click the downloaded “Installer.exe” file.

15 Geometry Manager Pro Ver. X XX - X

Welcome to the Geometry Manager Pro Ver X.X.X A
Setup Wizard el 48

The installer wil guide you though the steps required to install Geometry Manager Pro Ver XXX on
your computer

WBRNING: This computer program is protected by copyright law and intermational treaties.
Unauthorized duplication o distribution of this program, or any portion of it may result in severe civil
or ciiminal penalties, and will be prosecuted to the maximum extent possible under the law.

Follow the on-screen instructions to install the application.

Perform this procedure using an account with administrator privileges.

3 As soon as the installation process is completed, a shortcut icon is created on the desktop.

zeometny
ManagerPro

If an identical version of the software is already installed, the following screen for selecting whether to repair or remove the
existing version appears.



Installing/Uninstalling Software Installation

5 Geometry Manager Pro VerX.X.X — x

Welcome to the Geometry Manager Pro Ver X.X.X o
Setup Wizard e}

Select whether you want to repai or remove Geomety Manager ProWer XXX

®) Repair Geometty Manager Pro Ver X3
() Remove Geometry Manager Pra Ver 3300

Cancel <Back

+ To repair defects in the software, select “Repair Geometry Manager Pro”, and click [Finish].

To uninstall the existing version before installing the software again, select [Remove Geometry Manager Pro], and
click [Finish].

Installing the “Auto Screen Adjustment plug-in software”

1 Download the “Auto Screen Adjustment plug-in software”.

® Both “Geometry Manager Pro” and the “Geometry Manager Pro - Auto Screen Adjustment plug-in software” are
necessary to use the Auto Screen Adjustment function.
Log in to PASS on the following website, click [Software Download], and follow the on-screen instructions to download
the “Auto Screen Adjustment plug-in software”.
https://[panasonic.net/cns/projector/pass/

2 The installer starts up.

Double-click the downloaded “Auslinstaller.exe” file, and follow the on-screen instructions to install the application.

® Perform this procedure using an account with administrator privileges.

® The compatible combination of versions for the “Auto Screen Adjustment plug-in software” and the “Geometry
Manager Pro” is predetermined. Therefore, an error message will appear if you attempt to install an incompatible
version of the “Auto Screen Adjustment plug-in software”. In such cases, check whether the version of “Geometry
Manager Pro” that appears in the error message matches the software version found on the above website. If the
versions match, download and install only “Geometry Manager Pro” from the website. If the versions do not match,
download and install both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software”.

3 When installation is complete, the [AUTO ADJUST] (Auto Screen Adjustment) button at the top right of the
“Geometry Manager Pro” main screen will be enabled.

- O X

] @ AuTo ADIUST
ﬂ Color Matching | Masking | Input Signal | Other

If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message
indicating that installation of the plug-in software is required will appear.



Installing/Uninstalling Software Software Uninstall

Software Uninstall

Enter and then select “Apps & features” in the search box of the task bar, select [Geometry Manager Pro Ver.*.*]*!, and click
[Uninstall].

*1 The “*” represent the version number.

® Perform this procedure using an account with administrator privileges.
® Uninstalling “Geometry Manager Pro” will not uninstall the “Auto Screen Adjustment plug-in software”. Perform the same

procedure as the above to uninstall the “Auto Screen Adjustment plug-in software” (Geometry Manager Pro - Auto Screen
Adjustment plug-in).




Preparation

B Projectors supported

For details on models compatible with “Geometry Manager Pro”, check the information found on the software download page
after logging in to PASS on the following website.
https://panasonic.net/cns/projector/pass/

No guarantees are made for the operations when the computer is connected to a non-supported projector.

B Projector and computer connections

Connect the projector and computer using a LAN cable.
Up to 99 projectors can be connected.

® Please use a crossing cable to connect the computer and projector when it is directly connected to the LAN.
® When using a hub to connect, whether or not a straight cable or crossing cable or both can be used depends on the system
configuration. Please consult your network administrator for details.

m Setting the Computer

Network Setup
® Set the IP ADDRESS, SUBNET MASK and DEFAULT GATEWAY according to the operating environment.
(Please consult your network administrator for details.)
@ If “use of automatic script” is checked for your web browser, please uncheck.
® If “Use of Proxy server in LAN” is checked for your web browser, please uncheck, or set the projector IP address to
“Exceptions” in the detailed proxy settings.

10



Preparation

m Setting the Projector

Network Setup
Set the IP address, subnet mask, and default gateway according to your operating environment. (Please consult your
network administrator for details.)
Set DHCP to OFF and set a fixed IP address, making sure that the entered IP address is not used by any other device on
the LAN.
If the entered IP address is used by another device, the projector cannot be registered.

® For models that can be set, enable both WEB Control and Command Control.
® For models in which the Web port number can be set, set the port number to “80”.

® Refer to operating manual of the projector for method on configuring the projector.

® |f prompted to configure the settings for the administrator account in the startup screen or WEB control screen of the
projector, complete those settings.

® This software identifies the projector using the configured IP address. If DHCP is set to ON in the projector network setting
in a network environment that uses a DHCP server etc. the DHCP server may change the IP address allocated to the
projector, making it impossible to connect using this software.
Please ensure the server does not change the IP address by, for example, setting the DHCP server so as to fix the IP
address allocated to the projector. (Please consult your network administrator for details.)

m Activation

There are functions that are enabled and functions that are expanded by performing activation.

The upgrade kit (ET-UK20), Auto Screen Adjustment upgrade kit (ET-CUK10), and Auto Screen Adjustment upgrade kit (PC)
(ET-CUK10P) are required for activation. For details on compatible projector models, check the information found on the
activation page by logging in to PASS on the following website.

https://panasonic.net/cns/projector/pass/

&= “Functions which are expanded as a result of activation” (page 32)

The “Auto Screen Adjustment plug-in software” must be installed and the Auto Screen Adjustment upgrade kit (ET-CUK10)
must be applied on the projector or the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) must be applied on the
computer to enable the Auto Screen Adjustment function.

However, some projectors will be in the state with the functions enabled or functions expanded without having to activate the
upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10).

Also, some projectors do not support activation of the upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit
(ET-CUK10).

B Camera connection

To use the Auto Screen Adjustment function, prepare a camera separately.
For details on supported cameras and lenses and how to connect the camera to the computer, refer to “Auto Screen
Adjustment” (page 115).

11



Activation

There are functions that are enabled and functions that are expanded by performing activation.

There are two methods of activation: one is to apply a kit on the projector to add or expand the functions of the projector
(projector activation) and the other is to apply a kit on the computer to expand the functions of the software installed on that
computer (computer activation).

The upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10) are required for the former method and the
Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P) is required for the latter method. For details on compatible projector
models, check the information found on the activation page by logging in to PASS on the following website.
https://panasonic.net/cns/projector/pass/

& “Functions which are expanded as a result of activation” (page 32)

® Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen
Adjustment function.

® Some projectors will be in the state with the functions enabled or functions expanded without having to activate the upgrade
kit (ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10).

® Some projectors do not support activation of the upgrade kit (ET-UK20) and Auto Screen Adjustment upgrade kit
(ET-CUK10).

Perform the projector activation

The flow of operations from installation to activation is as follows.

This sections describes projector activation.

4 P

L J

A

g

wnload

A

'Input
Key code B a Activation code
leoad D B ‘
D . Actlvatlon code

Device

information file ACTIVELST m

'

—
S~ T )

‘ Device information file
SERIAL.LST

Software installation

-

Export

Projector activation can be performed using one of the following two methods. Perform activation according to your operating
environment.

Please note that activation may fail if you attempt to change the method to a different one during activation.

12



Activation

Perform the projector activation

m Method 1: Method not involving file operation

When can connect to the Internet
Connect to the Internet and perform activation from the computer while connected with the projector.

1 Have the key code ready.
The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit

(ET-CUK10).

Wi

The following screen appears if there is no loadable license management information, such as at initial startup. In this

case, click [Cancel].

Start the software application, and display the Connection Setting screen.

Version

10.73.182 .40 / 255255 254 0

Port;
User Name:

Password:

() Load from file

Fie path

&) Geometry Manager Pro

Option
Activation(ET-CUK10P) ¥
Activation(ET-UK20/ET-CUK10) |
Display Theme T
Command Control »
Service Password

1024

Bl

Select.

‘ Connect | |

Exit |

b

Geometry Manager Pro

4 Click the [Projector Search] button.

Select [Activation(ET-UK20/ET-CUK10)] from the [Option] menu of the Connection Setting screen.

Projector Activation

Projector Search | Delete

Export

Import

Reload

No MAC IPvd

SiN

Model

Name Keycode(ET-UK20)

Status

Keycode(ET-CUK10}

Status

Server Connection Test

Activation

Exit

13




Activation Perform the projector activation

5 Enter the IP address, port number, user name, and password, and click the [Search] button to search for the
projector.
To search by specifying an IP address range, select the [End IP Address] check box and enter the IP address for which to
end the search.

Projector Search X
P Address: | 192 . 168 . 0 . & |
[]End P Address: | 182 . 188 . 0 . 254 |
User Name: | dispadmin |
Password: sssssesses |

6 Select the projector you want to connect to from the search results, and click the [Connect] button.

Geometry Manager Pro X
Available projectors: 2 Selected: 2 Upper limits: 99
=
IP Address Model MName Status
192.168.0.8 PT-RCQ10E MAME3282
192.168.0.9 PTRZSTO MAMEBS74
< >
Select All Clear Al Back Connect

7 Select the projector to be managed, and double-click in a license item you want to activate.

Projector Activation

Projector Search Delete Export Import Reload
W W W W W W W W

No MWAC Py4 SN Model Name 3 Keycode(ET-UK20} Status Keycode(ET-CUK10) Status 1

1 00-0B-87-41-E6-42 192.168.0.8 SN1234567880 PT-RCQ10E NAME3282 L] PJ's info acquired PJ'sinfo acquired ¥
2 BC-C3-42-87-DB-B6 192.168.0.8 DATE40074 PT-RZS70 NAME&ST4 L PJ's info acquired PJ'sinfo acquired I

Server Connection Test Activation Exit

14



Activation Perform the projector activation

8 Enter the key code, and click [OK].
The [OK] button is enabled when you enter all 25 digits of any key code.

Input Keycode X

ol |- | |- | - |- |

<= e O e Y — Y — —

9 Click the [Activation] button.

Projector Activation X
Projector Search Delete Export Impaort Reload
No WAC Py SN Model! Name Keycode(ET-UK20) Status Keycode(ET-CUK10} Status.
1 00-0B-97-41-E6-42 192 168.0.8 SN1234567890 PT-RCQ10E NAME3282 U0020-ZGF0Z-30000-1AAQH-117F7 Keycode registered PJ's info acquired
2 BC-C3-42-B7-DB-B6 192 168.09 DATSA0074 PT-RZ970 NAMEB374 PJs info acquired CO0010-ZGF0Z-30000-1AMHJ-82898 Keycode registered
< >
Server Connection Test Exit
H H H [13 H ”
1 0 Activation is complete when [Status] becomes “Activated”.
Exit the software application by clicking the [Exit] button.
Projecter Activation X
Projector Search Delate Export Impart Reload
No MWAC IPvd. SN Mode! Name Keycode(ET-UK20) Status Keycode(ET-CUK10) Status
1 00-0B-97-41-E6-42 192168.0.8 SN1234567890 PT-RCQ10E NAME3282 UDDZILZGF0273DDBD—1AAQH—11T PJ's info acquired
2 BC-C3-42-87-DB-B6 192.168.0.8 DATE40074 PT-RZS70 NAME2874 Pl's info acquired C0010-ZGF0Z-30000-1AMHI-82698
< >
Server Connection Test Activation Exit

15



Activation Perform the projector activation

When cannot connect to the Internet

Export the license management information including the device and key code information, and acquire the activation code
using another computer that can connect to the Internet. The computer that will acquire the activation code does not need to
connect with the projector.

® Operation of computer connected with projector

1 Have the key code ready.
The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit
(ET-CUK10).

2 Start the software application, and display the Connection Setting screen.

Select [Activation(ET-UK20/ET-CUK10)] from the [Option] menu of the Connection Setting screen.

& Geometry Manager Pro ®
Option
Activation(ET-CUK10P) >
Activation|ET-UK20/ET-CLIK10) |
Display Theme > 3
Command Control >
Service Password
Version
10.73.182.40 / 255.255.254.0
Port 1024
[ o
() Load from file
Comes | [ =]

The following screen appears if there is no loadable license management information, such as at initial startup. In this
case, click [Cancel].

Geometry Manager Pro X

3

| Load the configuration file. Is it OK?

o« |f

Cancel

4 Click the [Projector Search] button.

Projector Activation X

Projector Search

Delete

Export

Import

Reload

No MAC

P4

SiN

Iodel

Name Keycode(ET-UK20) Status

Keycode(ET-CUK10}

Status

Server Connection Test

Activation

Exit
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Activation Perform the projector activation

5 Enter the IP address, port number, user name, and password, and click the [Search] button to search for the
projector.
To search by specifying an IP address range, select the [End IP Address] check box and enter the IP address for which to
end the search.

Projector Search X
P Address: | 192 . 168 . 0 . & |
[]End P Address: | 182 . 188 . 0 . 254 |
User Name: | dispadmin |
Password: sssssesses |

6 Select the projector you want to connect to from the search results, and click the [Connect] button.

Geometry Manager Pro X
Available projectors: 2 Selected: 2 Upper limits: 99
=
IP Address Model MName Status
192.168.0.8 PT-RCQ10E MAME3282
192.168.0.9 PTRZSTO MAMEBS74
< >
Select All Clear Al Back Connect

7 Select the projector to be managed, and double-click in a license item you want to activate.

Projector Activation

Projector Search Delete Export Import Reload
W W W W W W W W

No MWAC Py4 SN Model Name 3 Keycode(ET-UK20} Status Keycode(ET-CUK10) Status 1

1 00-0B-87-41-E6-42 192.168.0.8 SN1234567880 PT-RCQ10E NAME3282 L] PJ's info acquired PJ'sinfo acquired ¥
2 BC-C3-42-87-DB-B6 192.168.0.8 DATE40074 PT-RZS70 NAME&ST4 L PJ's info acquired PJ'sinfo acquired I

Sovm e i £
8 Enter the key code, and click [OK].
The [OK] button is enabled when you enter all 25 digits of any key code.
Input Keycode X
S I N — — —
Sroukio |- | | - | - |- |
canc
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Activation Perform the projector activation

9 Check that [Status] has become “Keycode registered”.

Projector Activation x
Projector Search Delete Export Import Reload
No WAC Py SN Mode! Name Keycode(ET-UK20) Status Keycode(ET-CUK10} Status.
1 00-0B-57-41-E6-42 192.168.0.8 SN1234587890 PT-RCQ10E NAME3282 U0020-ZGF0Z-30000-1AAQH-117FT Keycode registered P.'s info acquired
2 BC-C3-42-B7-DE-B6 192.168.0.9 DATEA0074 PT-RZS70 NAMEZ2T4 PJs info acquired C0010-ZGF0Z-30000-1AMHJ-32898 JKeycode registered

Server Connection Test Activation Exit

1 0 Click the [Export] button and save the file to USB memory or other storage media.

Projector Activation x
Projector Search Delete Impart Reload
No MWAC Pvd SN Model Name Keycode(ET-UK20) Status Keycode(ET-CUK10) Status.
1 00-0B-87-41-E6-42 19216808 SN1234567880 PT-RCQ10E NAME3282 U0020-ZGF0Z-30000-1AAQH-117F7 Keycode registered PJ's info acquired
2 BC-C3-42-87-DB-B5 19216808 DATB40074 PT-RZ970 NAMEBST4 PJ's info acquired C0010-ZGF0Z-30000-1AMHJ-82898 Keycode registered
< >
Server Connection Test Activation Exit

® Operation of the other computer

1 1 Load the file saved in step 10 using another computer that can connect to the Internet.

Start the software application, and select [Activation(ET-UK20/ET-CUK10)] from the [Option] menu of the Connection
Setting screen. When the following screen opens, click the [Import] button.

Projector Activation x
Projector Search Delete Export Reload
No MAC Pvd SN Model Name Keycode(ET-UK20) Status Keycode(ET-CUK10) Status
Server Connection Test Activation Exit
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Activation

Perform the projector activation

12 Click the [Activation] button.

Projector Activation x
Projecter Search Delete Export Import Reload
No WAC Py SN Mode! Name Keycode(ET-UK20) Status Keycode(ET-CUK10} Status.
1 00-0B-97-41-E6-42 192.168.0.8 SN1234587890 PT-RCQI0E NAME3282 U0020-ZGF0Z-30000-1AAQH-117F7 Keycode registered PJ's info acquired
2 BC-C3-42B7-DB-BS 192.168.0.9 DATS40074 PT-RZ370 NAME2ET4 PJ's info acquired C0010-ZGF0Z-30000-1AMHJ-82898 Keycode registered
< >
Server Connection Test Exit
113 H H H ”
1 3 Check that [Status] has become “Activation code acquired”.
Projector Activation x

Projector Search

Delete

Export

import

Reload

No WAC

Py

Model

Name Status

Keycode(ET-UK20)

Keycode(ET-CUK10)

Status

Server Connection Test Activation

Exit

14 Click the [Export

] button and save the file to USB memory or other storage media.

Projector Activation

Projector Search

Delete

import

Reload

P4

Model

Status

Keycode(ET-UK20)

U0020-ZGF0Z-30000-1AAQH-117F7

Keycode(ET-CUK10)

Activation code acquired

Status

PJs info acquired

Activation code acquired

PJs info acquired

Server Connection Test Activation Exit

® Operation of computer connected with projector

1 5 Click the [Import] button on the computer connected with the projector, and load the file saved in step 14.

Projector Activation x
Projector Search Delete Export Reload
No MWAC IPvé SN Model Name Keycode(ET-UK20) Status Keycode(ET-CUK10) Status
1 00-0B-97-41-E6-42 192.182.0.8 GSN12345873%0 PT-RCQI0E MAME3282 U0020-ZGFOZ-30000-1AAQH-117FT  Activation code acquired PJs info acquired
2 BC-C3-42B7DE-B6 192.182.0.0 DATB40074 PT-RZST0 NAMESET4 PJs info acquired C0010-ZGF0Z-30000-1AMHJ-82B98 Activation code acquired
< >
Server Connection Test Activation Exit
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Activation Perform the projector activation

1 6 Click the [Activation] button.

Projector Activation x
Projecter Search Delete Export Import Reload
No MAC Pv4 SN Model Name Keycode(ET-UK20) Status Keycode(ET-CUK10) Status
1 00-0B-97-41-E6-42 192.188.0.8 SN1234557830 PT-RCQI0E NAME3282 U0020-ZGF0Z-30000-1AAQH-117F7  Activation code acquired PJ's info acquired
2 BC-C342B7DBB6 192.168.0.9 DATE40074 PT-RZ970 NAMES274 PJ's info acquired C0010-ZGF0Z-30000-1AMHJ-82B38 Activation code acquired
< >
17 Activation is complete when [Status] becomes “Activated”.
Exit the software application by clicking the [Exit] button.
Projector Activation ped
Projector Search Delete Export Impaort Reload
No MWAC P4 SN Mode! Name Keycode(ET-UK20) Status Keycode(ET-CUK10} Status
1 00-0B-97-41-E6-42 192.168.0.8 SN1234567890 PT-RCQ10E NAME3282 UEII]2[I—ZGFI]Z—3I]EI[II]—1AA[]H—11T PJ's info acquired
2 BCL3-4287DB-B6  192.168.0.8 DATE40074 PT_RZ470 NAMEBS74 BI's info scquired C0010-ZGF0Z-30000-1AMHJ-B82898
< >
Server Connection Test Activation Exit
® Registering just the key code first is not possible.
® Deactivation or transferring the key code to another projector is not possible.
® To test connecting with the server, click [Server Connection Test].
Projector Activation *

Projector Search Delste Export Import Reload

No MAC Pv4 SN Model Name Keycode(ET-UK20) Status Keycode(ET-CUK10} Status

Server Connection Test Activation Exit

If the connection test is successful, the following screen appears. Click [OK] to close the screen.

Geometry Manager Pro x

| Succeed to connect to the server.

20



Activation Perform the projector activation

If connecting failed, the following error message appears. In this case, revise the Internet settings of the computer and
then perform the connection test again.

Geometry Manager Pro *

.'\'-, Failed to connect to the server.

H Method 2: Method involving file operation

1 Have the key code ready.

The key code is indicated on the key code label of the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit
(ET-CUK10).

2 Start the software application, and display the main screen.

&~ “Adjustment and Settings — Main screen” (page 37)

3 On the [File] menu, select [Activation] - [Export Equipment Profile] - [ET-UK20/ET-CUK10].

® All the projectors to which the upgrade kit (ET-UK20) or the Auto Screen Adjustment upgrade kit (ET-CUK10) is not
applied will be targets for operation.

® All connected projectors will be displayed in the common operation area. However, the operation cannot be performed
while two or more of these projectors are selected.

® In the common operation area, an asterisk (*) appears to the left of projector names for which the upgrade kit (ET-UK20)
has not been applied. You can check whether the Auto Screen Adjustment upgrade kit (ET-CUK10) is applied when using
the Auto Screen Adjustment function.

@ Geometry Manager Pro
File Edit View Tools Version

Open File (Current Tab) ]

Open File (One Projector)
Open File (Al Projectors) -ens Setting Geometry ‘ Edge Blending | Uniformity | Brightness Control | Color

Open File (Connection Only) =slosan Lens Memory

Save File (One Projector) @ 1. LENSMEMORY

Save File (One Projector) As...
Save File (All Projectors) As... : 2. LENSMEMORY

Save File (Connection Only) As...

‘ 3. LENSMEMORY
Reset Data (Current Tab)
Reload (Current Tak)

ddd || Add | [ b hbb 4. LENSMEMORY
Activation > Export Equipment Profile > ET-UK20 / ET-CUK10
Export b3 Activate License b3 ET-CUK10P ¥
Key Config

6. LENSMEMORY

Exit ;

The file save screen is displayed.

21



Activation Perform the projector activation

4 Specify the save destination, name the file, and save.
® The default file name is “SERIAL.LST.”

When the confirmation screen for saving the file appears, click [OK].

Geometry Manager Pro x

o Equipment Profile was saved.

5 Start the web browser, and log in to PASS on the following website.

https://panasonic.net/cns/projector/pass/

6 Click the activation button in the side menu of the top page, and follow the on-screen instructions to perform key
code registration, etc.

Register the key code readied in step 1 and the file (default file name: SERIAL.LST) saved in step 4 to PASS to acquire the

activation code file (default file name: ACTIVE.LST).

® The activation codes for the upgrade kit (ET-UK20) and the Auto Screen Adjustment upgrade kit (ET-CUK10) must be
acquired separately.

7 Close the web browser.

8 On the [File] menu, select [Activation] - [Activate License] - [ET-UK20] or [ET-CUK10].

The file selection screen is displayed.

@ Geometry Manager Pro
File Edit View Tools Version

Open File (Current Tab) (m|

Open File (One Projector)

Open File (All Projectors) -ens Setting  Geometry | Edge Blending | Uniformity ‘ Brightness Cont

Open File (Connection Only) SSREDT Lens

Save File (One Projector) @ 1. LEM

Save File (One Projector) As...
Save File (All Projectors) As... : 2. LEN
Save File (Connection Only) As...

3. LEN

Reset Data (Current Tab) A
Reload (Current Tab)

ddd || A4 > | | » ’» 4. LEN
Activation > Export Equipment Profile »
Export > Activate License > ET-UK20
Key Config ET-CUK10

ET-CUK10P

Exit ;

I — — I Hnme Pnxitinn

9 Select the activation code file (default file name: ACTIVE.LST) acquired in step 6.
When activation is complete and the confirmation screen appears, click [OK].

Geometry Manager Pro >

o Activation has succeeded.
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Activation Perform the computer activation

Perform the computer activation

This section describes computer activation.

H Method 1: Activation directly from this software

1 Have the keycode ready.
The keycode is indicated on the keycode label of the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P).

Computer
installed the
software

Key code| <+ E‘iﬂ
SR

2 Start this software, and display the Connection Setting screen.

3 Select [Activation(ET-CUK10P)] — [Direct Procedure] from the [Option] menu of the Connection Setting screen.

@ Geometry Manager Pro x

Option
Activation(ET-CUK10P) » I Direct Procedure I
Activation(ET-UK20/ET-CUK10) File-based Procedure >

Display Theme > o 8
Command Centrol >
Service Password ’

Version

10.73.182 40 / 255 255.254.0

Port: 1024

User Name: |

O Load from file

Connect | | Exit

The [PC Activation] screen appears.

4 Double-click the area displaying the keycode or status in the [PC Activation] screen.

PC Activation *
License Keycode Status
e o o o - = — — —
ET-CUK10P I
1
Server Connection Test Activation Deactivation Exit

The [Input Keycode] screen appears.



Activation Perform the computer activation

5 Enter the keycode and click the [OK] button in the [Input Keycode] screen.
[OK] is enabled when you enter all 25 digits of the keycode.

Input Keycode X

1 ) ) . Y E—

| Cancel | | oK |

If you click [Cancel], all digits of the input keycode will be discarded.

6 Check that [Status] has become “Keycode registered”.

PC Activation b4

License Keycode Status

ET-CUK10P [PRlA-pr==s_szssx mmmww _mmmEw | Keycode registered

Server Connection Test Activation Deactivation Exit
7 Click the [Activation] button.
PC Activation *
License Keycode Status
ET-CUK10P (BO1G_PEEEE_SEREx_sreEs_sriEs Keycode registered
Server Connection Test Activation Deactivation Exit

8 Activation is complete when [Status] becomes “Activated”.

PC Activation b4

License Keycode Status

ET.CUK10P [BR1B-pEsss _swsss _EmmEn EEEEE | Activated |

Server Connection Test Activation Deactivation Exit

Exit the software by clicking [Exit].
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Activation Perform the computer activation

® To test connecting with the server, click [Server Connection Test].

PC Activation b4
License Keycode Status
ET-CUK10P
Server Connection Test Activation Deactivation Exit

If the connection test is successful, the following screen appears. Click [OK] to close the screen.

Geometry Manager Pro *

@ Succeed to connect to the server.
b ¥ 4

If the connection test failed, the following error message appears. In this case, revise the Internet settings of the computer
and then perform the connection test again.

Geometry Manager Pro x

-

l: ﬁ\) Failed to connect to the server.
® \When computer activation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as shown
below.

— [m] x — a >
I FEFEEEEER W@ AUTO ADJUST I FEEEEEEE] W@ AuTO ADJUST B
Before activation After activation
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Activation Perform the computer activation

B Method 2: Activation via a website
1 Have the key code ready.
The key code is indicated on the key code label of the Auto Screen Adjustment upgrade kit (PC) (ET-CUK10P).

Computer
installed the
software

Key code| <+

2 Start the software application, and display the Connection Setting screen or the main screen.

3 Select [Activation(ET-CUK10P)] - [File-based Procedure] - [Export Volume Serial] from the [Option] menu of the
Connection Setting screen or [Activation] - [Export Equipment Profile] - [ET-CUK10P] from the [File] menu of the
main screen.

@ Geometry Manager Pro X
Option
Activation(ET-CUK10P) > Direct Procedure

Activation(ET-UK20/ET-CUK10) File-based Procedure >I

Export Volume Serial

Display Theme Activate Software License

Command Control

Service Password

@ Geometry Manager Pro

File Edit View Tocls Version
Open File (Current Tab)

Open File (One Projector)
Open File (All Projectors)

Open File (Connection Only)

Save File (One Projector)
Save File (One Projector) As...

(|

-ens Setting Geometry ‘ Edge Blending ‘ Uniformity | Brightness Control | Color

—ens Position

Lens Memory

1. LENSMEMORY

Save File (All Projectors) As... 4 =L
Save File (Connection Only) As...

A 3. LENSMEMORY
Reset Data (Current Tab)

Reload (Current Tak)

ddd || A4 > | [ SR AN YN 4. LENSMEMORY

Activation » Export Equipment Profile > ET-UK20/ ET-CUK10
Export » Activate License >I ET-CUK10P I\
Key Config

6. LENSMEMORY
Exit ;

The [Input Keycode] screen appears.

In the [Input Keycode] screen, enter the key code indicated on the key code label.

The key code consists of 25 single-byte alphanumeric characters. All letters should be uppercase, and 5 characters
should be entered in each box.

Input Keycode
[ ||

‘four Yolume Serial Mumber

*Login the PASS{Refer to the instruction manual for URL) web site, and visit “activation™ page.
*Then follow the procedures, upload the exported Volume Serial Number

|
oK Cancel

* (SERIAL.LST) file OR enter your Volume Serial Number manually on to PASS.

Click [OK] to display the file save screen.

If key code input fails 10 times in a row, you will not be able to enter the key code for 24 hours.
If that happens, wait until input becomes possible and then try again.
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Activation Perform the computer activation

5 Save the Volume Serial file ("SERIAL.LST") to any location.

e — ~
Vol | fil
Key code olume serial file

or
Volume serial number

DO XXXXX XXX
\§ J

You can change the file name as desired, but do not change the extension (.LST). To return to the [Input Keycode] screen,
click [Cancel] in the file save screen. When saving of the file is completed, the [Input Keycode] screen closes.

Once the file has been saved, the volume serial number (20 single-byte alphanumeric characters) appears in the [Input
Keycode] screen.

If you will enter this volume serial number manually to download an activation code file later in this procedure, write down
this code and take care not to lose it before activation is completed.

Input Keycode X
*four Volume Serial Number
[204e0 | -[3a270 | -[spa26 |- [31102 |

*Log in the PASS{Refer to the instruction manual for URL) web site, and visit “activation™ page.
*Then follow the procedures, upload the exported Volume Serial Number
* (SERTAL.LST) file OR enter your Volume Serial Number manually on to PASS.

6 Start the web browser, log in to PASS on the following website, and click the [Activation] button from the side
menu of the member top page.

https://panasonic.net/cns/projector/pass/

7 Follow the on-screen instructions to download the activation code file.

Download the activation code file ("ACTIVE.LST") using one of the following two methods.

T4,
(" Volume serial file ) :."' (" Activation code file )
\--
N\~
or I I » or
Volume serial number Activation code
XXX XXX XXX XX (XXX XK= XXX XX K-
N J N J

Key code
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Activation Perform the computer activation

When using a volume serial file (default file name: SERIAL.LST)

Follow the on-screen instructions to upload the volume serial file to PASS, enter the key code, and download the activation

code file ("ACTIVE.LST") to any location.

® You can change the activation code file name as desired, but do not change the extension (.LST).

® The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file ("ACTIVE.LST") to perform activation later in this procedure. If you
will enter the activation code manually to perform activation, write down this code and take care not to lose it before
activation is completed.

When entering the volume serial number manually

Follow the on-screen instructions to register the volume serial number to PASS, enter the key code, and download the

activation code file ("ACTIVE.LST") to any location.

® The volume serial number consists of 20 single-byte alphanumeric characters. All letters should be uppercase, and 5
characters should be entered in each box.

® You can change the activation code file name as desired, but do not change the extension (.LST).

® The activation code (30 single-byte alphanumeric characters) is displayed after the activation code file is downloaded,
but it is not used when using the activation code file to perform activation later in this procedure. If you will enter the
activation code manually to perform activation, write down this code and take care not to lose it before activation is
completed.

8 Close the web browser.

9 Perform activation.

Perform activation using one of the following two methods.

(" Activation code file )

=]

or
Activation code

= XXK=DRX- XXX XXX
(N J

When using the activation code file (default file name: ACTIVE.LST)

1) Select [Activation(ET-CUK10P)] - [File-based Procedure] - [Activate Software License] from the [Option] menu of the
Connection Setting screen or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen
and then click the [By import "Activation Code" file] button.

3 Geometry Manager Pro *
Option
Activation(ET-CUK10P) > Direct Procedure
Activation(ET-UK20/ET-CUK10) File-based Procedure 3 Export Yolume Serial
—_
Display Theme > Il | Activate Software License |
Command Control >

Service Password v
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Activation

Perform the computer activation

@ Geometry Manager Pro

File Edit View Tools Version

Open File (Current Tab)

Open File (One Projector)
Open File (All Projectors)
Open File (Connecticn Only)
Save File (One Projector)
Save File (One Projector) As...
Save File (All Projectors) As...
Save File (Connection Only) As...
Reset Data (Current Tab)
Reload (Current Tab)
Activation

Export

Key Config

]

lens Sefting Geometry | Edge Blending | Uniformity | Brightness Contr

_ens Position Lens !

@ 1o

: 2.LEN

3. LEN
A
Addd ad > | | » » 4. LEN
> Export Equipment Profile >
> Activate License 3 ET-UK20 4
’ ET-CUK10

:

T Hnma Draitinn

Activation

s

How you input Activation Code into the program?

: By import "Activation Code” file

By entering “Activation Code™

2) Select the activation code file (default file name: ACTIVE.LST) downloaded from PASS.

When entering the activation code manually

1) Select [Activation(ET-CUK10P)] - [File-based Procedure] - [Activate Software License] from the [Option] menu of the
Connection Setting screen or [Activation] - [Activate License] - [ET-CUK10P] from the [File] menu of the main screen
and then click the [By entering "Activation Code"] button.

@ Geometry Manager Pro
Option

Activation(ET-CUK10P)
Activation(ET-UK20/ET-CUK10)
Display Theme

Command Control

Service Password

*

> Direct Procedure

File-based Procedure > Export Yolume Serial
> s I Activate Software License I

0 10

@ Geometry Manager Pro

File Edit View Tocls Version

Open File (Current Tab)
Open File (One Projector)
Open File (All Projectors)
Open File (Connection Only)

Save File (One Projector)

Save File (One Projector) As...
Save File (All Projectors) As...

Save File (Connection Only) As...

Reset Data (Current Tab)
Reload [Current Tab)

Activation
Export
Key Config

Exit

|

-ens Setting Genmedryl EdgeBIendmgl Uniformity | Brightness Contr

-ens Posttion Lens !

@ b

: 2 LEN

A 3.LEN
ddd || A4 > | [ » »’ 4. LEN
> Export Equipment Profile >
¥ Activate License » ET-UK20 'l
; EL-CUK10

.

T Hnma Brsitinn

Activation

x

How you input Activation Code into the program?

By import “Activation Code” file

IE By entering "Activation Code” ||
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Activation Perform the computer activation

2) After downloading the activation code file, enter the displayed activation code.
® The activation code consists of 30 single-byte alphanumeric characters. All letters should be capitalized, and 5
characters should be entered for each box.

Entering "Activation Code" manually x
Refer PASS web site and enter 30 alphanumeric of the Activation
—— 1 - 1 1 |
Cancel

1 0 When activation is completed, the activation code is registered to the computer.

When the confirmation screen appears, click [OK].

@ If activation failed, check the following again.
- The key code input in the [Input Keycode] screen in step 4 and the key code input when uploading the volume serial
file (default file name: SERIAL.LST) to PASS or registering the volume serial number to PASS are different.
- The volume serial file or the volume serial number created in step 5 and the volume serial file uploaded to PASS when
generating the activation code or the volume serial number entered when registering to PASS are different.
® \When computer activation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as
shown below.

- O x - a X
I FHEFEEEEEH] W@ AuTo ADIUST I FEEFEEEEE]] W@ AuTo ADJUST L
Before activation After activation
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Activation Perform the computer deactivation

Perform the computer deactivation

Deactivation is possible when computer activation was performed directly from this software (page 23). Deactivation
enables the keycode to be used for activation on another computer.

1 Start this software, and display the Connection Setting screen.
2 Select [Activation(ET-CUK10P)] — [Direct Procedure] from the [Option] menu of the Connection Setting screen.
The [PC Activation] screen appears.

3 Check that the keycode is already entered and [Status] is “Activated” in the [PC Activation] screen.

PC Activation b4

License Keycode Status

Ercukiop |[ coete prees srees T T ] :ﬁmwted ‘

Server Connection Test Activation Deactivation Exit

4 Click the [Deactivation] button.

A confirmation message appears. Click [OK] to perform deactivation. Click [Cancel] to not perform deactivation.

5 Deactivation is complete when [Status] becomes "Keycode Registered".

PC Activation b4

License Keycode Status

ET-CUK10P CRRLB-press s it it | Keycode registered

Server Connection Test Activation Deactivation Exit

® \When computer deactivation is completed, the [AUTO ADJUST] button at the top right of the main screen changes as
shown below.

- O x - a X
I [FEFEEEEEH W@ AuTo ADJUST L I [ @ AUTO ADIUST
Before deactivation After deactivation
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Activation Functions which are expanded as a result of activation

Functions which are expanded as a result of activation

Listed below are the functions which are expanded when the activation process has been completed.

Some projectors will be in the state with the functions enabled or functions expanded without having to activate the upgrade kit
(ET-UK20) and Auto Screen Adjustment upgrade kit (ET-CUK10).

m Upgrade kit (ET-UK20)

Function Activation not completed Activation completed

When the resolution of the projector

is 1920 x 1200 dots or 3840 x 2400 2x2 to 11x11 2x2 to 41x26
Grid pattern dots

:’:':i';;:: 0’::3'::::" of the projector 2x2 to 11x11 2x2 to 29%22

Adjustment | HorEont! keystone 15 240
Geometry ranges Vertical arcs 150 +100
Correction Horizontal arcs 150 +100

Pincushion 150 +100

Rotational correction - \/

Flip Vertical B J

Flip Horizontal

Flexible Correction - N
Uniformity Flip Vertical B N

Flip Horizontal
Masking — N

V: Can be used.
—: Cannot be used.

H Auto Screen Adjustment upgrade kit (ET-CUK10) / Auto Screen Adjustment upgrade kit
(PC) (ET-CUK10P)

This allows simple automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape
of the screen through use of a camera.

® Both “Geometry Manager Pro” and the “Auto Screen Adjustment plug-in software” must be installed to use the Auto Screen
Adjustment function.
® To use the Auto Screen Adjustment function, prepare a camera separately. &= “Camera connection” (page 115)
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Starting and Exiting the Application

Double-click the shortcut icon on the desktop.
When the application starts, the connection settings screen appears.

g Geometry Manager Pro X

Option
Connection Setting

@iPAgdress:

Start IP Address: 192 . 188 . 0 .8
Depassss | |

O MNetwork

10.73.182.40 / 255.255.254.0 LAN connection

Port: 1024

O Load from file

File path Select..

File connection

Select [ @ IP Address ] or [ @ Metwork ] to use a LAN connection for the projector and computer, and select
[ @ Laad from file ] to connect by loading a saved file.

The following items can be selected from the [Option] menu at the top left of the connection settings screen.
Activation (ET-CUK10P)
This performs Auto Screen Adjustment upgrade kit (PC) activation.
Direct Procedure
This performs the activation procedure directly from this software in an environment where a computer with this
software installed can connect to the Internet.
File-based Procedure
This performs the activation procedure via file creation, processing using a Web browser, etc.
Export Volume Serial
This creates a volume serial file (file registered to PASS).
This file is required to acquire the activation code file.
&= “Activation” (page 12)
Activate Software License
This performs computer activation. An activation code file or activation code is required.
&= “Activation” (page 12)
Activation (ET-UK20/ET-CUK10)
This performs upgrade kit activation.
&= “Activation” (page 12)
Display Theme
This switches the theme (color scheme) of this software.
You can select from [Dark Gray] and [Light Gray].
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Starting and Exiting the Application Starting the application

Command Control
Control command data set in the Command Control screen (registered commands and registered scripts) can be
saved to a file or read from a file.
&= “Projector Control” (page 111)
Import Commands
This reads control command data from a file.
Export Commands
This saves control command data to a file.
Service Password
This menu is used to support maintenance. It is not normally used.
Version
This is where the application’s version information can be checked.

H LAN connection

Select the search method for the projector to be connected, and configure the following settings.

IP Address
Select this to search by specifying the IP address of the projector to be connected.
Start IP Address:
Input the IP address of the projector to be connected to the computer. When searching for a connected projector,
enter an IP address to start searching.
End IP Address:
When searching for a connected projector, select the check box and enter an IP address to end searching.
Network
Select this to search for a projector within the same network as your computer. The IP address and subnet mask of your
computer are displayed in the list.
Port
Set the number of port on the computer for connecting with the projector.
User Name
Input the user name used for WEB control of the connected projector.
Password
Input the password used for WEB control of the connected projector. You can switch between displaying the input

password as is or displaying it replaced with “e” by clicking the icon on the right of the input area.

©. Displays the password replaced with “e”. (default)

ES1\3: Displays the password as is.

® Specify the same network address for the Start IP Address and End IP Address. If the search range is too wide, an error
will occur when you start the search.

® In Network, multiple IP addresses and subnet masks are displayed in the list if your computer has multiple network
interfaces. Select the address that is connected to the same network as the projector to be connected from the list.

® Enter the user name and password of the account with administrator privileges for the projector to be connected.
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Starting the application

When not searching for a connected projector, click [Connect] after configuring the settings to display the data transfer method
confirmation screen. Click the [OK] button on the screen to display the main screen.
&= “Adjustment and Settings — Main screen” (page 37)

® |If the check box is selected on the data transfer method confirmation screen when you click the [OK] button, the
confirmation screen will not be displayed subsequently.

Geometry Manager Pro

@ Current data transfer to projector is sat to "Auto”.
R r
@ru disable this remainder, check this box.

When searching for a connected projector, click [Search] after configuring the settings to start the search according to the
settings. The projector search screen is displayed while the search is in progress.

Geometry Manager Pro

*

| Cancel I

Available projectors: 2 SelecEd: 2 Uipper Iimit_s: 33
=

IP Address Model Mame Status

192.168.0.9 PT-DZ780 MAMESOG1

192.168.0.10 FT-RZE70 MAMED203

<

>

Select Al II Clear Al I
1

| Connect

Cancel

Cancel the search.

When a search is canceled, projectors that have been
detected up to that point will be displayed.

L— Connected projector list

Displays a list of projectors that were detected via the
search.

Connect

Connect to the selected projectors, and display the data
transfer method confirmation screen. Click the [OK] button
on the screen to display the main screen. & "Adjustment
and Settings — Main screen" (page 37)

Clear All
Clear selection of all detected projectors.

Select All
Select all detected projectors.

When [Exit] is clicked, the application is exited without establishing a connection.
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H File connection

Select [ @ Load from file 1 and configure the following settings.

File path
Specify a file (with .prjc or .prjs extension) saved in the past.
Click [Select] to open the file selection screen.

Click [Connect] after configuring the settings to display the data transfer method confirmation screen (page 35). Click the [OK]
button on the screen to display the main screen. & “Adjustment and Settings — Main screen” (page 37)
When [Exit] is clicked, the application is exited without establishing a connection.

The following screen appears when you connect to a projector for which the upgrade kit (ET-UK20) has not been applied.

Geometry Manager Pro x

This projector has limitation on the following functions.
- Geometry
- Uniformity
- Masking

Please check the following:
- Does the projector support the upgrade kit?
- Is the projector activated using the upgrade kit?

Exiting the application

To exit the connection main screen, either select [File] and then [Exit] or click the button at the top right of the window.
To exit the connection settings screen, either click the [Exit] button or click the button at the top right of the window.
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Adjustment and Settings
 Mainscreen

The main screen consists of the following five general areas and the [AUTO ADJUST] (Auto Screen Adjustment) button.

Main menu Adjustment area [AUTO ADJUST]
(Auto Screen Adjustment)

ﬁ Geometry Mandger Pro - a X

Iconmenu—= € &[5 ¢ @m0 /=& a] || i @ oo ||

—
# % | 1 | ons Setiing | [Geomelry] Edge Blending| Uniformity | Brightness Control| Color Matching | Masking | input Signal| Gther
02 PROJECTORZ (...
03 PROJECTOR3 (0.
04 PROUECTORY (0..
05 PROJECTORS (0...
08 PROJECTORS (0...
07 PROJECTORT (0...
08 PROJECTORS (0..

Shutter Close || Shutter Open

"

0SD ON 0SD OFF
Status ON Status OFF

Status Page | Prev | [ Next

Command Control

Common= et patem
OFF ~
operation area

Image Direction

Landscape v

Grid Resolution

3 vlx 3 ~
O use Square Grid

Display Grid Lines

OFF ~

< >

Moving Area

Cursor Information pC-1 | Date Modified 2022/12107 123456 | 0 =7 | O Smoothing [ Alert Distortion -m v
Display Cursor ~
Grid Aspect Free Grid (PJ) |OFF v Import FREE GRID
dinate Information

one Default v x

Ci

Free Grid

Transfer
Manual Transfer . m

Auto Transfer

s

Qne

Status bar

® \When using this application, keep the main power of the projector in the “on” setting.
The [Power ON] operation will be enabled even when the projector is in the standby state. However, if the standby mode is
set to [ECQ] on a projector for which standby mode can be set, all operations including [Power ON] will be disabled. When
using this application and performing the [Power ON] operation, set the projector’s standby mode to [Normal]. Operations
other than [Power ON] are not guaranteed when the projector is in the standby state.

® If the projector settings have been changed using a remote control, for instance, rather than the software application, the
software application displays and projector settings may not match.

Adjustment area

You can click the tabs in the adjustment area to switch between screens and perform various adjustments and operations.
The modes in which these adjustments and operations are performed are called “editing modes.”
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Main menu

H File submenu

Open File (Current Tab)
This loads only the setting data of the current editing mode from a setting file (with .prj extension) saved on the
computer.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
Open File (One Projector)
This loads all the editing mode settings from the setting file (with .prj extension) saved on the computer into the selected
projector.
When this menu item is selected, the loaded settings are reflected in the target projector even if ("] Auto Transfer (at the
bottom of the common operation area) has not been checked.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

When the setting file is loaded, the settings may not be reflected correctly if the selected input signal is not the same as
the one when the setting file was saved.
Open File (All Projectors)
This loads a file saved with [Save File (All Projectors) As...].
When this item is selected, the loaded settings are reflected in all the target projectors that are connected even if

|| Auto Transfer (at the bottom of the common operation area) is not checked.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

When the file is loaded, an error message is displayed if the target projector is not connected to the network. When the
connection of the target projector to the network is recognized, the connection is established and the loaded settings
are reflected automatically.

Open File (Connection Only)
This loads a setting file (with .prjc or .prjs extension) saved to the computer and reflects the status of the connection
with the saved projector.

® When the file is loaded, an error message will be displayed if the target projector is not connected to the network, but
a connection will be established automatically when the computer recognizes that the target projector is connected
to the network.

® Even if a setting file (with .prjs extension) is selected, the settings of the projector target for connection are not
reflected.

Save File (One Projector)
This saves the settings being edited, overwriting the previous settings in the current setting file (with .prj extension).
When the file is saved for the first time, a message appears prompting the user to provide a filename.

Save File (One Projector) As...
This saves the settings now being edited in a file under the filename (with .prj extension) provided.

Save File (All Projectors) As...
This saves the setting information of all the currently connected projectors as a single All Project File (with .prjs
extension) on the computer.
The layout information, IP addresses, user names, and passwords of the projectors are also encrypted and saved in the
All Project File.

38



Adjustment and Settings Main screen

Save File (Connection Only) As...
This saves the connection information of all the currently connected projectors as a single file (with .prjc extension) on
the computer.
The IP addresses, user names, and passwords of the projectors are also encrypted and saved.

Reset Data (Current Tab)
This sets the current editing mode settings to the initial statuses.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Reload (Current Tab)
This cancels the settings currently being edited using the application, and loads the same settings again from the
projector.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.

Activation
Export Equipment Profile (ET-UK20 / ET-CUK10 / ET-CUK10P)
Creates a file to be registered in PASS. This file is required to acquire the activation code file.
&= “Activation” (page 12)

Activate License (ET-UK20 / ET-CUK10 / ET-CUK10P)

Select [ET-UK20], [ET-CUK10], or [ET-CUK10P] and then perform activation.

&= “Functions which are expanded as a result of activation” (page 32)

® The activation code file is required.
& “Activation” (page 12)

® |f the “Auto Screen Adjustment plug-in software” is not installed, [ET-CUK10] or [ET-CUK10P] cannot be selected.
&= “Installing the “Auto Screen Adjustment plug-in software™ (page 8)

Export
Multi Monitoring and Control Software
This saves the data in the file format (with .ugk extension) used for the “Multi Monitoring & Control Software”.
The file is for registering the data of the projectors already registered in the software application in the “Multi Monitoring
& Control Software” for monitoring and control purposes.
For details, refer to the operation manual of the “Multi Monitoring & Control Software”.

Key Config
This configures the key settings for using a gamepad to operate some functions of this software.
& “Operation by Gamepad” (page 152)
Exit
Exits the software.
® When this item is selected, a confirmation message appears. Proceed with operation as instructed in the message.
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m Edit submenu

Undo
This discards the software application and projector settings currently being edited.
It returns these settings to the status before the setting data is sent.

Redo
This returns the settings to the ones before the Undo operation is performed.

® Undo and Redo can be used up to 50 times during a single setting process (for each editing mode).
® The Undo and Redo logs are cleared if you switch to another editing mode or projector.

The following Edit submenu items are enabled only in certain editing modes. For details, refer to the respective reference
pages.
Lock

& “Adjustment and Settings - Geometry Correction” (page 57)

Unlock
& “Adjustment and Settings — Geometry Correction” (page 57)

Free
&= “Adjustment and Settings — Geometry Correction” (page 57)

Reset
&= “Adjustment and Settings — Geometry Correction” (page 57), “Adjustment and Settings — Uniformity” (page 79),
“Adjustment and Settings - Masking” (page 91)

Flip Vertical
& “Adjustment and Settings - Geometry Correction” (page 57), “Adjustment and Settings - Uniformity” (page 79),
“Adjustment and Settings - Masking” (page 91)

Flip Horizontal
& “Adjustment and Settings — Geometry Correction” (page 57), “Adjustment and Settings — Uniformity” (page 79),
“Adjustment and Settings — Masking” (page 91)

Area Select
&= “Adjustment and Settings — Uniformity” (page 79)

Point Select
& “Adjustment and Settings - Uniformity” (page 79)
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H View submenu

Tool Bar, Status Bar, Sub Window, Layout Window
Enter a check mark, and select whether the items are to be displayed.
In the initial status, “Tool Bar” and “Status Bar” are displayed.

Display Theme
Dark Gray / Light Gray
These switch the theme (color scheme) of this software.

Live View
This displays live view images.
&= “Live View” (page 147)

Auto Transfer
When a check mark is entered for this and then settings are changed, the changed settings are reflected in the
projector as soon as they are changed.
The state when this software is exited will continue when the software starts next time.

® Entering a check mark causes a check mark to appear in || Auto Transfer in the lower left of the common operation
area.

Image Direction
Landscape / Landscape (Flipped) / Portrait (Clockwise) / Portrait (Counterclockwise)
Switch this to match the direction of images projected by the projector and the display in this software.
& “Adjustment and Settings - Geometry Correction - Geometry screen” (page 57)
&= “Adjustment and Settings - Edge Blending - Edge Blending screen” (page 71)
& “Adjustment and Settings - Uniformity - Uniformity screen” (page 80)
& “Adjustment and Settings - Masking - Masking screen” (page 92)

® This setting is not linked with the portrait setting of the projector. Configure the portrait setting of the projector separately.
@ Set this setting individually for each connected projector.

Line Color
White / Red / Green / Blue
These perform the same operations as the icon menu [White], [Red], [Green] and [Blue] on the Geometry screen.
& “Adjustment and Settings - Geometry Correction - Geometry screen” (page 57)

Coordinate Information
None / Absolute / Relative
These select the mode in which the coordinates of the control points are displayed.
& “Adjustment and Settings - Main screen - Coordinate Information” (page 49)

Grid Resolution
Use Square Grid / X /Y
These select the mode in which the coordinates of the control points are displayed.
& “Adjustment and Settings - Geometry Correction - Geometry screen” (page 57)

Zoom
x1/8 1 x1/4 1 x1/2 | x1 1 x2 [ x3 [ x4 | x5/ x6 | x7 | x8
The editing area is zoomed in or out.

Masking Marker
Red / Green / Blue / Orange
These select whether to display the control points.
& “Adjustment and Settings - Masking - Masking screen” (page 92)
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Main screen

H Tools submenu

Command Control
This displays the Command Control screen.
&= “Projector Control” (page 111)
Auto Screen Adjustment
This displays the Auto Screen Adjustment screen.

This performs the same operation as the [AUTO ADJUST] (Auto Screen Adjustment) button.

&= “[AUTO ADJUST] (Auto Screen Adjustment) button” (page 50)

This cannot be selected if the “Auto Screen Adjustment plug-in software” is not installed.

H Version submenu

About Geometry...
This displays version information for “Geometry Manager Pro”.
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Ilcon menu

This icon menu is used in all the editing modes.
For details on the icon menu items used in each editing mode, refer to the description of the mode concerned.

[y |
L= Open File (One Projector)

This performs the same operation as [Open File (One Projector)] on the File submenu.

E Save File (One Projector)

This performs the same operation as [Save File (One Projector)] on the File submenu.

6 Reload (Current Tab)

This performs the same operation as [Reload (Current Tab)] on the File submenu.

'El: Undo

This performs the same operation as [Undo] on the Edit submenu.

ctb Redo

This performs the same operation as [Redo] on the Edit submenu.

Layout Window
Each time this is clicked, the Layout Window screen is switched between displayed and cleared.
On the Layout Window, the positions of the projectors can be changed by means of mouse operations.
When a projector position is moved, the overall layout is automatically corrected based on the projector which was moved.
Main screen operations can be performed even while the Layout Window is displayed.
The Layout Window screen can be displayed also by selecting [Layout Window] on the View submenu.
The Layout Window screen below is an example when eight projectors are connected.

Layout Window n
Selection area
The projector layout is displayed.
| m || 0z || 03 || 04 | You can change the active projector by clicking one of the rectangles
| 5 ” 0% ” 07 ” 0 | representing the projectors.

The frame of the selected projector is indicated in red.

I oK " Cancel " Apply I

|—Apply
Click to apply the layout displayed in the selection area.
The screen is not closed.

Cancel
Click to close the screen without applying the layout displayed in the
selection area.

OK
Click to apply the layout displayed in the selection area and close the
screen.

|_] Reset Data (Current Tab)

This performs the same operation as [Reset Data (Current Tab)] on the File submenu.

.j Open File (Current Tab)

This performs the same operation as [Open File (Current Tab)] on the File submenu.
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Main screen

Common operation area

The common operation area houses the operations which can be used in all the editing modes.

& o
PROJECTOR1 (0.0.0.1)
02 PROJECTORZ (0.0.0.2)
03 PROJECTOR3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
05 PROJECTORS (0.0.0.5)
i PROJECTORTY (0.0.0.7})
08 PROJECTORE (0.0.0.8)

Add | | Del | | Rename

Dizplay Projector Name

Projector list

This list displays the projector numbers, projector names and IP addresses in the
sequence in which the projectors were connected.

The projector currently selected is the one whose data is being edited. Any projector on
the list can be selected to switch the projector whose data is to be edited.

® Multiple projectors can be selected as targets for operations by holding the Ctrl key
while clicking. In that case, the following functions can be operated.
Power ON/Standby, Shutter Close/Shutter Open, OSD ON/OSD OFF, Status ON/
Status OFF, Status Page, Test Pattern, Display Projector Name, Grid Resolution,
Display Grid Lines

® When a projector for which the upgrade kit (ET-UK20) has not been applied is
connected, an asterisk (*) appears to the left of that projector name. An error
message will appear if you connect to this projector and attempt to use the extended
functions. &= “Activation” (page 12)

® When a projector on the list is selected and then double-clicked, the WEB control
screen opens. For details on the WEB control screen, refer to the operating
instructions of the projector.

® When the mouse pointer is placed over a projector on the list, a tooltip appears and
shows the model number and resolution of that projector.

® If you change the projector authentication information (user name, password, etc.)
by WEB control after connecting the projector to this software, you will lose ability to
connect to or control the projector using this software.
In that situation, right-click on the projector in the list, select [Property], open the
[Property] screen, and correct the authentication information.
&= “[Property] Screen” (page 45)

Power ON Standby
Shutter Close Shutter Open
0SD ON 0SD OFF
Status ON Status OFF
Status Page Prev | | MNext
Commarjd Control |
Test Pattern
OFF e

—i | ¥
These change the order of the projectors in the list.
Select a projector in the list and then click the up arrow button to move it up one place in
the list or click the down arrow button to move it down one place in the list.

® Multiple projectors cannot be moved at the same time.

® When the up arrow button is clicked while the very top projector is selected or when
the down arrow button is clicked while the very bottom projector is selected, the
projector does not move.

® The results of moving the projectors are reflected in Layout Window.
&= “Layout Window” (page 43)

Del

Click to remove the selected projector from the operating targets.
When all the projectors are removed, the software is exited.
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Main screen

PROJECTOR (0.0.0.1)
02  PROJECTORZ (0.0.0.2)
03  PROJECTOR3 (0.0.0.3)
04  PROJECTORS (0.0.0.4)
05 PROJECTORS (0.0.0.5)
06  PROJECTORS (0.0.0.5)
07  PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8)
agd || Del || Rename = Rename
Display Projector Name Click to change the name of the currently selected projector.
A name can consist of a maximum of 12 characters including letters (upper-case),
Hower ON Standby numbers, hyphens and periods.
Shutter Close Shutter Open Display Projector Name
gErEd TErgsr Click to display the name and number of the currently selected projector on the image
EreEl SEI3EAF projected by the projector.
Status Page Prew | | Next
‘ Command Control | Add
st Pattern Click to display the LAN connection destination selection screen and add a new
projector.
{ o - &= “Adjustment and Settings — Main screen — LAN connection destination selection

[Property] Screen

screen” (page 46)

IP Address

Enter the IP address of the projector.

Port

Property
P Address: 192
Port.

User Name:

Password:

183 0 8

Set the port number to be used for connecting to the projector.

Projector Name:  PROJECTOR1

102 Model PI-REQ12 — Jser Name
Enter the user name to be used for connecting to the projector.

N |

MAC Address:  00-11-22-AA-BB-CC

Password

‘ Update Cancel ‘

Enter the password to be used for connecting to the projector.

You can switch between displaying the input password as is or
displaying it replaced with “e” by clicking the icon on the right of
the input area.

©. Displays the password replaced with “e”. (default)

@: Displays the password as is.

® Enter the user name and password of the account with
administrator privileges for the projector to be connected.

Cancel
Discard entered information.

Update
Update and reconnect using the entered information.
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LAN connection destination selection screen

When is clicked, the LAN connection destination selection screen is displayed.
A projector that is going to be connected now be set.

IP Address
Select this to search by specifying the IP address of the projector to be connected.
Start IP Address:
Input here the IP address of the projector to be connected.
To search for a connected projector, enter an IP address to start searching.
End IP Address:
To search for a connected projector, select the check box and enter an IP address to end
searching.

@ Geometry Manager Pro X m

® Specify the same network address for the Start IP Address and End IP

(@) IP Address
Address.
. 182 168 . 0O T . . .
Start P Address: | | ® |If the search range is too wide, an error will occur when you start the
[ End IP Address: | HE - AED - Wi | search.
ONe‘twork
Network

192.168.0.201 / 255.255.255.0 . . sl
Select this to search for a projector within the same network as your

User Name: | | m

Password: |:| > ® Multiple IP addresses and subnet masks are displayed in the list if your
computer has multiple network interfaces. Select the address that is
connected to the same network as the projector to be connected from
the list.

—Port
Set here the number of the port that is to be connected to the projector.
User Name
Input here the user name of the projector to be connected.
Password
Input here the password of the projector to be connected. You can switch
between displaying the input password as is or displaying it replaced with
"e" by clicking the icon on the right of the input area.

@: Displays the password replaced with “e”.

@: Displays the password as is.

® Enter the user name and password of the account with administrator
privileges for the projector to be connected.

Exit
Click to cancel the connection with the projector and close the LAN
connection destination selection screen.

Connect / Search

When not searching for a connected projector, connection to the projector
will be established according to the entered settings.

When searching for a connected projector, the projector search will start
according to the entered settings.

A status screen is displayed while the search is in progress. &= "Starting
and Exiting the Application — Projetor Search Screen" (page 35)

When the projector is connected successfully, the LAN connection
destination selection screen is closed.
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Main screen

— Power ON/Standby
Click the left button to set the power of the selected projector to the “On” state or click the
right button to set it to the standby state.
The setting is reflected in the projector even when a check mark has not been entered in

[] Auto Transfer,

When the projector is in the standby state, no guarantees are made for any operations
except [Power ON].

— Shutter Close/Shutter Open
Click the left button to set the shutter of the selected projector to the “On” state or click
the right button to set it to the “Off” state.
The setting is reflected in the projector even when a check mark has not been entered in

[7] Auto Transfer.

OSD ON/OSD OFF

Click these to select to display (ON) or not display (OFF) the OSD menu on the images

of the selected projector.

This operation is reflected in the projector even if a check mark has not been entered

for [ | Auto Transfer.

| Status ON/Status OFF
Click these to select to display (ON) or not display (OFF) the status (information) on the

images of the selected projector.
The setting is reflected in the projector even when a check mark has not been entered in

PROJECTOR1 (0.0.0.1)
0z PROJECTORZ (0.0.0.2)
03 PROJECTORS3 (0.0.0.3)
04 PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
08 PROJECTORS (0.0.0.8)
o7 PROJECTORT (0.0.0.7)
153 PROJECTORSE (0.0.0.8)
Add | | Del | | Rename
Dizplay Projector Name
Power ON Standby |
Shutter Close Shutter Open
0SD ON 0SD OFF
Status ON Status OFF
Status Page
| Command Control _’—
— Test Pattern

OFF

[7] Auto Transfer.

Status Page

— Image Direction

Landscape

Click these to select the previous or next page of the status screen when the status is
displayed on the projector’s image.

The setting is reflected in the projector even when a check mark has not been entered in

— Grid Resolution
k|

D Use Sguare Grid
Display Grid Lines.
OFF

| X | N

[7] Auto Transfer,

— Command Control
Click to display the Command Control screen.
&= “Projector Control” (page 111)

— Cursor Information
Dizplay Cursor

—— Test Pattern

— Coordinate Information
None
Absolute

Relative

Click to switch the image projected from the projector to the test pattern.

A test pattern supported by the selected projector can be selected.

If multiple projectors are selected, a test pattern commonly supported by the selected
projectors can be selected.

Default value: OFF

—Transfer

| WManual Transfer

‘ The setting is reflected in the projector even when a check mark has not been entered in

Auto Transfer

[7] Auto Transfer.

® A user test pattern can be selected for a model that supports user test patterns. The
user test patterns are displayed in the selection options as User1 to User3.

® A user image can be selected as a test pattern for a model that supports the user
image functions of the projector. The user images are displayed in the selection
options as User1 to User4.

® This software does not support registering, deleting, and renaming user test patterns
and user images. Perform such operations using, for example, the OSD menu or
Web control functions of the projector.
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Main screen

PROJECTOR1 (0.0.0.1)
02  PROJECTORZ (0.0.0.2)
03  PROJECTORS (0.0.0.3)
04  PROJECTORS (0.0.0.4)
05  PROJECTORS (0.0.0.5)
06  PROJECTORS (0.0.0.8)
07  PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8)

Add | | Del | | Rename

Display Projector Name

Power ON Standby
Shutter Close Shutter Open
0SD ON 0sD OFF
Status ON Status OFF
Status Page Prev | | Next

Command Control |

— Test Pattern

OFF ~

—Image Direction

—Image Direction
Click to select an option to match the direction of images projected by the projector and
the display in this software.

Landscape: Display projected images as they are.

Landscape (Flipped): Rotate by 180 degrees (flip top/bottom and left/right).
Portrait (Clockwise): Display is rotated clockwise (90 degrees right).

Portrait (Counterclockwise): Display is rotated counterclockwise (90 degrees left).

Default value: Landscape

This operation does not change the projector settings.

Landscape ~

Set this individually for each connected projector.

— Grid Resolution I

isplay Grid Lines
DFF e

— Cursor Information

E'El Display Cursor

— foordinate Information
None
Absolute

Grid Resolution (horizontal)
The number of grids in the horizontal direction is selected here.

1 x| o
E Use Square Grid I——Grid Resolution (vertical)

The number of grids in the vertical direction is selected here.

The number of grids that can be selected differs depending on the model and resolution
of the selected projector.

The upper limit for the number of grids differs depending on whether or not the upgrade
kit (ET-UK20) has been applied to the selected projector.

&= “Activation” (page 12)

When a check mark is entered for D Use Square Grid , the two grid resolutions

Relative

—Transfer

‘ Manual Transfer |

Auto Transfer

(horizontal and vertical) become one, and the button for selecting the combination of

the number of grids whose horizontal and vertical intervals are identical is selected. If
there is no combination of the number of grids whose horizontal and vertical intervals are
identical, this is disabled.

The number of grids that can be selected differs depending on the model and resolution
of the selected projector.

The combinations that can be selected differ depending on whether or not the upgrade
kit (ET-UK20) has been applied to the selected projector.

& “Activation” (page 12)
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Main screen

PROJECTOR1 (0.0.0.1)
02  PROJECTORZ (0.0.0.2)
03  PROJECTORS (0.0.0.3)
04  PROJECTOR (0.0.0.4)
05  PROJECTORS (0.0.0.5)
06  PROJECTORS (0.0.0.8)
07  PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8)

Add | | Del | | Rename

Dizplay Projector Name

Power ON Standby
Shutter Close Shutter Open
0SD ON 0SD OFF
Status ON Status OFF
Status Page Prev | | MNext

Command Control

— Test Pattern

OFF “

— Image Direction

Landscape w

— Grid Resolution

[ use square Grid
Display Grid Lines

" | X [N L

— Display Grid Lines
The color of the grids to be projected is selected here.

OFF, White, Black, Red, Green, Blue, Cyan, Magenta, Yellow

Default value: OFF
The setting is reflected in the projector even when a check mark has not been entered in
[7] Auto Transfer.

- Cursor Information

When a check mark is entered for [#|pisplay cursor , the cursor indicating the position of
the control point can be displayed on the projected image.

The cursor appears only at the top left when the control point has been selected using a
line or area.

If a multiple number of control points have been selected, the cursor will be displayed
only at the control point selected last.

Cursor

OFF v

— Cursor Information

Display Cursor

— Coordinate Information
None
Absolute

Relative

Transfer

| WManual Transfer

_l-Coordinate Information

The mode in which to display the control point coordinates is selected here when grids
have been set in one of the editing modes.

Auto Transfer

None: The coordinates are not displayed.

Absolute: The coordinates with the top left control point used as the origin point are
displayed alongside the control points.

Relative: The coordinates with the initial position of the control point in the selected
grid used as the origin point are displayed alongside the control points.

If the grid intervals are narrow, the coordinates may not be displayed even when
Absolute or Relative has been selected.

- Manual Transfer
When this button is clicked, the edited settings are reflected in the projector.

— When a check mark is entered in [__| Auto Transfer | as soon as a setting is changed, that
setting is reflected in the projector.

The state when this software is exited will continue when the software starts next time.
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[AUTO ADJUST] (Auto Screen Adjustment) button

This allows automatic adjustment of geometry correction, edge blending, color, and brightness according to the shape of the
screen through use of an externally connected camera.

Click the [AUTO ADJUST] button to display the Auto Screen Adjustment screen.

& “Auto Screen Adjustment” (page 115)

If you click the [AUTO ADJUST] button while the “Auto Screen Adjustment plug-in software” is not installed, a message
indicating that installation of the plug-in software is required will appear. Also, if you click the [AUTO ADJUST] button while
the combination of the versions of “Geometric & Setup Management Software” and “Auto Screen Adjustment plug-in software”
is inappropriate, an error message will appear. Check the version number of “Auto Screen Adjustment plug-in software”
displayed in the error message, and then reinstall “Auto Screen Adjustment plug-in software” so that its version is appropriate.
&= “Installing the “Auto Screen Adjustment plug-in software” (page 8)

Status bar

This is where the progress made in the data transfer, error messages and expansion ratio of the editing area are displayed.
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Lens Settings

The lens settings are selected on this screen. This may be disabled depending on the model.

Lens setting screen

@ © 0O @ @O ® B ®

@ Geometry Manager Pro — [m] X
File Edit View Tools Version
[~ =] G‘ ‘lL] |D R i@ AUTO ADIUST
ERY Lens Sefing | Geometry | Edge flendng | uritormie]| Brigntness coftrol | color atoning | maskinf | input fional | omfr |
01 PROJECTORT (0.0.0.1) Lens Postto Lens Memory
02 PROJECTORZ (0.0.0.2) lLens Type ET-D3LEWG0 l——
03 PROJECTORZ (0.0.0.3) 1 Rename | Load save || Dekte
04  PROJECTOR4 (0.0.0.4) [-500/ +1000/0/89] Laoe oo i
05 PROJECTORS (0.0.0.5) v
% v Eﬂnw’ Zrmh'_ rename | Loas | save | oeete Lens 0 ALL @
) [ -500/ +1000/ 0/ 99 ]
07 PROJECTORT (0.00.7) Lens lame Lensot @
08 PROJECTORE (0.0.0.8) sraWhF Rename | Loag | save [ Dekte
A LA ] Active Focus Optimizer
o H Del H e 4 Rename Load Save Delete Active Focus. OFF v @
i c ename. [-500/ +1000/ 0/ 99 ]
Display Projector Name RIS Brignt [ =
5 Rename |§  Load Save Delete = @
[-500/ +1000/ 0/ 99 ] Dark o
Power ON Standby v =
8, Rename. Load Save Delete Test Pattern OFF v @
[-500/ +1000/ 0/ 99 ]
Shutter Close Shutter Open o @
l initalize
7 Rename | Load Save || Dekte
05D ON 05D OFF
7 i T I [-500/ +1000/ 0/ 89 | |—
Status ON Status OFF
8 Rename | Load Save || Dekte
8 Lens Calbration 25001 +1000/0/28]
| CommandConiol l =
Postion 0 = Apply 9, Rename. Load Save Delete.
Test Pattern = [ -500/ +1000/ 0/ 99 ]
@ Postion 0 =TT Appiy
eEF > Ve Rename | Load Save Delete
-500/ +1000/ 0/ 88
D) et L l
Landscape o Far @ Near
1 ~| x [n - D
[ Use Square Grid
@ DiEglGroln | [ |:U = ’—‘pr l
oFF v L
Cursor Information
Display Cursor
Coordinate information
None
Absolute
Relative
@ LeosZoon
Tele wide
Manual Transfer
{3
| =
@ JLere zoom 0 = Apply
# "Lens Type” This data cannot be applied. Please check the status of the projector, 3 x1/4
### "Lens Type” This d be applied. Please check th f the projector, #22 /4 NUM

@ Upward
Use this to move the projected image upward.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order; A , £y , E3

@ Leftward
Use this to move the projected image toward the left.
When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.
In such cases, the amount of movement increases progressively for each button in the following order; B , E , @

@ Rightward
Use this to move the projected image toward the right.

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model. -
In such cases, the amount of movement increases progressively for each button in the following order; E] , [L , &]

51



Adjustment and Settings Lens Settings

@

Downward

Use this to move the projected image downward.

When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the amount of movement increases progressively for each button in the following order; E , [? , [3

Vertical Position

Specify the vertical position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Horizontal Position

Specify the horizontal position of the image as a numerical value.
Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Home Position
Click to move the lens position to the home position.

Lens Calibration
Click to automatically set the limit to which the lens is to be moved and the home position of the lens.

Lens Focus (Far)

Click these buttons to adjust the focus to “far”.

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the further toward the left the button is located, the further the focus will move.

Lens Focus (Near)

Click these buttons to adjust the focus to “near”.

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the further toward the right the button is located, the closer the focus will move.

Lens Focus

Specify the focus position as a numerical value.

Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

Lens Zoom (Tele)

Click these buttons to reduce the size of the projected image (zoom out).

When you click and hold the button, the movement speeds up as with operations on the remote control.
There may be three buttons depending on the projector model.

In such cases, the image is reduced in progressively larger steps by clicking the buttons progressively further toward the
left.

Lens Zoom (Wide)

Click these buttons to enlarge the size of the projected image (zoom in).

When you click and hold the button, the movement speeds up as with operations on the remote control.

There may be three buttons depending on the projector model.

In such cases, the image is enlarged in progressively larger steps by clicking the buttons progressively further toward the
right.

Lens Zoom

Specify the zoom position as a numerical value.

Move to the specified position by clicking the [Apply] button.

This function can be used only for projectors that have this function.

52



Adjustment and Settings Lens Settings

®

Lens Memory Save

Click these buttons to save the focus position, shift position and zoom position of the adjusted lens in the projector's lens
memory.

The number of lens memories available for saving lens settings varies according to model.

Even if a check mark has not been entered for || Auto Transfer | the settings are saved in the lens memory when the
[Save] button is clicked.

This function can be used only for projectors that have this function.

Lens Memory Load

Click these buttons to select and load the lens memory whose settings are saved in the projector.

The lens will move automatically to the saved focus position, zoom position and shift position.

Even if a check mark has not been entered for || Auto Transfer , the settings are loaded from the lens memory when the
[Load] button is clicked.

This function can be used only for projectors that have this function.

Lens Memory Rename
Click these buttons to rename the lens memory settings.
When one of the buttons is clicked, the [Rename] screen is displayed.

Rename X

New Name

LENSMEMORYZ

When a new name is input and the [OK] button is clicked, the [Rename] screen is closed, and the name of the projector’s
lens memory settings is changed.

A name can consist of a maximum of 16 characters including letters, numbers, hyphens and periods.

If the [Cancel] button is pressed instead, the [Rename] screen is closed without renaming the lens memory settings.

This function can be used only for projectors that have this function.

Lens Memory Delete

Click these buttons to delete the settings saved in the lens memory of the projector.

Even if [_| Auto Transfer Transfer is not checked, the settings are deleted from the lens memory when the [Delete] button
is clicked.

This function can be used only for projectors that have this function.

Lens Memory Position

These display the value of each position of the lens memory saved to the projector.

The values are Lens Shift Vertical, Lens Shift Horizontal, Lens Focus, and Lens Zoom in order from the left.
If the corresponding value is not saved, that value will not be displayed.

This function can be used only for projectors that have this function.

Lens Type
Specify the lens part number.
This function can be used only for projectors that have this function.

Lens ID
Specify ALL or a value within the range of 1 to 255 for the ID used for lens identification.
This function can be used only for projectors that have this function.

53



Adjustment and Settings Lens Settings

@ Lens Name
Specify the lens name.
A name can consist of a maximum of 12 characters including letters, numbers, hyphens, and periods.
This function can be used only for projectors that have this function.

@ Active Focus
Enable or disable the active focus optimizer function.
This function can be used only for projectors that have this function.

@ Focus Offset
Set the focus correction amount for when the maximum specified brightness has entered the lens or when little light
enters the lens in Bright and Dark, respectively.
This function can be used only for projectors that have this function.

@ Test Pattern
Select the test pattern for adjustment with the active focus optimizer function.
This function can be used only for projectors that have this function.

@6 Initialize

Initialize the Focus Offset value.
This function can be used only for projectors that have this function.

The screen will be as follows for some projectors.
Lens Position

Lens Position

o— CGEOED

Home Position
Lens Calibration

‘eertical Fosition 0 = Apply
[ E

Apply

Horizontal Posttion

@ Slider Bar
Use this to move the projected image up, down, left, and right.
You can operate the slider bar by dragging the slider button at the center along a rail. Operation is performed at three
speeds (low, medium, and high), depending on the distance of the drag position from the center.
This function can be used only for projectors that have this function.
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Lens Settings

Lens Focus

Lens Focus
B Hear

Lens Type

ET-EMSB00

[Adive Focus

= 306

Periphery Focus

O—=

@

@ Periphery Focus (Far)
Adjust the periphery focus of projected images to “far”.

When you click and hold the button, the movement speeds up as with operations on the remote control.

This function can be used only for projectors that have this function.

@ Periphery Focus (Near)
Adjust the periphery focus of projected images to “near”.

When you click and hold the button, the movement speeds up as with operations on the remote control.

This function can be used only for projectors that have this function.

@ Active Focus

Enable or disable the temperature feedback function of the lens focus.

Lens Focus
Far Near

>— AOD

Periphery Focus

Far Near

>— AOD

@ Slider Bar (Lens Focus)
Adjust the focus of the projected image.

You can operate the slider bar by dragging the slider button at the center along a rail. Operation is performed at two
speeds (low and high), depending on the distance of the drag position from the center.

This function can be used only for projectors that have this function.

@ Slider Bar (Periphery Focus)
Adjust the periphery focus of the projected image.

You can operate the slider bar by dragging the slider button at the center along a rail. Operation is performed at two
speeds (low and high), depending on the distance of the drag position from the center.

This function can be used only for projectors that have this function.
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Lens Zoom

Lens Zoom
Tele Wide

—aon QB

() slider Bar
Enlarge or reduce the size of the projected image.
You can operate the slider bar by dragging the slider button at the center along a rail. Operation is performed at two
speeds (low and high), depending on the distance of the drag position from the center.
This function can be used only for projectors that have this function.
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Geometry Correction

Test patterns or grids are projected onto the screen and those parts of the image that look unnatural are corrected.
By adjusting the number of grids or number of control points, the images can be made to look more natural.
Use the mouse to make coarse corrections, and use the cursor keys on the keyboard or input numerical values to make fine
corrections.
® Drag the control point with the mouse while holding down the Shift key to move it in either the horizontal or vertical
direction.
® Select the control point and then press the cursor key to move it in increments of 1 pixel. Press the cursor key while
holding down the Ctrl key to move it in increments of 0.2 pixel. Press the cursor key while holding down the Alt key to
move it in increments of 4 pixels.
You can also select and move the control points with a gamepad.
&~ “Gamepad Operation Preparation” (page 152)

When the number of grids displayed during ongoing adjustments is reduced, the corrected grid information may be lost.
It is recommended that a small number of grids be displayed first to make coarse adjustments and then a larger number of
grids be displayed to make fine adjustments.

Geometry screen

@ Geomptry Manager Pro - [m] X

Filel Edit Viewl Tools Version

= = I ] @ Q Elﬁl\ﬂlq‘gl II [] .I FEEEEEEEEE] @@ AUTO ADIUST
~

* &

02 PROJECTOR2 (0....
03 PROJECTOR3 (0....
04 PROJECTOR4 (0....
05 PROJECTORS (0....
06 PROJECTORG (0....

(©

(0

-
Lens Setting ‘Geometry Edge Blending | Uniformity | Brightness Control | Color Matching | Masking | Input Signal | Other

o7 PROJECTORT (0.
08 PROJECTORS (0.

Power ON Standby

Shutter Close || Shutter Open

08D ON 0OSD OFF
Status ON Status OFF

Status Page | Prev | | Next

Command Control

Test Pattern
OFF v

Image Direction

Landscape v

Grid Resolution

3 v x 3 ~
[ Use Square Grid

Display Grid Lines

OFF v

Moving Area
Cursor Information PCA1 | Date Modified 202212007 123456 g ‘ 0 =] O Smoothing [ Alert Distortion |  Stare L
[ Display C: =
4] Display Cursor Free Grid (PJ) |OFF Import FREE GRID

Grid Aspect
Coordinats Information
o Default v X

() Relative

Free Grid

Transfer
Manual Transfer 1 |/.—‘_

Auto Transfer

SN

e

Y

x1/4

(1) Sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
® The red frame around the Sub Window indicates the display range in the editing area.
® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.
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@ Zoom In

Zooms in to the editing area.

@ Zoom Out
Zooms out the editing area.

@ wnite

This corrects the RGB color components together.

This may be disabled depending on the model.

@ Red, Green, Blue
These correct only the component of the selected color.

This may be disabled depending on the model.

@ Editing Area
The image can be corrected by selecting the grid using the mouse.
The settings established in the operation area are also reflected in this area.
The outermost red frame indicates the maximum area which can be projected.
The red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left when the
Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image Direction
setting.

@ Operation Area
This is where the buttons, slide bars, etc. used by geometry correction are displayed.
The operations that they perform differ depending on which correction pattern has been selected.
&= “Operation area” (page 60)

Edit, View

The following menu items can be used on the Geometry screen.

Edit submenu
Lock
Locks the control points of the grids selected.

A locked control point will not move even if the correction pattern has been changed.
The lock will not be released even if the number of grids has been changed.

Unlock
Unlocks the control points that have been selected.

Free
Click to release the control point selection.

Reset
Click to return the selected control points to the initial status.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
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View submenu

Image Direction
Match the direction of the editing area to the images projected by the projector.
This performs the same operation as Image Direction in the common operation area.

Grid Resolution
Use Square Grid
This makes it possible to select the combination of the number of grids which can be selected when a check
mark has been entered for [_| Use Square Grid in the common operation area.
X
The number of grids in the horizontal direction is selected here.
This performs the same operation as Grid Resolution (horizontal) in the common operation area.

Y
The number of grids in the vertical direction is selected here.
This performs the same operation as Grid Resolution (vertical) in the common operation area.
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m Operation area

Moving Area &‘ . I . I
PCA1 ~ | Date Modified §2022/12/07 12:34:56 I t 0 = Smoothing Alert Distortion Store v
(Q) —F—Grid Aspect Free Grid (P)) [oFF  ~ | Import FREE GRID |
Default w X
Free Grid

@

AR\ e

@ Mode Switching
OFF: Disables geometry correction.
PC-1/PC-2/ PC-3: Enables geometry correction.

When geometry correction is enabled, only one piece of data (PC) can be saved for some models.

@ Date and Time Stored
This displays the date and time that the geometry correction data was saved inside the projector.
The indication is “----/--/-- --:--:--" for a model that does not support this function.

@ Moving Area
Set here the range of the effects exerted on the grids around the control points that have been dragged and moved.

@ Smoothing

Correction using curves can be performed when a check mark is entered in /| Smoothing

Example when the check mark is entered Example when the check mark is not entered

®) Alert Distortion

If a setting exceeding the geometric distortion limit is sent to the projector when [¥] Alert Distortion has been checked, an
error message will be displayed on the dialog screen. The error message will be displayed on the status bar if a check

mark has been entered in || Auto Transfer,
/| Alert Distortion is checked as the default setting.

When a check mark is not entered for || Alert Distortion , even settings exceeding the geometry correction limits can be
sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.

@ Store

Click this button to save the current settings inside the projector after they have been reflected in the projector. The
current Grid Resolution setting is also saved inside the projector at the same time.
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@

® A screen for selecting the save folder inside the projector may appear for some models.

® With some models, the Grid Resolution setting is not saved inside the projector. A screen for selecting whether to
save the Grid Resolution setting will appear when you exit this software, and you can save it to this software by
selecting [Yes]. The setting can be saved for up to 99 projectors, and is overwritten from the oldest save date and
time when the upper limit is reached.

Geometry Manager Pro x

Save the grid number for each projector?

[ 7o Digabie this reminder, check this box.|

When the Grid Resolution setting is saved, the saved Grid Resolution setting will be loaded when the software is
started next time. However, the Grid Resolution setting inside the projector will be given priority for models that can
save it inside the projector.

Free Grid (PJ)
Enable or disable arbitrary geometry correction for the PC-1 to PC-3 currently selected for the projector.

This may be disabled depending on the model.

Import FREE GRID
Reflect the correction results of [FREE GRID] in the OSD menu of the projector.
This is applicable to the correction results of [FREE GRID] for the PC-1 to PC-3 currently selected.

This may be disabled depending on the model.

Gird Aspect

When the aspect ratios of the grid and projected image differ, switch the aspect ratio of the grid to match that of the
projected image.

For example, if the aspect ratio of the projected image is 4:3, the grid can be placed aligned with outer circumference by
switching Grid Aspect to 4:3.

® The quality of the projected image may momentarily change while Grid Aspect is switched to other than Default
because [SCREEN SETTING] and [ASPECT] in the OSD menu of the projector are switched and then processing is
performed by geometry correction.

® Even if Grid Aspect is switched to other than Default, clicking the Store button will return it to Default.

Display Switching
Click _¥_| to minimize the operation area; conversely, click _& Ito maximize it.
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Selecting the control points

Select the Geometry screen and switch the mode to other than OFF. The control points can now be selected.
&= “Free Grid (Free-form correction)” (page 63)
Drag the control points to move them. The control points cannot be moved by selecting the lines.

The control points can be selected using lines by
o clicking the space between one point where the grids
iii.iil intersect and another such point.

IREREEEREREER The control points can be selected using a multiple
=- . number of lines by dragging and enclosing the
spaces between one point where the grids intersect
and another such point.

BN '/hen a point where the grids intersect is clicked, it

“III' can be selected as a single control point.

T T 1]

L L [ 1 | []

By clicking (or dragging) while holding down the Ctrl key, another control point can be selected while the currently selected
control point keeps selected.

To move the selection to the adjacent control point, press the Tab key or Shift + Tab keys while one control point is selected, or
press the cursor key while holding down the Shift key.

To cancel the selection of the control point, click anywhere other than the grid with the mouse or select [Free] in the Edit
submenu displayed by right-clicking.

Right-clicking

The menu with the items described below is displayed when a grid control point is selected and the right button of the mouse
is clicked.

The menu functions are the same as with the Edit submenu.

&= “Edit submenu” (page 58).

Lock, Unlock, Free, Reset, Flip Vertical, Flip Horizontal
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Free Grid (Free-form correction)

The Free Grid operation area is where the operations for all the correction patterns are selected.

The corrections made with Free Grid are also reflected in the editing area of the other correction patterns. You can
superimpose corrections by selecting another correction pattern after making corrections with Free Grid, and then configuring
the settings of each correction pattern.

Moving Area X X
PC- ~ Date Modified 2022112007 1234:56 | & I:U =] [ Smoothing [ Alert Distortion v
Grid Aspect Free Grid (P)) [OFF v | Import FREE GRID |
Default ~ X
Free Grid
oS QN e A

@ Correction Patterns
Any of the following correction patterns can be selected.

Free Grid (free-form correction)

4 Corner (4-corner correction)

Keystone (keystone shape correction)

Cylindrical screen (cylindrical shape correction)

Elliptical screen (elliptical shape correction)

Spherical screen (spherical shape correction)

Rotation (rotational correction)

To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector, with the exception of
some projectors.

&= “Activation” (page 12)
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4 Corner (4-corner correction)

The positions of the four corners of the image are set with this type of correction.

1
Moving Area 5 . .
PCA ~ | Date Modified 2022/12/07 12:34:56 ] 0 = | O Smoothing Alert Distortion ‘ Store Import fram CORNER CORRECTION I L J
Grid Aspect Free Grid (PJ) OFF  w Import FREE GRID

Default ~ X

Linearity | [] Auto

v ] 0 = Reset
1 0 = Reset H 1 0 5 Reset
| 0 = Reset Pincushion | Upper 1 0 > Reset
1 0 = Reset Lower 1 0 S Reset
1 0 = Reset Left ] 0 = Reset
] 0.00 = Reset | 1 Fit Slzel Right 1 0 5 Reset
| || |
® ® @ ©) ®

@ Upper Left
Set the horizontal and vertical positions of the upper left.
The setting ranges vary depending on the projector model and resolution.

@ Lower Left
Set the horizontal and vertical positions of the lower left.
The setting ranges vary depending on the projector model and resolution.

@ Upper Right
Set the horizontal and vertical positions of the upper right.
The setting ranges vary depending on the projector model and resolution.

@ Lower Right
Set the horizontal and vertical positions of the lower right.
The setting ranges vary depending on the projector model and resolution.

@ Reset

Click these to reset the respective settings which have been changed.

S

Rotation [degree]*
Set the rotational angle of the image here.

@ Fit size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.
Linearity
Set the linearity in the horizontal and vertical directions.

When a check mark is entered for DNJTD, the linearity values are determined automatically from the positions of the
upper, lower, left, right, and four-corner points. In this case, values cannot be set.

This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UKZ20) has been applied to the selected projector, with the exception
of some projectors.
& “Activation” (page 12)
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€)

Pincushion

Set the pincushion independently for upper, lower, left, and right.

The setting ranges vary depending on the projector model and resolution.

The setting ranges are expanded when the upgrade kit (ET-UK20) has been applied to the selected projector.

Import from CORNER CORRECTION

Reflect the [CORNER CORRECTION] and [CORNER/PINCUSHION] adjustment items in the OSD menu of the projector.
This is available only for models that have the CORNER/PINCUSHION and CORNER/PINCUSHION adjustment
functions in the projector.

Keystone (keystone shape correction)

Images are corrected using the keystone shape as the reference with this type of correction.

@

®

Maoving Area

PCA v/ Date Modiied 2022112107 123456 | g [0 [y |/ Smostiing Akt izt [ swoe || imponfomkEYSTONE  |—%—h
Grid Aspect Free Giid (PJ) |OFF v/ | Import FREE GRID |
Default ~ X
Keystone _Setting
e Lens Throw Ratio 20 = Reset
m ) r’. C‘. g‘. | U |. V Keystone [degree] | 0.0 = Reset
— H Keystone [degree] 0.0 = Reset
i £ (o0 2 Reset
I I— x I— W Arc 0.0 = Reset
@ I @ 0.0 > Reset H Arc 0.0 = Resat
@ I @ 0 = Reset V Balance 0 = Reset
4B I B [o - Reset H Balance a S Reset
| | Rotation [degree] 0.00 |2 Reset [ Fit Sizel
@ @ ©) @ @ ®

Correction pattern adjustment area

Select the settings for vertical, horizontal, vertical balance, and horizontal balance here.

The setting ranges vary depending on the projector model.

The setting ranges for vertical and horizontal are expanded when the upgrade kit (ET-UK20) has been applied to the
selected projector.

Reset
Use these to reset the settings that have been changed.

Setting

Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Balance, H Balance, and Rotation* here.

The setting ranges vary depending on the projector model.

The setting ranges for V Keystone and H Keystone are expanded when the upgrade kit (ET-UK20) has been applied to
the selected projector.

Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size | the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.

Import from KEYSTONE
Reflect the correction results of [KEYSTONE] in the OSD menu of the projector.

* This item can only be configured if the upgrade kit (ET-UKZ20) has been applied to the selected projector, with the exception
of some projectors.
& “Activation” (page 12)
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Cylindrical screen (cylindrical shape correction)

Images are corrected using the cylindrical shape as the reference with this type of correction.

Maving Area

PCA | Dafe Modfied 202212007 123456 g S O Smoothing [ Alert Distortion |  Store ||| Import from CURVED CORRECTION
Grid Aspect Free Grid (PJ) |OFF  ~ Import FREE GRID
Default ~ e
Cylindrical screen Setting
- e Lens Throw Ratio 20 B Reset
l/"! | sl r'. C‘_ “ X | » I. V Keystone [degree] | 0.0 = Reset
H Keystone [degree] 0.0 = Reset
V Arc 0.0 = Reset
& I B (o0 = Reset H Arc 0.0 = Reset
& I ﬁ 0.0 = Reset V Balance 0 = Reset
H Balance 0 = Reset Maintain Aspect Ratiol
Rotation [degree] [ — Reset [ Fit Size] |
@ @ ©) @ @ ® ®

@ Correction pattern adjustment area
Select the settings for vertical arc and horizontal arc here.
The setting ranges vary depending on the projector model.
The setting ranges are expanded when the upgrade kit (ET-UK20) has been applied to the selected projector.

@ Reset

Use these to reset the settings that have been changed.

@ Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Arc, H Arc, V Balance, H Balance, and Rotation*
here.
The setting ranges vary depending on the projector model.
The setting ranges for V Keystone, H Keystone, V Arc, and H Arc are expanded when the upgrade kit (ET-UK20) has
been applied to the selected projector.

@ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for D Fit Size | the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

®) Import from CURVED CORRECTION
Reflect the correction results of [CURVED] or [CURVED CORRECTION] in the OSD menu of the projector.

@ Maintain Aspect Ratio
When a check mark is entered for [| Maintain Aspect Ratio | correction is made so that the aspect ratio of the projected
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UKZ20) has been applied to the selected projector, with the exception
of some projectors.
& “Activation” (page 12)
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Elliptical screen (elliptical shape correction)

Images are corrected to fit a screen whose shape is
elliptical when viewed from above.

Moving Area X X
PC1 | Date Modified 2022/12/07 12:34:56 {I |:U = | O Smoothing [ Alert Distortion L |

@
@
®

Grid Aspect Free Giid (P)) OFF v | Import FREE GRID |
’7 Default b X
—Elliptical screen ~ Setting
l/ﬂ rﬂ f' c‘ i‘ e |/1 Lens Throw Ratio 20 ) Reset
S 4 . * | I, V Keystone [degres] 0.0 = Reset
H Keystone [degree] 0.0 = Reset
B B (001 2] Reset
I |: = E Width/Radius Ratio 0.01 = Reset
B I ﬁ 1.00 - Reset Flattening 1.00 = Reset
m I E 0.0 = Reset Azimuth 0.0 = Reset
B I B (o = Reset V Balance 0 > Reset  |[] Maintain Aspect Ratio |
| | Rotation [degree] 0.00 2 Reset E Fit Size |
@ @ ©) @ @ ®

Correction pattern adjustment area
Select the settings for width/radius ratio, flattening, azimuth, and vertical balance here.

Reset
Use these to reset the settings that have been changed.

Setting

Select the settings for Lens Throw Ratio, V Keystone, H Keystone, Width/Radius Ratio, Flattening, Azimuth, V Balance,
and Rotation* here.

The setting ranges for V Keystone and H Keystone are expanded when the upgrade kit (ET-UK20) has been applied to
the selected projector.

Fit Size*

Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.

Maintain Aspect Ratio

When a check mark is entered for [_| Maintain Aspect Ratic Aspect Ratio, correction is made so that the aspect ratio of the
projected image is maintained.

If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.

This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UKZ20) has been applied to the selected projector, with the exception
of some projectors.
& “Activation” (page 12)
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m Description of elliptical screen (elliptical shape correction) parameters

View of projector as seen from above

Tangent .. " idth/Radius Ratio -

Screen

NG H Keystone [degree]

Flattening
Projector
|
I Horizontal radius of
ellipsis
Example of settings
Setting item Calculation method Setting
Lens Throw Ratio Projection distance + width of image on flat screen 0.9
=3 870 mm +4 300 mm
H Keystone [degree] Angle formed with tangent of projection center 14.0
Width/Radius Ratio Width of image on flat screen + radius in horizontal direction of ellipsis 0.69
=4 300 mm + 6 200 mm
Flattening Radius in vertical direction of ellipsis + radius in horizontal direction of ellipsis 0.66
=4 110 mm + 6 200 mm
Azimuth Position of projected image center on ellipsis 40.0

Tangent --._ \

Screen

4110 mm

Projector

| 6 200 mm
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Spherical screen (spherical correction)

Images are corrected using the spherical shape as the reference with this type of correction.

Moving Area ) ; .
PC-1 v | Date Modiied 2022112/07 123456 I:U <7 | O Smoothing [ Alert Distortion v
Grid Aspect Free Giid (P)) |OFF  ~| | Import FREE GRID |
Default v X
Spherical screen _Setting

Lens Throw Ratio 2.0 Reset

A QNe, A

V Keystone [degree] 0.0 Reset

H Keystone [degree] 0.0 Reset

IR TLHE TLANE NS TEANE AR ISR} 3

V Arc 0.0 Reset
o) I E ‘ 0.0 = . Reset I H Arc 0.0 Reset
V Balance 0 Resst
H Balance 0 Reset Maintain Aspect Ratio|
Rotation [degree] 0.00 Reset ([ Fii Size
@ @ ©), @ ® ©

@ Correction pattern adjustment area
Select the settings for vertical arc and horizontal arc here.
The setting ranges vary depending on the projector model.
The setting ranges are expanded when the upgrade kit (ET-UK20) has been applied to the selected projector.

@ Reset

Use these to reset the settings that have been changed.

@ Setting
Select the settings for Lens Throw Ratio, V Keystone, H Keystone, V Arc, V Balance, H Balance, and Rotation* here.
The setting ranges vary depending on the projector model.
The setting ranges for V Keystone, H Keystone, and V Arc are expanded when the upgrade kit (ET-UK20) has been
applied to the selected projector.

@ Fit Size*
Projected images sometimes protrude beyond the projection area when they are rotated.
When a check mark is entered for || Fit Size , the image is reduced to a size in which it can be projected when it exceeds
the projection area.
The image will not be reduced if a check mark is not entered.

@ Maintain Aspect Ratio
When a check mark is entered for [ | Maintain Aspect Ratio | correction is made so that the aspect ratio of the projected
image is maintained.
If a check mark is not entered, the aspect ratio is not maintained and correction is made using the entire surface of the
display device.
This function can be used only for projectors that have this function.

* This item can only be configured if the upgrade kit (ET-UK20) has been applied to the selected projector, with the exception
of some projectors.
& “Activation” (page 12)
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Rotation (rotation correction)

Images are rotated with this type of correction.

To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector, with the exception of some
projectors.

& “Activation” (page 12)

Moving Area
PCA | Date Modified 2022/12/07 12:34:66 {I s [ Smoothing [ Alert Distortion \
Grid Aspect Free Grid (PJ) |OFF v/ | Import FREE GRID |
’7 Default v X
 Rotation Setting
- e Lens Throw Ratio 20 = Reset
|" . |__,> . f'. Q. '(;\. N |__, I. V Keystane [degree] 0.0 = Reset
H Keystone [degree] 0.0 = Reset
V Arc 0.0 = Reset
& I 2 |U'UU : ll Reset I H Arc 0.0 = Reset
\ Balance 0 = Reset
H Balance 0 o Reset
Rotation [degree] 0.00 S Reset | Fit Sizel
bt =

@ @ ® @ @

@ Correction pattern adjustment area
Select the setting for the gradient here.

@ Reset

Use these to reset the settings that have been changed.

@ Setting

Select the setting for the gradient here.
@ Fitsize
Projected images sometimes protrude beyond the projection area when they are rotated.

When a check mark is entered for || Fit Size | the image is reduced to a size in which it can be projected when it exceeds
the projection area.

The image will not be reduced if a check mark is not entered.
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Edge Blending

The joins between images can be corrected when constructing a multi-display screen by combining the projected images from
multiple projectors.
The correction method for edge blending differs depending on the projector model.

B When the projector does not support free-form correction

Set the start position, width, and black level border width for edge blending. Make the joins between the images less visible
by applying a brightness gradient to the parts where projected images overlap.

B When the projector supports free-form correction

Set the width and black level border shape for edge blending to free-form. Make the joins between the images less visible
by applying a brightness gradient using a border shape that matches the screen shape.

Edge Blending screen

B When the projector does not support free-form correction

® 2@ ®

@ Gednetry Manager Pro - m] x
File View Tools Version
EeevcE|DE O FEFEEFEFE] @ AUTO ADIUST
T+ ¥ Lens 5 Ilmg‘ Geomet} HE Blending  Uniforfity Bngnmesscuntrm| Color alr:mng‘ Masking InpulS\gna\l Dther‘
01 PROJECTOR1 (0.0.01) Mon-Overlapped Black Level Black Border Level
02 PROJECTORZ (0.0.0.2) o | 4] Nark Interiocked Interiocked

03 PROJECTORS (0.0.0.3)
04  PROJECTORM (0.0.0.4)
05  PROJECTORS (0.0.0.5)
06  PROJECTORS (0.0.0.6)
07  PROJECTORY (0.0.0.7)
06  PROJECTORE (0.0.0.8)

Upper
Enable Overlappad Black Leval

Start | 0 = Interiocked

Setting ) = =

2d || Del || Rename width 192 = R [} z

@ Black Border 128 1+ ® [} L
PrYeren

Keystone Area | 64 2 B [] @
| Power ON | | Standby |
Shutter Close Shutter Open Right
= = Enaple = (8)
0sD O 0SD OFF Enable | Enable . =
Status ON Status OFF Start [ 32 Start [ 0 B Start | 0 _—— @
Status Page | Prev Hext Width | 256 width | 128 = Width | 128 - @
| —
| | Black Border | 384 Black Border | 0 =
@ Command Control z Black Border | 0 - @
— Keyst ea | -256 Keystone Area | 0 = hd
Test Pattern Y
Overlapped Black Level Overiapped Black Level Keystone Area | 0  — @
i =z Interlocked Interlocked T
Image Dirzction R 0 R 0 B Overiapped Black LEVE] e— @
Lendscaps - s b G 0 : Interiocked
B 0 = 8 0 e "
Grid Resolution R 0 = .
" X mn ~ E o -
-
[ use square Grid =
Display Grid Lines B o =
OFF ~ [ Enable
0 Interlocked
@ 128 0 z
Display Cursor ) 5 =
Coordinate Information o 0 =
Mone
Absolute
@ Relative
Transfer

Manual Transfer

Auto Transfer

x1/4 NUM

@ Mode Switching
OFF:
The edge blending settings are canceled.

ON:
Makes the edge blending settings effective.

User:
Adjusts settings for edge blending using the user-defined curve.
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® Selecting User may not be possible depending on the model.
® When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

@ Marker

When a check mark is entered in [ Marker  markers are displayed in the editing area and on the images projected from
projector.

The start position for edge blending is indicated by display of a green line, and the edge blending width is indicated by
display of a red line.
&= “Editing Area” (page 73)

©

Setting
Click this button to display the user-defined curve setting screen.
&= “User-defined curve setting screen” (page 77)

Upper
The upper side settings of the projected image are set here.

Left
The left side settings of the projected image are set here.

Right
The right side settings of the projected image are set here.

Q0 @ @ ®

Lower
The lower side settings of the projected image are set here.

Enable

©®

Enter a check mark in [_|Enable to allow edge blending correction to be performed. Only the settings for items with a
check mark entered in |_|Enable take effect.

When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

@ Start

The starting position of edge blending is set here.

Width

The width of the edge blending is set here.

@ Black Border (Outside Area)
Set the border width of the black level.
[Outside Area] may be displayed in place of [Black Border] for some models.

@ Keystone Area
Set the slope of the black level border when using the edge blending at the same time as the keystone correction.
This function can be used only for projectors that have this function.

@ Overlapped Black Level (Bright Blending)
The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.
[Bright Blending] may be displayed in place of [Overlapped Black Level] for some models.

Interlocked

When a check mark is entered for Interlocked , Overlapped Black Level can be set with the Red, Green and Blue values
all linked together.
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@ Non-Overlapped Black Level (Bright Inside)
The black level inside the area where the images are to be superimposed is set here.

When a check mark is removed from [V Interlocked , the Red, Green and Blue values can be set separately.
[Non-Overlapped Black Level] may be displayed in place of [Bright Inside] for some models.

Black Border Level (Bright Outside)
Set the black level of the parts where images are superimposed.

When a check mark is removed from [¥]Interlocked | the Red, Green and Blue values can be set separately.
[Black Border Level] may be displayed in place of [Bright Outside] for some models.

@ Editing Area
The edge blending setting status is displayed here.
By dragging these markers, the start position of the edge blending (green), edge blending width (red), and black level
border width (yellow) can be set.
The settings established with Upper, Left, Right and Lower are also reflected in this area.

The line for the black level border width (yellow) is displayed only when the mouse cursor is positioned on the marker
(yellow).

Start (Edge blending start position)

Black Border (Black level border width)
Width (Edge blending width)

1 Edit
In addition to the menu items described in “Main menu” (page 38), the following menu items can be used on the Edge
Blending screen.

Edit submenu
Flip Vertical:
Click to flip vertically the correction status of the entire image.

Flip Horizontal:
Click to flip horizontally the correction status of the entire image.
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B When the projector supports free-form correction

jut

@ Geometry Manager Pro - [m] X
File Edit View Tools Version
EeEc|vclmlo=olas FFFEEEEE] @@ AUTO ADIUST

L Lens Setting | Geometry |[Edge Blending. Unitormiy | Brighiness Control | Color Matching | Masking | nput Signal | other |

01  PROJECTOR{ (0.0.0.1)

ace || oel | Rename

Display Projector Name

Shutter Close Shutter Open

03D ON 05D OFF

Status ON Status OFF

Status Page | Prev. Next

Command Contral

Test Pattern

OFF -

Image Direction

Landscape -

Grid Resolution
1 o x 1 -

[ use square Grid
Display Grid Lines
oFF -

Cursor Information

Display Cursor

Coordinate Information
@ None. Edge Blending _Black Level Adjustment
Abselute
OReiative Edoe Blend Mode oN ~ User Blending Curve: Defautt Black Level Area Geometry Linked ~
SR
Start Width R G B

Auto Transfer
Upper Enable [] <+ 2% 5 Upper [ interlocked 0 < 48 < 0 <
Lower [ Enabe ] < 128 % Lower Interlocked 0 B 0 < 0 Z
Right [ Enable o B 128 5 Right Interiocked 0 s [ s 0 =

x1/4 NUM

@ Editing area
The edge blending width and black level border shape can be set by operating the adjustment points with the mouse.
The settings configured in the operation area are also reflected in this area.
The outmost red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left when
the Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image Direction

setting.

The line for the black level border width (yellow) is displayed only when the mouse cursor is positioned on the marker
(yellow).

® Operation area
This is where the buttons and other controls used for edge blending are displayed.
Switching between edge blending and black level adjustment changes the operations that they perform.
&~ “Edge Blending” (page 75)
&= “Black Level Adjustment” (page 76)

@ Zoom In

Zooms in to the editing area.

@ Zoom Out
Zooms out from the editing area.
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Edge Blending

©),
Edge Blending  Black Level Adjustment
@— Edge Blend Mode on w|l  user Blending cuge IBIack Level Area Geometry Linked ~ I
@— Edge Blend Marker ON ~ | Set;mg | Overiapped Biack Level
R G B
@— Upper Enable Upper [ interlocked 0 : 43 : 0 :
@— Lower ] Enable Lower Interlocked 0 = 0 = 0 <
@— Left Enable Let nterlocked 2 2 [z ] [ &
@— Right [ enabie Right Interlocked 0 < 0 < 0 <
| |
@

(1) Edge Blend Mode
OFF:
The edge blending settings are canceled.

ON:
Makes the edge blending settings effective.

User:
Adjusts settings for edge blending using the user-defined curve.

When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

@ Edge Blend Marker
When this is set to ON, markers (lines) are displayed in the editing area and on the images projected from the projector.
The start position for edge blending is indicated by display of a green line, and the edge blending width is indicated by
display of a red line.

@ Setting

Click this button to display the user-defined curve setting screen.
&= “User-defined curve setting screen” (page 77)

Upper
The upper side settings of the projected image are set here.

Lower
The lower side settings of the projected image are set here.

Left
The left side settings of the projected image are set here.

Q @ @© ®

Right
The right side settings of the projected image are set here.
Enable

Enter a check mark in [:]Enable to allow edge blending correction to be performed. Only the settings for items with a
check mark entered in [_|Enable take effect.

When the input signal of the projector has been changed, it may be necessary to re-set the edge blending mode and the
Upper, Lower, Left and Right Enable boxes.

Q) start

The starting position of edge blending is set here.

Width

The width of the edge blending is set here.

)
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@) Black Level Area
The area of black level adjustment is set here.

Geometry Linked:
Black level adjustment is performed only in the video display area.

Geometry Unlinked:
Black level adjustment is performed for the entire display panel area.

@ Overlapped Black Level
The Red, Green and Blue values are adjusted here to set the brightness of the areas subject to edge blending.
These settings are applied to the edge blending width. The higher the numerical value, the brighter the colors.

Black Level Adjustment

@
Edge Blending || Black Level Adjustment
@H Black Level Mode Soft Edge / Black Level ~ I I Auto Test Pattern OFF ~ I
R G B

@— Non-Overlapped Black Level Interlocked T 0 Y 0 Y
@— Black Border Level ] interiocked Bz = 0 = 0 =

Black Border Area

Width Free Shape Adjustment Points.

Upper 128 = Enable 9 v
®— o5 Qe B

Left 0 = Enable 2 - Initialize Shape

] 2| [Oenabe 2 Initialize Shape

@ Black Level Mode
Soft Edge / Black Level:
Edge blending and black level adjustment are performed at the same time.

Black Level Only:
Only black level adjustment is performed.

@ Auto Test Pattern
When this setting is ON, the Black pattern is shown on the projected image when you go to this screen.

@ Non-Overlapped Black Level
The black level inside the area where the images are to be superimposed is set here.

When a check mark is removed from Interlocked | the Red, Green and Blue values can be set separately.
@ Black Border Level

Set the black level of the parts where images are superimposed.

When a check mark is removed from Interlocked | the Red, Green and Blue values can be set separately.

@ Black Border Area
Set the black level border.

Width:
Set the width of the black level border.

Free Shape:
Select the [ |Enable check box to set the black level border shape to free-form.

Adjustment Points:
Specify the number of adjustment points. You can select from 2, 3, 5, 9, and 17.

Initialize Shape:
Initialize the black level border settings.
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Edge Blending

User-defined curve setting screen

When [Setting] is clicked, the user-defined curve setting screen is displayed.

The gradient (brightness gradient) at which edge blending is performed is set using a gamma curve.
When a user-defined curve setting is changed from the initial curve, the display above [Setting] changes from [User Blending
Curve: Default] to [User Blending Curve: Changed].

@
@

Geometry Manager Pro

Gain

x
Blendng
@ Uppert
OLeft
O Lower 1 @
() Right
Copy
From Upper
To Lower H— @
Copy
Gamma
| L—@3)
200 |5
Store ——— @
Resst e : )
oK p I I .
Apply p @
Cancel P .

Blending

The position where the user-defined curve is to be set is selected here.

Copy
Click this to copy the current user-defined curve setting.

The setting is copied from top to bottom (or vice versa) or from left to right (or vice versa).

Gamma
The user-defined curve is set here.

For numerical value input: Enter a setting from 0.25 to 4.00 (in 0.01 steps).

Initial Curve

The initial setting of the user-defined curve is displayed here.

Correction Curve

The operation point in the center can be dragged to change the user-defined curve setting (shape of the gamma curve).

Store

Click this to reflect the currently displayed user-defined curve setting in the projector and save the setting in the projector.
The setting remains saved even when the main power of the projector has been set to “off”.

Reset

Click this to reset the currently displayed user-defined curve setting and return it to the initial value.
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® ok

Click this to reflect the user-defined curve setting in the projector and close the user-defined curve screen.

This operation is reflected in the projector even when a check mark has not been entered in ("] Auto Transfer.
© Apply

Click this to reflect the user-defined curve setting in the editing area.

This operation is reflected in the projector even if a check mark has not been entered for [_| Auto Transfer,

Cancel

Click this to cancel the setting and close the user-defined curve screen.
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Uniformity

Correct the unevenness in color and brightness within the screen. This may be disabled depending on the model.
There are the following two correction methods for uniformity depending on the projector model.

B When DLP Projector

Gradient Correction

When unevenness in color occurs in one direction across the image, greater uniformity can be obtained by applying
correction in the vertical or horizontal direction.

Correction is performed by toning down (thinning) the selected color in a gradient-like manner from one side of the image to
the other.

Flexible Correction

If other than OFF was selected in Flexible Correction, correction can be performed by specifying ranges for the localized
unevenness of colors in the image.

When the image contains localized unevenness in color, correction is applied after specifying the range.

As with Gradient Correction, correction is performed by toning down (thinning) the selected color in a gradient-like manner.
& “Flexible Correction / PC Correction Procedure” (page 85)

To use the Flexible Correction function, the upgrade kit (ET-UK20) must be applied on the selected projector, with the
exception of some projectors.

&= “Activation” (page 12)

B When LCD Projector

User Correction

Greater uniformity can be obtained by applying correction in the directions of the four corners of the screen or in vertical or
horizontal direction.

Correction is performed by toning down (thinning) or toning up (deepening) the selected color in a gradient-like manner from
one side of the image to the other.

PC Correction

Correction can be performed by specifying ranges for the localized unevenness in the screen in the same way as Flexible
Correction.

Correction is performed by toning down (thinning) or toning up (deepening) the selected color in a gradient-like manner from
one side of the image to the other in the same way as User Correction.

To use the PC Correction function, the upgrade kit (ET-UK20) must be applied on the selected projector.
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Uniformity

Uniformity screen
B When DLP Projector
@

& Gednetry Manager Pro
File View Tools Version
==

==

[m] x

PR W@ AuTO ADIUST

* &
02 PROJECTORZ2 (0.0.0.2)
03 PROJECTORS (0.0.0.3)
04 PROJECTOR# (0.0.0.4)
05 PROJECTORS (0.0.0.5)
06 PROJECTORS (0.0.0.6)
o7 PROJECTOR7 (0.0.0.7)
08 PROJECTORS (0.0.0.8)
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® 6) ®

(1) sub Window

Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
The Sub Window displays a representation of the Gradient Correction and Flexible Correction settings for the entire

projection area.

® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

Zoom In
Zooms in to the editing area.

The center of the target area is zoomed in when the target area has been selected in the editing area.

Zoom Out
Zooms out the editing area.

Editing Area

A representation of the Gradient Correction and Flexible Correction settings is displayed.
When applying Flexible Correction, this is where you select target points and set the target area.
The outmost red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left

when the Image Direction setting is Landscape, and the location where it is shown also moves depending on the Image

Direction setting.

Mesh granularity in the editing area differs depending on the model.
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®

Gradient Correction

When applying gradation to the entire image, set the degree of color variation.

You can set this individually for each of the colors White, Red, Green and Blue, both for the vertical direction (V) and the

horizontal direction (H).

For numerical value input: Enter a value from -127 to 127.

® How the vertical (V) and horizontal (H) gradation slopes varies depending on the model. For details, refer to “Settings”
- “[DISPLAY OPTION] menu” - “[UNIFORMITY]” in the operating instructions of the projector.

Display on PC

When you put a check in (V] Display on PC , the Gradient Correction settings are applied in the editing area.

Put a check here when you want to see the combined effect of Gradient Correction settings and Flexible Correction
settings in the editing area.

When the check is removed from || Display on PC , the Gradient Correction settings are not applied to display in the editing
area. The settings will still be reflected in the projector, however.

Lamp Status
When a projector that uses a lamp as light source is selected, this indicates the lamps that are currently lit.
[None] is displayed if none of the lamps is lighted.

This may be disabled depending on the model.

Gradient Correction

Display on PC | (Lamp 1 /Lamp2/Lamp 3/Lamp 4} |

White W 1 0 2 Reset

White H 1 0 2 Reset
Reset

Return the Gradient Correction and Flexible Correction settings to their default values.

Switch mode

OFF: Disable the Flexible Correction settings.

Geometry Linked:  Enable the Flexible Correction settings and process before geometry correction.
Geometry Unlinked: Enable the Flexible Correction settings and process after geometry correction.

® The selection options may be [OFF] and [ON] depending on the model.

Right-clicking

If other than OFF was selected in Flexible Correction, clicking the right button of the mouse in the editing area displays
a menu with following items. The functions of these items are the same as with the Edit submenu items.

&= “Edit submenu” (page 82)

Reset, Flip Vertical, Flip Horizontal, Area Select, Point Select

Flexible Correction

When correcting partial unevenness in image color, you can set the degree of the change in the gradation color to be
applied to the area surrounding the selected target point.

This setting can be made individually for each of the three colors Red, Green, and Blue.

Setting range: 0 to 1023

Interlocked

By putting a check in Interlocked , you can set Flexible Correction to link the value set to all three of colors Red, Green,
and Blue.
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@

Mode

Chroma Only: Correct only the unevenness of colors. Select this when giving priority to the brightness of the overall
projected image.

Luminance / Chroma: Correct the unevenness of luminance and colors.

This may be disabled depending on the model.

Store
Reflects the gradation settings in the projector and saves them in the projector.
The settings are maintained even when the main power of the projector has been turned off.

Factory Default
Discard the current Flexible Correction settings and initialize to the factory default state.

This may be disabled depending on the model.

Generate from Geometry

Generate the data of Flexible Correction based on the adjustment data of geometry correction.

If you select the adjustment data of geometry correction to reference, a selection screen appears for selecting whether or
not to display in combination with the Flexible Correction data currently being adjusted or to discard that data and create
new data.

Gamma

Perform inverse gamma correction to remove gamma value influence.
Setting range: 1.0 to 2.8 (in 0.1 steps)

Adjustment may not be possible depending on the model.

Edit
In addition to the menu items described in “Main menu” (page 38), the following menu items can be used on the
Uniformity screen. However, these menu items are valid only when the Flexible Correction method is used for correction.

Edit submenu
Reset
Return the Gradient Correction and Flexible Correction settings to their default values.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.

Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Area Select
While an area is selected, its control points are displayed.
The target area can be enlarged or reduced or moved using the control points.
® [Area Select] cannot be selected concurrently with [Point Select].

Point Select
Confirms settings for the target area currently being set.
® [Point Select] cannot be selected concurrently with [Area Select].
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@ Mode Switching
OFF: Disable the uniformity adjustment settings.
Use: Enable the User Correction settings.
PC: Enable the PC Correction settings.

Only one of User Correction and PC Correction can be enabled.

@ User Correction
Correct the brightness and color unevenness of the overall screen in Upper Left, Lower Left, Upper Right, Lower Right,
Upper, Lower, Left, Right and All.
The setting range differs depending on the model.

® The setting range is limited depending on [Adjustment Level].
® The correction of All may not be supported depending on the model.
® The area to adjust differs depending on the model.

@ Adjustment Level
Specify the adjustment level of images.
The higher the value, the darker the images.
The setting range differs depending on the model.

@ Test Pattern
OFF: A test pattern is not displayed during adjustment.
ON: A test pattern is displayed during adjustment.
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®
®
@

Reset
Return the corresponding User Correction and PC Correction settings to their default values.

Initialize
Initialize the User Correction and PC Correction settings for the currently selected adjustment level.

PC Correction

When correcting partial unevenness in image color, you can set the degree of the change in the gradation color to be
applied to the area surrounding the selected target point.

This setting can be made individually for each of the three colors Red, Green, and Blue.

The setting range differs depending on the model.

The setting range is limited depending on [Adjustment Level].

Interlocked
By selecting the Interlocked check box, you can set PC Correction by linking the three colors Red, Green, and Blue with
the same value.

Store

Reflect the PC Correction settings for the currently selected adjustment level in the projector and save the setting values
in the projector.

The settings are maintained even when the main power of the projector has been turned off.

Copy to Other Level
Copy the PC Correction settings for the currently selected adjustment level to another adjustment level.

The data saved in the projector can be copied. If you wish to copy the data you are working on, save it to the projector
first and then execute this.

Edit

In addition to the menu items described in “Main menu” (page 38), the following menu items can be used on the
Uniformity screen. However, these menu items are valid only when the PC Correction method is used for correction.

Edit submenu
Reset
Return the User Correction and PC Correction settings to their default values.
This item cannot be selected when [Area Select] has been selected.
Neither can it be selected when the target area has not been set.

Flip Vertical
Click to flip vertically the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.
This item cannot be selected when [Area Select] has been selected.

Area Select
While an area is selected, its control points are displayed.
The target area can be enlarged or reduced or moved using the control points.
® [Area Select] cannot be selected concurrently with [Point Select].

Point Select
Confirms settings for the target area currently being set.
® [Point Select] cannot be selected concurrently with [Area Select].
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Flexible Correction / PC Correction Procedure

Select the target point from which gradation is to be applied, and then specify the target area (the range to be corrected) and
apply correction. When doing this, specify the points at which grid lines cross as target points.

Editing area

Target point

-
-l

Target area

Operation point

1 Select other than OFF in Flexible Correction for a DLP projector and select PC in Flexible Correction for an LCD
projector, and enable the Flexible Correction / PC Correction settings.

2 Click or drag the mouse to select a target point.

You can also select multiple target points at the same time.
A red frame is displayed around the perimeter of the area defined by the selected target points, and this becomes the
target area (the correction area).
* The target area and target point can be selected using the same method as for the control points of the geometry
correction grid.
&= “Selecting the control points” (page 62)

3 Adjust the parameters.
Gradation is applied to the selected color toward the periphery of the target area, treating the target point as the starting
point.

4 Right-click and select [Area Select], and display the operation points (green) in the target area.

Using the mouse, drag the operation points to enlarge or reduce the size of the target area. Drag an operation point with
the mouse while holding down the Shift key to enlarge or reduce the size symmetrically with the center of the target area
treated as the target point.

If the mouse cursor is placed in the target area and then dragged, the target area can be moved.

® [Area Select] can also be selected on the Edit submenu.

Enlarging or reducing the size of the target area does not change the number of selected target points.

5 Right-click to select [Point Select], and release the operation point display.

@ [Point Select] can also be selected on the Edit submenu.

[Point Select] and [Area Select] can be toggled by pressing the space key.

6 Repeat the above steps when you want to apply correction to multiple target areas.

Where the target areas overlap, correction will be applied by multiplying the respective settings.
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Brightness Control

When a single image is configured using a multiple number of projectors, the brightness levels of the images projected from
the projectors may not be consistent. If this is the case, adjust the projectors so that the brightness levels are made consistent.
Brightness correction can also be made automatically at periodic intervals with some projectors.

This may be disabled depending on the model.

Brightness Control / Brightness Setting screen

& Geometry Manager Pro - m] ®
File Edit View Tools Version
LR =l @O FEFEEEEEE M AuTO ADIUST
T+ & L
ens Sefting | Geometry | Edge Blending | Uniformity || Brightness Control  Color Matching | Masking | Input Signal | Other
01 PROJECTOR1 (0.0.0.1) Brightness Control Gain
o DOOJECIOD2 0000,

©

03 PROJECTOR3 (0.0.0.3) I 1o :

04  PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5)
06 PROJECTORS (0.0.0.6)
o7 PROJECTORT (0.0.0.7)
08  PROJECTORS (0.0.0.8)

Brightness Control

agg I po 1 pepope Mode o

Display Projector Name:
e, Link OFF

OIS

! Brzeeer O 1 ! foo 1 Calibration Message
Chroma Correction
Shutter Close Shutter Open
: 05D ON 05D OFF [ calibration Time

IO STHTEOTT
00 i} Apply 7
Status Page Prev ‘ Next

Status
| Command Control ‘
Status  Message

Test Pattern Brightness control is set to OFF.

OFF ~

|

Image Direction Update @
Landscape ~

Grid Resolution
1 w XN ~

[ use Square Grid
Display Grid Lines
OFF v

Cursor Information

Display Cursor

@ The items displayed will vary depending on the projector you are using.

Brightness Control Gain

Lens Set'ting| Genmetr:.r| Edge Blending| Unifl:lrrn'rty| Brightness Control  Color Ma
Brightness Control Gain
I 100 =

This is where the projector brightness is set.
The brightness of the image projected from the projectors is set according to the numerical value that is set here.

Operating Mode

Lens Setting | Geumetr:.r| Edge Blending | Uniformity | Brightness Control  Color Matching | Maskin
Operation Setting

Operating Mode MNormal ~

Max Light Output Level o000 —

Light Dutput I e 1=

This is where the operating mode of the projector is set.

L3
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High:
This reduces the life of the light source more than Normal, but select this when a higher level of brightness than
Normal is required.

Normal:
Select this when a high level of brightness is required.

Eco:
This mode produces a lower brightness than in [Normal] mode, but extends the life of the light source.

Quiet/Quiet1/Quiet2:
These modes produce a lower brightness than in [Normal] mode, but set them when prioritizing operation with low
noise.

Long Life1/Long Life2/Long Life3:
These modes produce a lower brightness than in [Eco] mode, but extend the life of the light source.

User1/User2/User3:
These modes allow you to configure separate [Max Light Output Level] and [Light Output] settings.

For details, refer to the operating instructions of the projector.

Max Light Output Level
This allows you to adjust the upper limit for brightness correction of the screen based on the change in brightness of
the light source.
Some models do not support this function.

Light Output
This allows you to adjust the brightness of the light source.

@ Mode

This is where the brightness correction mode is selected.
Some models do not support this function.

OFF:

The brightness is not corrected.

Auto:

The brightness levels of the images projected from the projectors are corrected by the brightness sensors of the
projectors.

For details, refer to the operating instructions of the projectors concerned.

PC:

The brightness levels of the images projected from the projectors are corrected using the “Multi Monitoring &
Control Software”.

For details, refer to the Operating Instructions of “Multi Monitoring & Control Software”.

@) Link
This is where the link mode is set.
The mode is enabled when [Auto] has been selected as the Mode setting.
Some models do not support this function.
OFF:
The brightness level of the selected projector is corrected.

Group A/Group B/Group C/Group D:

The brightness levels of the projectors in the respective group are corrected.
The groups are set using the network function of the projectors.

For details, refer to the operating instructions of the projectors.

@ Calibration Message

When a check mark is entered for [¥] Calibration Message | g message is displayed while measuring the brightness levels for
correcting the brightness.

This may be disabled depending on the model.
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@ Chroma Correction

When a check mark is entered for ¥/ Chroma Correction | color is adjusted together with brightness.
This may be disabled depending on the model.

@ Calibration Time
The time at which to start measuring the brightness levels for correcting the brightness is selected here.

The time can be set when a check mark is entered for (¥ Calibration Time .
This may be disabled depending on the model.

@ Apply
Click this to reflect the brightness correction setting on the projector.
If Mode is set to OFF, brightness correction ends. In other cases, brightness correction is executed.
With some models, you can select whether to re-execute brightness correction with the settings used last time or newly
execute brightness correction with the current settings.
Some models do not support this function.

Status

This displays the brightness correction-related status.
Some models do not support this function.

Status Message Description

Brightness sensor error Something is wrong with the brightness sensor (projector).

Red Cannot apply Brightness Control. The brightness cannot be corrected due to a factor that is not
Please check projector status. related to the brightness sensor.

Yellow The brightness can no longer be The brightness that can be corrected by the projector is
corrected by a significant margin. reaching its limit.

Green No Error Normal condition.

Gray Brightness Control is set to OFF. The brightness control is set to off.
The projector is standby or cooling. The power of the projector is in standby state or cooling.

@ Update

Click this button to check the projectors and update the Status displays.
Some models do not support this function.
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Color Matching / Color Adjustment

When configuring a single image using a multiple number of projectors, the coloring of the image projected from the various
projectors may not be consistent. If this is the case, adjust the projectors to match the coloring.
This may be disabled depending on the model.

Color Matching / Color Adjustment screen
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® @

The items that can be adjusted, setting details, and setting range vary depending on the model.

@ Mode

The color matching mode is selected here.
OFF
Color matching is not performed.

3 Colors
The inconsistencies in the colors are corrected by adjusting three colors (Red, Green and Blue).

7 Colors
The inconsistencies in the colors are corrected by adjusting seven colors (Red, Green, Blue, Cyan, Magenta, Yellow
and White).
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709 Mode

The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.

The Target Data values are fixed.

709 Mode cannot be selected for some models. For details, refer to the Operating Instructions of the projector.

Measured

The brightness (Y) and chrominance coordinate (x, y) values are adjusted here based on the values obtained using
a coloring chromoscope capable of measuring chrominance coordinates and brightness levels.

The Target Data values can be adjusted.

Selecting [Measured] may not be possible depending on the model. For details, refer to the Operating Instructions of
the projector.

@ 3 Colors

The Red, Green and Blue values are set here.
The settings take effect when [3 Colors] has been selected as the Mode setting.
The White value can be set in addition to the Red, Green and Blue values for some models.

@ 7 Colors

The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [7 Colors] has been selected as the Mode setting.

@ Measurement Data
The Black, Red, Green, Blue and White values are set here.
The settings take effect when [709 Mode] or [Measured] has been selected as the Mode setting.

@ Target Data
The Red, Green, Blue, Cyan, Magenta, Yellow and White values are set here.
The settings take effect when [Measured] has been selected as the Mode setting.

@ Reset

Each adjustment item of the color matching mode is reset here.

Picture Mode: Set each adjustment item to the factory default color value of the currently selected picture mode.
Native: Set each adjustment item to the uncorrected value.

Rec.709: Set each adjustment item to the Rec.709 equivalent value.

This function can be used only for projectors that have this function.

@ Execute

Click this to reflect the reset settings in the projector and update the values of the color matching mode.

This function can be used only for projectors that have this function.
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Two kinds of masking are available.

To use this function, the upgrade kit (ET-UK20) must be applied on the selected projector.
&= “Activation” (page 12)

Some models do not support this function.

H Line Masking

The shape to be masked is set by moving the operation points on the four sides—top, bottom, left and right—of the projected
image.
The area to be masked can also be inverted between positive and negative.

m Bitmap Masking

The bitmap in the 1-bit monochrome format is loaded and set as the masking data.

The position and size of the masking can be changed.

Bitmaps from 8 x 8 pixels to 1920 x 1200 pixels (when the resolution of the projector is 1920 x 1200 dots or 1400 x 1050
dots) or 4096 x 2400 pixels (when the resolution is other than the aforementioned) are supported.

The *.bmp and *.dib file extensions are supported.

The shape to be masked is set by adding/moving the operation points on the four sides—top, bottom, left, and right—of the
projected image.

The area to be masked can also be inverted between positive and negative.

® The Line Masking and Bitmap Masking settings can be used simultaneously. In that case, masking applies to the each area
set in the settings.
® When the input signal of the projector is changed, retransmission to the projector may be required.
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Masking screen
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(1) sub Window
Each time this is clicked, the Sub Window screen is switched between displayed and cleared.
An image of the entire projection area is displayed on Sub Window.
® Sub Window display can also be switched between displayed and cleared for the sub window in the View sub window.

@ Zoom In

Zooms in to the editing area.

@ Zoom Out
Zooms out the editing area.

@ Red

Selects whether the operation points on the left side of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Red] on the View submenu.

®) Blue

Selects whether the operation points at the top of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Blue] on the View submenu.

@ Green

Selects whether the operation points on the right side of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Green] on the View submenu.
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@

Orange
Selects whether the operation points at the bottom of the projected image are to be displayed or not displayed.
® This performs the same operation as [Mask Marker] — [Orange] on the View submenu.

Editing Area

Click the operation points to select them, and then drag them to form the shape that is to be masked.

The outmost red frame has an L-shaped mark to indicate the image orientation. This mark is shown at the upper left when
the Image Direction setting is OFF, and the location where it is shown also moves depending on the Image Direction
setting.

Right-clicking
Clicking the right-mouse button in the editing area displays a menu with following items.
Reset, Flip Vertical, Flip Horizontal, Bitmap Masking Custom

Reset, Flip Vertical, Flip Horizontal
The menu functions are the same as with the Edit submenu.
&= “Edit submenu” (page 93)

Bitmap Masking Custom
Add/delete operation points on the sides with masking enabled in Custom of Bitmap Masking.

Mode Switching
OFF: Masking is not performed.
PC-1/PC-2/PC-3: Masking is enabled.

When masking is enabled, only one piece of data (PC) can be saved for some models.

Edit, View
In addition to the menu items described in “Main menu” (page 38), the following menu items can be used on the
Masking screen.

Edit submenu
Reset
When Line Masking has been performed, the positions of the operation points are returned to their initial
statuses.
Returns to the status established when the bitmap has been loaded when Bitmap Masking is executed.

Flip Vertical
Click to flip vertically the correction status of the entire image.

Flip Horizontal
Click to flip horizontally the correction status of the entire image.

View submenu
Mask Marker (Red, Green, Blue, Orange)
Selects whether the operation points are to be displayed or not displayed.

The non-displayed operation points are fixed at the positions when the selection was made not to display them.
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Line Masking

PC-1 e
Line Masking Bitmap Masking
Enable Enable Custom
Left Upper Right Lower O Left O Upper O Right [ Lower
T O tnvert O Invert

® ® @ ® @

@) Left

When a check mark is entered for [V Left | masking based on the operation point on the left side of the projected image is
enabled.

@ Upper

When a check mark is entered for [¥! Upper | masking based on the operation point at the top of the projected image is
enabled.

@ Right

When a check mark is entered for ¥/Right | masking based on the operation point on the right side of the projected image
is enabled.

@ Lower

When a check mark is entered for [¥/Lower = masking based on the operation point at the bottom of the projected image is
enabled.

@ Invert

When a check mark is entered for [_|invert | the Line Masking area can be inverted between positive and negative.

Upper operation point (Blue)

Right operation point (Green)
Left operation point (Red)

Lower operation point (Orange)

The operation points positioned at both ends of each side can be moved only around the outer circumference (along the
four sides—top, bottom, left, and right) of the projected image.

When an operation point at the center of a side is moved, it can be moved without changing the angle of the straight line
that connects the operation points at both ends of the side.

When the operation points have been selected, they can also be moved by operating the cursor keys on the keyboard.
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Bitmap Masking

PC-1 v
Line Masking Bitmap Masking
Enable Enable Custom
[ Left O upper [ Right [ Lower Led Upper Right
O Invert Invert [ Invert
@ @ ©)

) File
Click this button to open the screen on which to select the bitmap data used for masking.
Using the bitmap data which has been loaded, mouse operations can be used to move, enlarge or reduce the masking
area.
The bitmap data can be moved, enlarged, or reduced in a display area with a resolution of 2880 x 1800 pixels (when the
resolution of the projector is 1920 x 1200 dots or 1400 x 1050 dots) or 6144 x 3600 pixels (when the resolution is other
than the aforementioned).

If [File] is clicked when the bitmap data for masking has already been loaded, the previously loaded bitmap data is
discarded and the new loaded bitmap data is set for masking.

@ Invert

When a check mark is entered for [_linvert | the Bitmap Masking area can be inverted between positive and negative.

Bitmap data (example)
Drag to move.

. When the center point here is dragged, the masking area
can be enlarged or reduced horizontally or vertically.

When a point in one of the four corners is dragged, the
masking area can be enlarged or reduced without changing
the aspect ratio.
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@ Custom

The shape to be masked is set by adding/moving the operation points on the four sides—top, bottom, left, and right—of the
projected image.
Left:
When a check mark is entered for [¥|Left , masking based on the operation point on the left side of the projected
image is enabled.

Upper:
When a check mark is entered for V| Upper , masking based on the operation point at the top of the projected image
is enabled.

Right:
When a check mark is entered for [¥|Right , masking based on the operation point on the right side of the projected
image is enabled.

Lower:
When a check mark is entered for [¥] Lower , masking based on the operation point at the bottom of the projected
image is enabled.

Invert:
When a check mark is entered for [_]invert , the Bitmap Masking Custom area can be inverted between positive and
negative.

Upper operation point
(Yellow green)

Right operation point
Left operation point (Magenta)

(Cyan)

Lower operation point
(Yellow)

The operation points positioned at both ends of each side can be moved only around the outer circumference (along the
four sides—top, bottom, left, and right) of the projected image.

If you right-click on a side and then select [Add Point], you can add an operation point (a maximum of 15 operation points
can be added per side).

To delete an added operation point, right-click it and select [Delete Point].
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Input Signal Adjustments

Projectors normally identify the input signals automatically, but if unstable signals are to be input, this software application
allows the format matching the input signals to be selected, position adjustments to be made, and so on by manual means.

This may be disabled depending on the model.

Input Signal screen

0z PROJECTORZ (0.0.0.2)

01 PROJECTOR1 (0.0.0.1)

Lens Setting | Geumelry| Edge Blendi

E) Geometry Manager Pro - O X

File Edit View Tools Version

= =l = | m = O FEFFEEEEE @) AUTO ADIUST
T+ ¥

| Umfurmrty‘ Bnghlnesstunlml‘ CD\urMaIchmg‘ Masking‘ Input Signal  Other

Input Select

Zoom

Zoom Mode

©

Internal

QeO®

® OO

03 PROJECTORS (0.0.0.3) REB2 DVI-D
04  PROJECTOR4 (0.0.0.4)
05 PROJECTORS (0.0.0.5) son soiz Digital Link Vertical I 50
06 PROJECTORE (0.0.0.6)

) Horizontal 50
07  PROJECTORY (0.0.0.7)
05  PROJECTORS (0.0.0.8) =

shift
sdd [ pel ][ Rename Vertical
— — et System Selscior RGB / 640x480/60
Display Projector Name Horizontal
Asgpect Default / Auto / VID Auto
‘ Power ON | | Standby ‘ [ e — I P I
l —

Shutter Close

Shutter Open

030 ON 03D OFF
Status ON Status OFF
Status Page | Prev | | Next

Command Control

Test Pattern
OFF

Image Direction

Landscape

Grid Resolution

[ use square Grid
Display Grid Lines
OFF

Cursor Information

Display Cursor

Coordinate Information
None

Absolute
Relative

Transfer

" v XM ~

Manual Transfer

Auto Transfer

NS N
N
2©

x1/4 NUM

@ Input Select

These are used to select the input.

Click the input (selector) button of the signals to be projected.
The inputs that can be selected vary depending on the model. For a model equipped with slots, the buttons are enabled

only for the slots with boards inserted, and the inputs that can be selected are displayed on the buttons.

Input Select
sSDE2 SDI3
HOMH [Slot1] HDMI2 [Slot1] [Slot1]
[Siot2] [Slot2] 5013 [Slot2]
Digital Link

SDi4

[Siot1]

SDI4 [Slot2]

This operation is reflected in the projector even if a check mark has not been entered for ("] Auto Transfer.
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For a model equipped with slots, if a change such as adding or deleting a board is made while connected to the
corresponding projector from this software, the board state cannot be reflected correctly.

In this case, the state will be reflected correctly if you perform one of the following operations.

- Execute [Reload] from the menu.

- Change to another tab and then select this tab again.

- Select another projector and then select this projector again.

- Restart this software and then connect with the corresponding projector.
- Delete the corresponding projector from this software and then add it again.

System Selector
The system format which matches the input signals is selected here.

The formats which can be selected differ depending on the projector model, input signals and input connectors.

Input Select

System Selector

RGB1, Y/C or
RGB1, Y/C, Video

When [RGB/YPbPr] is selected*!

When [Y/C] or [Video] is selected*"

RGB / VGAB0
YCbCr / YPbPr / 480p YCbCr
480p RGB

RGB / 640x480/60p

YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60

RGB1, RGB2 or
Computer

RGB / VGAB0

YCbCr / YPbPr / 480p YCbCr
480p RGB

RGB / 640x480/60p

YCbCr / YPbPr / 480/60p YCbCr
480/60p RGB

Video

Auto
NTSC
NTSC4.43
PAL
PAL-M
PAL-N
SECAM
PAL60

DVI-D

RGB
YCbCr/ YPbPr

HDMI

Auto
RGB
YCbCr / YPbPr

Digital Link

Auto
RGB
YCbCr/ YPbPr
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1080/50i YPbPr
1080/60i YPbPr
1080/50p YPbPr
1080/60p YPbPr
1080/24p RGB
1080/24sF RGB
1080/25p RGB
1080/30p RGB
1080/50i RGB
1080/60i RGB

1080/60i RGB
1080/50p RGB
1080/60p RGB
1080/50p YPbPr
1080/60p YPbPr
2K/48p RGB
2K/50p RGB
2K/60p RGB
2K/48p YPbPr
2K/50p YPbPr
2K/60p YPbPr

Input Select System Selector
SDI1 or SDI When [Single Link] is selected*? When [Dual Link] is selected*? When [Auto] is selected*?
Auto Auto Auto
480i YCbCr 1080/24p RGB
480/60i YCbCr 2K/24p RGB
576i YCbCr 2K/24p XYZ
576/50i YCbCr 1080/24sF RGB
720/50p YPbPr 2K/24sF RGB
720/60p YPbPr 2K/24sF XYZ
1035/60i YPbPr 1080/25p RGB
1080/24p YPbPr 1080/30p RGB
1080/24sF YPbPr 1080/50i RGB
1080/25p YPbPr 1080/60i RGB
1080/30p YPbPr 1080/50p RGB
1080/50i YPbPr 1080/60p RGB
1080/60i YPbPr 1080/50p YPbPr
1080/50p YPbPr 1080/60p YPbPr
1080/60p YPbPr 2K/48p RGB
1080/24p RGB 2K/50p RGB
1080/24sF RGB 2K/60p RGB
1080/25p RGB 2K/48p YPbPr
1080/30p RGB 2K/50p YPbPr
1080/50i RGB 2K/60p YPbPr
1080/60i RGB
2K/24p RGB
2K/25p RGB
2K/30p RGB
2K/48p RGB
2K/50p RGB
2K/60p RGB
SDI2 When [Single Link] is selected*? When [Dual Link] is selected*? When [Auto] is selected*?
Auto Auto Auto
480i YCbCr 1080/24p RGB
576i YCbCr 2K/24p RGB
720/50p YPbPr 2K/24p XYZ
720/60p YPbPr 1080/24sF RGB
1035/60i YPbPr 2K/24sF RGB
1080/24p YPbPr 2K/24sF XYZ
1080/24sF YPbPr 1080/25p RGB
1080/25p YPbPr 1080/30p RGB
1080/30p YPbPr 1080/50i RGB

*1In the Other screen, select with [Display Option] - [RGB In] - [RGB1 Input Setting].
*2 |n the Other screen, select with [Display Option] - [SDI In] - [SDI Link].
&= “Display Option” (page 106)

® For models that do not support dual link HD-SDI signals, the system format that can be selected when [SDI1], [SDI],
or [SDI2] is selected with [Input Select] is the same as for [Single Link].
® Even if an [Input Select] button shown in the table above is selected, the function may be disabled depending on the
projector you are using.

99




Adjustment and Settings Input Signal Adjustments

€)

Aspect
The aspect ratio of the images is selected here. The aspect ratios that can be selected are listed below:

Default / Auto / VID Auto
Through

16:9

4:3

HFIT

V FIT

HV FIT

For details, refer to the operating instructions of the projectors.

Clock Phase

Image flickering and contour blurring are adjusted here.

Input value range: 0 to 31

However, they cannot be adjusted when Y/C signals have been selected as the input signals.
For details, refer to the operating instructions of the projectors.

Zoom Mode

The zoom mode is selected here.

The setting is enabled when [Default / Auto / VID Auto] has been selected as the Aspect setting.
The modes that can be selected are listed below:

® Internal
® Full

For details, refer to the operating instructions of the projectors.

Vertical (Zoom)
The zoom magnification in the vertical direction is set here.
Input value range: 50 to 999

Horizontal (Zoom)
The zoom magnification in the horizontal direction is set here.
Input value range: 50 to 999

Interlocked

When a check mark is entered for |V Interlocked , the same zoom magnification can be set in both the horizontal and
vertical directions.

Vertical (Shift)
The vertical position of the projected image is set here.
The input value range varies depending on the projector model.

Horizontal (Shift)
The horizontal position of the projected image is set here.
The input value range varies depending on the projector model.

The Input Signal screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.

100



Adjustment and Settings Projector Menu Settings

Projector Menu Settings

Some of the operations using the projector's menus can be performed using this software application.
This may be disabled depending on the model.

Other screen

®2 @ @ 6 ®

@ Geometry Manager Pro - u] X
File Edit View Tools Version
[ =] G| || g"|l=:l ] @ AuTo ADIUST
B Lens[Betting | enmetry| Edpe Blending | Uni urmrty‘ i Cnntrnl| Coldr Matching ‘ Masking ‘ Input Signa\‘ Other
01 PROJECTOR{ (0.0.0.1) "
02  PROJECTOR2 (0.0.0.2}
Picture I Position |ll Advanced Menu (§ Display Option § Projector Setup | Multi Displa
03 PROJECTORS (0.0.0.3) I l l Il = I : DI = y‘l
04  PROJECTORS (0.0.0.4) Picture Mode Color Temperature Gamma
05  PROJECTORS (0.0.0.5) Standard ~ Defautt ~ Defautt ~
06  PROJECTORS (0.0.0.6) o Ic
07 PROJECTORT (0.0.0.7) = White Balance Red High 255 = HDR HLG System Gamma o
Contrast 0 =
08  PROJECTORS (0.0.0.8) . 5
White Balance Green High ~ 255
Brightnass o = System Daylight View OFF ~
White Balance Blue High 255 = y
Add | ‘ Del | ‘ Rename Color 0 = Dynamic Contrast
Display Projector Name o = White Balance Red Low o = OFF ~
Tint =
= White Balance Green Low 0 =
Power ON Standby Sharpness o -
it 0 S Auto Contrast OFF
e G ) White Balance Blue Low =
Shutter Close Shutter Open
Waveform Monitor
0SDON 0SD OFF B -
OFF ~ Bright Signal Level & =
Status ON Status OFF . =
Line Posttion 5 Lights Out T
Status Page | _Prev | [ Next e TEiiE
— | Lights Out Signal Level 0 =
Test Pattern Lights Out Fade-In OFF
OFF ~ Lights Qut Fade-Qut OFF
image Direction Manual Intensity 0
Landscape ~ Dynamic Gamma OFF
Grid Resolution
Color Space ~
1 v ox (1 ~ p: Native
[ use Square Grid
Display Grid Lines
OFF ~
Cursor Information
Display Cursor
Coordinate Information
Hone:
Absolute
Relative
Transfer
Manual Transfer
v
Auto Transfer = =
x1/8 NUM

@ Picture

Click to display the Picture screen.
The video mode, black level and other settings related to the image adjustments can be selected.

@

Position
Click to display the Position screen.
The convergence settings can be selected.

This function can be used only for projectors that have this function.

@ Advanced Menu
Click to display the Advanced Menu screen.
The blanking width, input resolution and other settings can be selected.

@

Display Option
Click to display the Display Option screen.
The color correction, aspect ratio and other settings related to the image display used for large screens can be selected.
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®

®

Projector Setup
Click to display the Projector Setup screen.
The projector’s projection system, lamp selection and other hardware settings can be established.

Displayed when the projector you are using has the corresponding function.

PinP

Click to display the P in P screen.

The positions and sequence of priority for the main screen and sub screens as well as other P in P functions can be set.

Multi Display
The inputs for 4-split display, frame lock, and other settings for the multi screen function can be set.
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H Picture

Picture  Advanced Menu | Display Option PrmecmrSetup| PinpP

Picture Mode Color Temperature

Standard ~ Rename Default

Gamma

w Rename Default ~

= White Balance Red High 255
Contrast o = System Daylight View
. |:0 = White Balance Green High 255 Dynamic Contrast
= White Balance Blue High OFF v
Color ] =
= White Balance Red Low 0 Auto Contrast
Tint o =
= Wihite Balance Green Low 0 Bright Signal Level
Sharpness. 0 z
5 Lights Out Timer
oFF White Balance Blue Low o =

Noise Reduction
Waveform Monitor

OFF -

Line Position

The following items can be set:

Lights Out Signal Level
Manual Intensity

Dynamic Gamma

Color Space

Rename

OFF -

Picture Mode **

Contrast

Brightness

Color

Tint

Sharpness

Noise Reduction

Waveform Monitor
Line Position

Default Picture Mode

Color Temperature
White Balance Red High
White Balance Green High
White Balance Blue High
White Balance Red Low
White Balance Green Low
White Balance Blue Low

Gamma

System Daylight View

Dynamic Iris
Auto Iris
Manual Iris
Dynamic Gamma

Dynamic Contrast
Contrast Mode
Auto Contrast
Brilliant Correction
Bright Signal Level
Lights Out Timer
Lights Out Signal Level
Lights Out Fade-In
Lights Out Fade-Out
Manual Intensity
Dynamic Gamma

Dynamic Contrast NX
Auto Contrast
Bright Signal Level
Lights Out Timer
Lights Out Signal Level
Lights Out Fade-In
Lights Out Fade-Out
Manual Intensity
Dynamic Gamma

Al

White Gain

Color Space

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.

® tems marked ** are reflected in the projector even when a check mark has not been entered in || Auto Transfer.
® The Picture screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon

menu.

103



Adjustment and Settings

Projector Menu Settings

H Position

Picture || Position ~ Advanced Menu | Display Option | Projector Setup | Mutti Display

Convergence

OoN

Red
Upper Left Upper Right
Wertical 000 Reset Vertical 000 - Reset
Horizontal ooo 2 Reset Horizontal I 000t Reset
Lower Left Lower Right
Vertical I 000 - Reset Vertical I 000 ° Reset
Horizontal oo0 Reset Horizontal I 000 2 Reset
Green
Upper Left Upper Right
Wertical oo * Reset Vertical 000 % Reset
Horizontal 000 2| [ Reset Horizontal I 000 2| [ Reset
Lower Left Lower Right
Vertical I 000 | *| | Reset Vertical I 000 *| | Resat
Horizontal 000 - Reset Horizontal I 000 * Reset
Blue
Upper Left Upper Right
Vertical oo 2 Reset Vertical 0oe Reset
Horizontal 0o * Reset Horizontal I 000 * Reset
Lower Left Lower Right
Vertical I 000 2| [ Reset Vertical I 000 2| | Reset
Horizontal oo0 Reset Horizontal I 000 - Reset
The following items can be set:
Convergence Green Blue
Red Upper Left Upper Left
Upper Left Vertical Vertical
Vertical Horizontal Horizontal
Horizontal Upper Right Upper Right
Upper Right Vertical Vertical
Vertical Horizontal Horizontal
Horizontal Lower Left Lower Left
Lower Left Vertical Vertical
Vertical Horizontal Horizontal
Horizontal Lower Right Lower Right
Lower Right Vertical Vertical
Vertical Horizontal Horizontal
Horizontal

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.

® The Position screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon

menu.
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B Advanced Menu

The following items can be set:

Picture | [ Advanced Menu  Display Option | Proj up| PinP

Digital Cinema Reality Auto

Blanking
Upper

Input Resalution

Total Dots @ =
Display Dots. @ =
Total Lines IE :
Display Lines IE =

jector Set

Clamp Position 24 =

Frame Response Normal ~

Frame Creation

Frame Creation Mode | OFF i

Film Detection OFF ~

Raster Position

Vertical

Horizontal

[P =
[P E

Digital Cinema Reality
Gradation Smoother
Blanking
Upper
Left
Right
Lower
Input Resolution
Total Dots
Display Dots
Total Lines
Display Lines

Clamp Position
Frame Response
Frame Delay
Frame Creation
Frame Creation Mode
Film Detection
Frame Lock
Raster Position
Vertical
Horizontal
Quad Pixel Drive
Smooth Pixel Drive

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

The Advanced Menu screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and

icon menu.
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m Display Option

Picture | Advanced Menu | Display Option  Projector Setup | PinP

Large Screen Correction
Screen Setting

Screen Format
Vertical Position
Horizontal Position

[] Auto Signal
Auto Setup

Mode

Display Dots

Position Adjust
[ signal Level Adjust

Background Color

Startup Logo
Cut OFf

[red [Jereen

Image Rotation

OFF

16:10

L =

0 -

Default

1024 :
Execute

Blue

Default Logo

[1Biue

Shutter Setting
[ Mechanical Shutter

Fade-n
Fade-Out
Startup

Shut-Off

On-Screen Display
05D Position

0SD Rotation

0S50 Design

Warning Message

Backup Input Setting
Backup Input Mode

Automatic Switching
Simul Input Setting
RGB1/RGB2
HOMVDVID

S01/sDR2

OFF
OFF
Open

Open

OFF

106

SDlin

SDI Link

Target Input

Resolution

3G-5D1 Mapping

System Selector

Bit Depth

Signal Level

Digital Link In

Signal Level

EDID Mode

EDID Resolution/\VV Scan Freq

RGE In
RGB1 Input Setting
RGB1 Sync Slice Level

RGB2 Sync Slice Level

RGB2 EDID Mode
RGB2 EDID Res=olution

RGB2 EDID V Scan Freq

DVED In

DVI Signal Level
DV EDID Select
DV EDID Mode

DVI EDID Resolution

DVIEDID V Scan Freq.

HOMI In

HDMI Signal Level

HDMIEDID Mode
HDMWI EDID Resolution

HDMI EDID V Scan Freq

Single ~
Single:SDM V
Aute ~
Auto ~
Auto ~
Aute ~
84-840 ~
Aute ~
Default ~
1820x1200p/60

RGBIYPbPr ~
High v
High v
Default ~
1920x1200p

B0Hz

0-255:PC ~
EDID3 ~
Default ~
1920x1200p

B80Hz

0-1023 ~
Default ~
1920x1200p

B0Hz
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The settings of the items listed below can be established and operated.

Large Screen Correction
Screen Setting
Screen Format
Vertical Position *
Horizontal Position *
Screen Marker
Upper
Lower
Left
Right
Horizontal
Vertical
Auto Signal
Auto Setup
Mode
Display Dots *
Position Adjust
Signal Level Adjust
Execute
Background Color
Startup Logo
Cut Off
Red
Green
Blue
Image Rotation
Closed Caption Setting
Shutter Setting
Mechanical Shutter
Fade-In
Fade-Out
Startup
Shut-Off
On-Screen Display
OSD Position
OSD Size
OSD Rotation
OSD Design
OSD Memory
Input Guide
Warning Message
Color Correction
Red
Green
Blue
Cyan
Magenta
Yellow

Backup Input Setting
Backup Input Mode
Automatic Switching
Simul Input Setting
RGB1/RGB2
HDMI/DVI-D
SDI1/SDI2
SDI In
Slot In
SDI In
SDI Link
SDI1 Signal Level
SDI1 Bit Depth
SDI1 3G-SDI Mapping
SDI2 Signal Level
SDI2 Bit Depth
SDI2 3G-SDI Mapping
Dual Link Signal Level
Dual Link Bit Depth
Dual Link 3G-SDI Mapping
Target Input
(The selection options of the
following adjustment items
vary depending on the selected
setting.)
Resolution
4K Division
3G-SDI Mapping
System Selector
Color Space
Sampling
Bit Depth
Signal Level
Digital Link In
Digital Link Signal Level
Digital Link EDID Select
Digital Link EDID Mode
Digital Link EDID Resolution
Digital Link EDID V Scan Freq.
Signal Level
Auto Gamma Select
Auto Color Space Select
EDID Select
EDID Mode
EDID Resolution/V Scan Freq.

RGB In

RGB Sync Slice Level

RGB EDID Resolution

RGB EDID V Scan Freq.

RGB1 Input Setting

RGB1 Sync Slice Level

RGB2 Sync Slice Level

RGB2 EDID Select

RGB2 EDID Mode

RGB2 EDID Resolution

RGB2 EDID V Scan Freq.
Computer In

Computer Sync Slice Level

Computer EDID Mode

Computer EDID Resolution

Computer EDID V Scan Freq.
DVI-D In

DVI EDID

DVI Signal Level

DVI EDID Select

DVI EDID Mode

DVI EDID Resolution

DVI EDID V Scan Freq.
HDMI In

HDMI Signal Level

HDMI EDID Select

HDMI EDID Mode

HDMI EDID Resolution

HDMI EDID V Scan Freq.
Slot In

Mode Select **

Link Select **

Link Setting ***

EDID Setting ***

Option Setting ***

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.
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® Items marked with an asterisk (*) cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and

icon menu.

® Items marked ** are switched automatically depending on whether a board is inserted in the slot and the type of board if a

board is inserted.

® |tems marked *** are switched automatically depending on setting of Link Select.

Hm Projector Setup

Picture | Advanced Menu | Display Option || Projector Setup PinP

Projection Method Front / Floor ~

Cooling Condition Floor Setting ~

Lamp Select

Dual ~ Apply

Lamp failed

Lamp Relay

OFF ~

Lamp Power Eco v

Standby Mode Normal ~

No Signal Shut-Off Disable ~
Initial Startup Last Memory i

Startup Input Select Last Used v

Date and Time

Time Zone +09:00 ~

Synchronize to PC

The settings of the items listed below can be established and operated.

Projection Method
Cooling Condition
High Altitude Mode
Lamp Select *
Lamp Relay
Time
Standby Mode
Quick Startup
Valid Period
No Signal Shut-Off
No Signal Lights-Off
Initial Startup
Startup Input Select
AC Voltage Monitor
Date and Time
Time Zone *
Synchronize to PC **
(The projector’s clock setting is synchronized with the
computer.)

Multi Projector Sync
Mode
Contrast Sync
Shutter Sync
Terminal Select

No Signal Setting
Secondary Input
Back Color
No Signal Shut-Off
No Signal Lights-Off

Power Management
No Signal Shut-Off
No Signal Lights-Off

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the

operating instructions of the projector.

® [tems marked with an asterisk (*) cannot be reset using the [New All Data] and [New Data (For Current Window)] commands

on the File submenu and icon menu.

® Items marked ** are reflected in the projector even when a check mark has not been entered in [| Auto Transfer.
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mPinP
Picture | Advanced Menu | Dieplay Option Prme[‘.’lnrse(up| PinP
Pin P Mode User1 ~
Frame Lock Main Window ~
Type Sub Window ~
Main Window Sub Window
nput Signal RGBT | input Signal A
Size Size
Interlocked Interiocked
Vertical II e Vertical IE e
Horizontal 100 = Horizontal 33 =
Position Position
Vertical 0 ] Vertical 0 s
Horizontal 0 = Horizontal 0 =
Clock Phase E =
The following items can be set:
P in P Mode ** Sub Window
Frame Lock Input Signal
Type Size
Main Window Interlocked
Input Signal Vertical
Size Horizontal
Interlocked Position
Vertical Vertical
Horizontal Horizontal
Position Clock Phase
Vertical
Horizontal

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

® Items marked ** are reflected in the projector even when a check mark has not been entered in || Auto Transfer.
® The P in P screen items cannot be reset using the [Reset Data (Current Tab)] command on the File submenu and icon

menu.
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m Multi Display

Picture | Advanced Menu | Display Option | Projector Selup‘ Multi Display

Multi Display Mode Usert ~

Frame Lock Upper Left Window ~
Upper Left Window sDit ~|  Upper Right Window soiz -
Lower Left Window sDB ~|  Lower Right Window SO -

The following items can be set:

Multi Display Mode **
Frame Lock

Upper Left Window
Lower Left Window
Upper Right Window
Lower Right Window

The items that can be adjusted, setting details, and setting ranges vary depending on the projector model. Refer to the
operating instructions of the projector.

® Items marked ** are reflected in the projector even when a check mark has not been entered in [ | Auto Transfer.
® The Multi Display screen items cannot be reset with the [Reset Data (Current Tab)] command on the File submenu and icon
menu.
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Projector Control

Control commands can be sent to the projector.

Command Control screen

@ Command Control

01 NAME&534 (192.168.0.8) PT-RZ6604
02 NAME4311 (192 . 10) PT-RZ66(
03 PROJECTOR3 (192.168.0.11) PT-RQ)
04 PROJECTOR4 (192.168.0.12) PT-RQ)

x
Send Command
B [I send |
Function l Edit I-—@

Shutter CLOSE

Function &

Function 11

Import

Shutter OPEN Frame Creation MAX Function 12
Function 3 Frame Creation OFF Function 13 -—@
Dynamic Contrast USER. Function & Function 14
Dynamic Contrast OFF Function 10 Function 15
—®
SDR. to HDR. Script 3 Script 5
L @
HDR to SDR Script 4 Script 6
Command Log — @
S
Time (Local) Destination Send Receive
2022-11-18 13:33:33.493 NAME4311 05H:1 0O5H:1
2022-11-18 13:33:34.514 NAME4311 Q5H:0 Q5H:0
2022-11-18 13:33:36.994 NAME4311 OAL:4 QAL:4
2022-11-18 13:51:25.083 PROJECTOR3 VXXFRCI1=+00003 WVXX:FRCI1=+00003
2022-11-18 13:51:25.083 PROJECTOR4 VIM:FRCI1=400003 WXX:FRCI1=+00003
2022-11-18 14:00:04.744 NAMES534 WX :GMMIO=-+00000 WX GMMID =-+00000

Export

@ Projector list

Displays a list of the numbers, projector names, IP addresses, and model numbers of the connected projectors.
The selected projector is the target for sending the command. The control command send target can be switched by

selecting a projector in the list.

® Multiple projectors can be selected by holding down the Ctrl key while clicking.

Command input

Enter the control command to send.

©

Send command

Send the entered control command to the selected projector.

Edit registered commands

Up to 15 frequently used commands can be registered. Clicking opens the Edit screen.
Only a button with a command registered can be clicked.

The text to display on the button can also be edited in the Edit screen. If the text to display on the button is not edited, the

default text ("Function*" where * is the number of the button) is displayed.

Send registered commands

Sends the registered commands to the selected projector.
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®

® Q

® ©

® O

Edit registered scripts

Up to 6 scripts of multiple consecutive commands (script) can be registered. Clicking opens the Edit screen for registered
scripts.

Only a button with a script registered can be clicked.

The text to display on the button can be edited in the Edit screen for registered scripts. If the text to display on the button
is not edited, the default text ("Script*":* where * is the number of the button) is displayed.

Send registered scripts
Sends the registered scripts to the selected projector.

Command Log

Displays the communication log for sent commands. This displays four information items: send time, send destination
projector name, sent command, and response to sent command.

Each information item can be sorted in ascending and descending order.

The maximum number of logs that can be displayed is 2,048.

Clear command log
Clear the information displayed in the command log.

Import
Reads control command data from a file.

Export
Saves control command data to a file.

Close
Close this screen. The command log is also cleared when the screen is closed.
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Projector Control

Edit screen

@ Title

@

& edit

Function 1
Function 2
Function 3
Function 4
Function 5
Function &
Function 7
Function 8
Function 9
Function 10
Function 11
Function 12
Function 13
Function 14

Function 15

Tife

Comnfand

|Frame Creation OFF

VA FRCI 1= 400000

|Frame Creation MAX

VXX:FRCI1=+00003

| Dynamic Contrast OFF

| Dynamic Contrast USER

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Clear

Enter the text to display on the registered command send buttons in the Command Control screen.

The text can consist of a maximum of 32 characters including letters, numbers, and symbols.

Command

Clear

Confirm

@ ®&® © ©

Cancel

Enter the control commands to register.

Confirm the current editing information.

Clear both the registered command name and registered command.

Discard the current editing information. A screen appears to confirm whether or not discarding the information is a

problem.
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Edit screen for registered scripts

@

@

®

Edit %
Saript 1 l Clear l Script 4 Clear
Title ?DF! 1o HDR l Title
—
Commands | VXX:LOPI2=+01000 Commands
VGA:US1
WXX:CSPI1=+00003
Script 2 Clear Script 5 Clear
Title HDR to SDR Title
Commands :’é’;ﬂﬂplz:*‘ﬂﬂmﬂ Commands
WXX:CSPI1=+00001
Script 3 Clear Script6 Clear
Title Title
Commands Commands
Confim

@ ©

Title
Enter the text to display on the registered script send buttons in the Command Control screen.
The text can consist of a maximum of 32 characters including letters, numbers, and symbols.

Commands

Enter the script to register.

Up to 10 lines (10 commands) can be entered. A blank line is also counted as a line.

The next command is sent as soon as the response for the previous command is received, but if you need to specify an
interval to wait until sending the command, enter it as “wait(****)” (where **** is an integer from 0001 to 9999, and the unit
is milliseconds). This is also counted as a line.

There is an offset of 10 to 15 seconds for an interval specified with “wait”.

Clear
Clear both the registered script name and registered script.

Confirm
Confirm the current editing information.

Cancel
Discard the current editing information. A screen appears to confirm whether or not discarding the information is a
problem.
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Auto Screen Adjustment

Applying the ET-CUK10 Auto Screen Adjustment upgrade kit to the projector or applying the ET-CUK10P Auto Screen
Adjustment upgrade kit (PC) to the computer expands the functions of Geometry Manager Pro, and allows automatic
adjustment of geometry correction, edge blending, color and brightness correction, adjustment of white balance, and
adjustment of black level according to the shape of the screen through use of an externally connected camera.

After performing Auto Screen Adjustment, you can perform further detailed adjustment and correction manually.

® The Auto Screen Adjustment upgrade kit is required to enable the Auto Screen Adjustment function.
The Auto Screen Adjustment function will be enabled for some projectors without applying the ET-CUK10 Auto Screen
Adjustment upgrade kit to the projector.

Product Number Product Name Description
ET-CUK10 Auto Screen Adjustment | Activating on each projector enables the “Auto Screen Adjustment plug-in software”
Upgrade Kit functions.
ET-CUK10P Auto Screen Adjustment | Activating on a computer on which the software is installed enables the “Auto Screen
Upgrade Kit (PC) Adjustment plug-in software” functions.

& “Activation” (page 12)

® You can check whether the “Auto Screen Adjustment plug-in software” is installed and the activation status of the Auto
Screen Adjustment upgrade kit (PC) in [About Geometry...] of the Version submenu.

® To use the Auto Screen Adjustment function, prepare a camera separately.

® This may be disabled depending on the model.

Preparing Auto Screen Adjustment

m Projector connection

Use a LAN cable to connect the projector to the computer.

m Camera connection

Use a USB cable to connect the camera to the computer.

For details on compatible cameras, check the information found on the software download page after logging in to PASS on
the following website.

https://panasonic.net/cns/projector/pass/

m Connection example

Projectors

connection

115



Auto Screen Adjustment Compatible screens for Auto Screen Adjustment

® Positioning the camera so that it faces the screen directly and performing adjustments will obtain more optimal adjustment
results. Adjustment is possible when the camera is facing the screen at an angle, but adjustment may fail or distortion may
remain in images after adjustment if the angle is too large.

® In cases such as the following, adjustment is possible using multiple cameras (up to 6).
- Projector layout configuration has 5 or more projectors in the vertical or horizontal direction.
- When the entire screen does not fit in the capture range of 1 camera.

Compatible screens for Auto Screen Adjustment

Auto Screen Adjustment may not be performed properly depending on the shape of the screen. If adjustment is not performed
properly, perform adjustments manually.

Compatible screens Non-compatible screens

® Flat ® Folded

Folded screen type

® Curved screen
* Individual adjustments for each side are

Curved in one direction Curved in two directions

® Curve changes smoothly

[ ]

S-curve Variable curve type
® 360-degree curved screen
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Auto Screen Adjustment Operation flow for Auto Screen Adjustment

Operation flow for Auto Screen Adjustment

Settings for Auto Screen Adjustment are configured in a wizard format.

Adjustment items selection

-
Camera Select (Camera selection)

Camera search
v
Camera selection and connection

=
Projector Layout

v

Projector layout settings
Projector selection and positioning

.
Camera Setting

Camera layout
v
Camera settings
-
Projection Setting

[Coordinate Detection] [ Color Matching ] [ White Balance ] [ Black Level ]

e
Screen Setting

Cursor Position
Specification
v
Geometry
Edge Blending

-

Auto Screen Adjustment complete
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Auto Screen Adjustment procedure

Starting Auto Screen Adjustment and selecting the adjustment item

1 Click the [AUTO ADJUST] button in the main screen.

- O X

I [FEEEE] @ AuTo ADIUST

ﬂ CnlnrMatching| Masking| InputSignaI| 0ther|

® |f you click the [AUTO ADJUST] button while the combination of the versions of “Geometric & Setup Management
Software” and “Auto Screen Adjustment plug-in software” is inappropriate, an error message will appear. Obtain "Auto
Screen Adjustment plug-in software" displayed in the error message from the PASS website, install it, and then try again.

2 Click the items you want to adjust.

@ Auto Screen Adjustment X

Click the button you want to adjust.

=2 o

Geometry _Edaw Blendng Color Matching Re-adiust

Adjustment items selection screen

® You can select from following five options
- [Geometry, Edge Blending, Color Matching]
- [Geometry, Edge Blending]
- [Color Matching]
- [White Balance]
- [Black Level]
By clicking the [Re-adjust] button to the right of each option, adjustment can be made by using the setting that it had
previously.
& “Readjust by recalling previous settings” (page 119)
® The subsequent steps and screens that appear in the procedure will vary depending on the selected items.
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® Make sure the projector is turned on before starting Auto Screen Adjustment. Proper correction will not be possible if the
projector is in the standby state.

® \When performing automatic screen color, brightness, white balance, and black level correction, do so in an environment
where the impact from external lighting will be low.

@ While setting Auto Screen Adjustment, a progress indicator will appear at the top right of each screen, allowing you to
check which step you are currently performing.

Progress indicator

& Auto Screen Adjustment >

Camera Select Projector Layout Camera Setting Projection Setting Screen Setting

B Readjust by recalling previous settings

Click the [Re-adjust] button to automatically perform Auto Screen Adjustment using the settings that it had previously.

@) Auto Screen Adjustment X

Click the button you want to adjust.

HQ

75

Geomelry  Edeo Blendine Color Matching

F

i -

HQ

S

Geometry  Edes Blendine

&

Ed

Color Matching

I_c)

7

White Balance

£

F

Black Level

® |f an option does not have a previous setting, the [Re-adjust] button for that option is disabled.

@ If readjustment fails, Auto Screen Adjustment is canceled. In this case, you can continue making adjustments using the
usual manual procedure from the point at which adjustment was interrupted.

® To cancel Auto Screen Adjustment in progress, click [Abort]. In this case, you can continue making adjustments manually
from the point at which adjustment was interrupted.
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Camera Select (Camera selection)

@ Auto Screen Adjustment X
Camera Select Projector Layout Camera Setting Projection Setting Sereen Setting
Click Search Camera and select the camera to use.
Camera Search ) Model
Camera 1 D5300
Camera 2 D5300

Select Al Clear Al

If failed to search camera, please check the following.
-1Is the camera connected correctly?

-Is the camera power-on ?

Click Next to continue.

1 Verify camera connection in the camera connection screen.

1) Click [Camera Search] button.

® The Camera Search screen opens.

® When the search results are displayed, select the camera to use for adjustment from those results.

@ |f a camera is not displayed in the list, check the following.
- The camera is properly connected.
- The camera is turned on.

® \erify that the check boxes of the cameras to be used are selected.

® You can select all the cameras by clicking the [Select All] button, or clear selection of all the cameras by clicking
the [Clear All] button.

2) Click [Next].
® To return to the previous screen, click [Back].

120



Auto Screen Adjustment Auto Screen Adjustment procedure

Projector Layout

1 Specify the projector configuration in the projector layout setting screen.

@) Auto Screen Adjustment X

— [Restore]

——Layout information display area

| wan[s [

T }—————————[Height / Width / Stack]

Ciick Next to continue.

Projector layout setting screen

1)  When you click the [Restore] button and layout information from previously configured projectors exists, the layout
information is loaded and applied to the layout information display area.
2) Enter the height, width, and stack layout for the projectors in the [Height / Width / Stack] fields.
® Up to 99 projectors can be configured.
- In the case of 1 camera, adjustment can be performed for up to 4 vertically, up to 4 horizontally, and up to 6
stacked.
- 5 or more projectors can be configured either vertically or horizontally by using multiple cameras.
The relationship between the number of projectors and the number of cameras is as follows.

Number of projectors

1to4

3to7

41010

5t0 13

6to 16

71019

Number of cameras

1

2

3

4

5

6

cameras.
Number of projectors 5t09 5to 12 5to 15 6to 18
Number of cameras 3 4 5 6

- 360-degree curved screens require 5 or more projectors in the vertical or horizontal direction and 3 or more

@® You cannot configure a layout that includes more projectors than the total number of connected projectors.
@ If [Geometry, Edge Blending, Color Matching], [Color Matching], [White Balance], or [Black Level] was selected in the

adjustment items selection screen, configure the layout so that either height (vertical) or width (horizontal) is more than
one projector.

3) Click [Next].
@ To return to the previous screen, click [Back].
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Auto Screen Adjustment Auto Screen Adjustment procedure

2 Select the projectors for which to perform correction in the projector selection screen.

@) Auto Screen Adjustment. X

Camera Select Projector Layout Camera Sefting Projecion Seiting Screen Sefting

Select the projectors to use for auto adustment

Name TP Address Model ®
PROJECTORL 192.168.0.8 PTRZAC
PROJECTOR2 192.168.0.8 PTRZ2K
PROJECTORS 192.168.0.10  PTRZZK
PROJECTORS 192.168.0.11  PTRZZK
PROJECTORS 192.168.0.12  PTRZZK
PROJECTORS 192.168.0.13  PTRZZK

= PROJECTOR? 192.168.0.14  PTRZZK

= PROJECTORS 192.168.0.15  PTRZZK
PROJECTORS 192.168.0.15  PTRZZK
PROJECTOR10 192.168.0.17  PTRZZK
= PROJECTORIL 192168018 PTRIZK
PROJECTOR12 192,168,019 PTRZZK
PROJECTOR13 192.168.0.20  PTRIZK
PROJECTOR14 192.168.0.21  FTRIZK

Check boxes

MRRKOREOORRKRRE,

Number of —— sean | [(can g [Clear All]
selected

Click Next to continue.
projectors [Select All]

Projector selection screen

1) Select the check boxes of the projectors for which you want to perform correction in the connected projectors list.
® You can select all the projectors by clicking the [Select All] button, or clear selection of all the projectors by clicking
the [Clear All] button.

@ If you clicked the [Restore] button in step 1 to load previous layout information, the check boxes for the configured
projectors will be selected.

® If * is displayed on the left of a projector name, you cannot select that projector for auto screen adjustment.

Apply the Auto Screen Adjustment upgrade kit (ET-CUK10) to the projectors or apply the Auto Screen Adjustment
upgrade kit (PC) (ET-CUK10P) to the computer.
&= “Activation” (page 12)

2) Click [Next].
® To return to the previous screen, click [Back].
® When [Color Matching] and [White Balance] are selected, a warning message will appear if projectors of different
models coexist. Click [Next] to continue the process, or click [Cancel] to reselect projectors.
® An error message will appear in the following cases.
In such cases, click [OK] and select the projectors again.

- Projectors with different resolutions coexist when [Geometry, Edge Blending, Color Matching], [Geometry, Edge
Blending] or [Black Level] is selected.

- The number of selected projectors does not match the number of projectors configured in the projector layout
setting screen in step 1.

- When the Auto Screen Adjustment upgrade kit (ET-CUK10/ET-CUK10P) is not applied to either the selected
projectors or computer.

- When a DLP projector and LCD projector coexist.

When you click [Next], the geometry correction, edge blending, color/brightness correction, and white balance adjustment
of the projectors will be initialized.
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Auto Screen Adjustment Auto Screen Adjustment procedure

3 Confirm projector positioning in the projector positioning screen.

@) Auto Screen Adjustment. X

Camera Setting Projection Seting Screen Setting

n the layout chart below.

1 FROXCTORL
2 ProxcroR
3 PROXCTORS
S PROXCTORS

& FROXECTORS
7 ProxcTORS
8 PROXCTORI0
5 PROJECTORI2
0 FROECTORLS
1 FROECTORIS
2 RoXCTORIS

Layout window— Selected projectors

[Undo]
[Reset]
Heght: 2 Width: 3 Stacki 2 Undo Reset | [ 1denty & [Identify]

Ciick Next to contiue,

Projector positioning screen

1) Click the layout window to position the projectors.

2)

® Configure the projectors in order, starting with the first projector in the list of selected projectors. Each number will
be projected on the screen. Position the projectors in the layout window so that their numbers match the projected
numbers.

@ Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.

® You can cancel the positioning of the projector currently being configured by clicking the [Undo] button, or cancel
positioning for all projectors by clicking the [Reset] button.

Click [Next].

® To save the projector positioning information, click [Next].

® To return to the previous screen, click [Back].

® An error message will appear if positioning of all the projectors is not complete. Configure settings again.

@ If other than [Black Level] is selected, go to the camera connection screen.
& “Camera Setting” (page 125)

4 Select the storage location of the current geometry correction data in the geometry correction data storage
location confirmation screen.

@) Auto Screen Adjustment. X

tsetto porariy, Geometry The location is commen to
al projectors.
If you do not need to store it pleas

If Geometry is not stor

@pc1 Opc2 Orec-3 (O Noneed to store

Click Next to continue,
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1) The current geometry correction data needs to be stored inside the projector so select that storage location from [PC-
1] to [PC-3]. If the data is already stored, select [No need to store].
® The storage location is common for all projectors that are target for Auto Screen Adjustment.
@ |f the current geometry correction data is not stored, that data will be discarded during the process. The result of
black level adjustment will not be able to be guaranteed.
2) Click [Next].
® To return to the previous screen, click [Back].
® When [Nex{] is clicked, the current geometry correction data is saved to the storage location.
® |f [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected and the layout is configured
so that either height (vertical) or width (horizontal) is more than one projector in the projector layout screen, the
black level adjustment selection screen opens.

@) Auto Screen Adjustment X

Select the process for the black level of the area to be overlapped.

- [Set temporary value]: Overwrite the black level value with the temporary value of the corresponding models.
- [Use current settings]: Retain the current (pre-adjustment) black level value.

- [Adjust using the camera]: Adjust the black level using the camera.

® When there are 2 or more cameras, goes to "1 Camera layout screen."
® When there is one camera, goes to "2 Camera setting screen."
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Camera Setting

1 Decide the layout (arrangement) of the cameras while checking the captured images in the camera layout screen.

Perform this work when using 2 or more cameras.

@ Auto Screen Adjustment. X

[Restore]

v J———[Live View]

Camera layout
TT\-—[Test Shot]

) E Camera target ranges

Camera S
layout window
(orange frame)

Camera selection

——Captured image
display window

Height: 3 Width: 6 Camera 1 l R BT I—[VIeW |a|'ger image]

Click Next to continue,

Camera layout screen
1) Set the camera layout.
® [Horizontal / Vertical]: Camera placement direction (horizontal/vertical)
® [360 degree screen]: Select this check box when 360-degree screen
2) Select the cameras and set the target ranges.
® The target range of the selected camera is indicated by an orange frame in the camera layout window.
3) Capture a test shot with the camera.
® \When you click the [Test Shot] button, a test shot is captured with the selected camera and the captured image
appears in the captured image display window.
® Verify that the target range fits within the captured image.
If it does not fit, check the actual position of the camera, the selection status of the camera, and the target range
setting.
® When you click the [View larger image] button, the content of the captured image display window is displayed
enlarged in another window. If you resize that window, the image is also resized while maintaining the aspect ratio.
4) Click [Next].

® The layout settings of the camera may not be able to be changed depending on the conditions.

@® One projector's worth of overlap is required for images captured with cameras that are side by side.

® The layout settings of the camera can also be configured while checking the live view images. Click [Live View] and
configure the settings in live view.
&= “Live View” (page 147)
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Auto Screen Adjustment procedure

2 Configure the camera you will use in the camera setting screen.

[Auto Setup]

[Manual Setup]

@ Auto Screen Adjustment

Camera Setup.

Click Auto Setup and check the preview image

Auto Setup Live View

[White Balance /
Shutter Speed /
ISO / F-number]

1) Click the [Auto Setup] button.

MANUAL

Shutter Speed Ja

150 2000

Fonumber i

Testshot |

Ciick Next to continue.

[ viewlarger mage  Jm—

[Live View]

—Image display
window

—[Test Shot]

—[View larger image]

Camera setting screen

® A test pattern appears on the screen, and camera configuration starts automatically.
® \When using 2 or more cameras, configure the settings of all the cameras.

® The setting values configured in step 1) appear in the [White Balance / Shutter Speed / ISO / F-number] fields.

You can select the [Manual Setup] check box to configure the setting values manually.
@ If [Black Level] is selected, next also set the camera for black level adjustment.

2) Capture a test shot.

® A test shot is captured when you click the [Test Shot] button, and the captured image appears in the image display

window. Verify that the entire screen fits within the image display window.

® When you click the [View larger image] button, the content of the captured image display window is displayed
enlarged in another window. If you resize that window, the captured image is also resized while maintaining the

aspect ratio.

@ To obtain the optimal adjustment results, make adjustments so that the target area of the screen fills as much of the

captured image display window as possible.

® Adjustment may fail if the target area of the screen does not fit properly within the captured image display window.
® An error message appears if camera configuration fails. In such cases, check the content of the message, click [OK], and

configure settings again.

@ If the screen is too bright or there is a strong light present, overexposure may occur and adjustment may fail.

3) Click [Next].

® To return to the previous screen, click [Back].
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Projection Setting

Adjust the option selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page 118).
Perform the operations by referring to their explanations on the following pages.

® When [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] is selected
& “Geometry and Edge Blending Adjustments” (page 127)

® When “Color Matching” is selected

& “Color Matching Adjustments” (page 129)
® When “White Balance” is selected

& “White Balance Adjustments” (page 133)
® When “Black Leve” is selected

& “Black Level Adjustments” (page 136)

B Geometry and Edge Blending Adjustments

1 Confirm the changes to the projector settings and select a coordinate detection pattern in the setting

initialization confirmation screen.

@ Auto Screen Adjustment

Camera Sekect Projector Layout Camera Setting

NOTICE: Geometry + Edge Blencing adjustment wil begin soon.

- Do not operate the the

- The follow

=22
e projector medel, setting and input signal, ths setting may not be possibl.

- Select the detecton pattern

Coor

Clck Next to continue,

@ Auto Screen Adjustment

NOTICE: Geometry + Edge Hlending adjustment wil begin soon.

~Do ot operate the projectors other than this application while the auto adjustment is working.

amera Select Projector Layout

Camera Seting Projecion Set Screen Setting

willbe set i advance.

=22
Projector medel, setting and input signal, this setting may not be possile.

-Select the detection pattern

the brightress of

screens, i tis

coor v

Click Next to continue.

Setting initialization confirmation screen
(geometry correction and edge blending:
when black level correction not performed)

1) Confirm the changes to the projector settings

® The projector settings will change to those displayed on this screen. For the setting with a check box, adjustment

Setting initialization confirmation screen
(geometry correction and edge blending:
when black level correction performed)

can be made without changing that setting by clearing the check box.

2) Set a coordinate detection pattern.

® Select the detection pattern that matches the screen characteristics or camera layout.

[Color]:
[Monochrome]:

Pattern recommended for a diffusion type white matte screen.
Pattern recommended when using a screen with a narrow viewing angle such as a silver screen

or when the camera cannot be placed in front of the screen.

Some models do not support [Monochrome].

[Monochrome] can be selected only when it is supported by all of the selected projectors.

® Click [Back] to return to the previous screen.
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2 Click [Next].
When you click [Next], a progress bar appears. The detection pattern is projected and captured, and the projector
coordinates required for auto screen adjustment are detected.

(@) Auto Screen Adjustment

Camera Select Projector Layout Camera Setting Projecton Sefting Screen Sating

Please wait whil the patter detection s n progress.

Ttmay take several minutes.

® To cancel coordinate detection, click [Abort].
Click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

OK | | Cancel

3 Check the detection result for the coordinates of each projector captured with each of the cameras in the
coordinate detection result display screen.

@) Auto Screen Adjustment X

Camera Select Projector Layout Camera Setting Projecton Seffing Screen Seting

Check the detection results and proceed to the next.
I gain, cick ‘Back to

Canera Projector Result Detecton Rate ~
1 PROECTORI 192.168.0.8 ok a5
2 PROECTOR3 192.168.0.10 ok B
5 PROECTOR2 182.168.08 ok 100%
& PROJECTOR4 192.168.0.11 ok 100%
2 PROECTORS 192.188.0.10 ok 100%
3 PROXECTORS 182.168.0.12 ok 2%
& PROJECTOR4 192.166.0.11 ok 1%
7 PROECTORE 192.188.0.13 ok 7%
3 PROKECTORS 182.168.0.12 ok 5%
4 PROJECTOR? 192.168.0.14 ok 2%
7 PROECTORE 192.168.0.13 ok 0%
& PROJECTORS 192.165.0.15 ok s5%

I the detection resuitis NG, click Back to Camera Setting” to check i the camera s capturing the
projected image properly, and then try pattern detection again.
If camera placement and settings are 2 ptima, try the other detection pattern.

ClickNext to contine,

[ Backto Camera Setting | [ wee ]

Coordinate detection result display screen

Check that the coordinate detection results (“Result” column) of the projectors are all “OK”, and then click [Next].

® |f the coordinate detection rate is too low (below approximately 30%), the detection result will be “NG.” If there is even
one line with “NG”, you cannot go to the next step. Click [Back to Camera Setting] to return to the camera setting screen,
revise the camera settings and layout, and then run detection again.
Even if a result is “OK”, auto screen adjustment is extremely likely to fail if the coordinate detection rate is 40% or lower.
Click [Back to Camera Setting] to return to the camera setting screen, revise the camera settings and layout, and then
run detection again.
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Auto Screen Adjustment procedure

m Color Matching Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Next].

When you click [Next], the projector settings will change to those displayed on this screen. For the setting with a check
box, adjustment can be made without changing that setting by clearing the check box.
® To return to the previous screen, click [Back].

@ Auto Screen Adjustment.

Camera Select Projector Layout Camera Seting

NOTICE: Color Matching adjustment wil begin soon,
Do not aperate the projectors other than this application while the auto adjustment is working.

~The folowing projector setings wil be setin advance,
You can change these settings after auto adjustment finshed.

Picture Dynaric s / Bynamic Corrast —oFF

A =oFF

Brightness Control =oFF

Brihtness Control Gain - 100%

Light Output — MaxLight Output Level
Vihite Balance High [Red, Green, Bue] =255

frm the following settings are adjusted for al projectors,

Contrast Ganma
Brightness White Gain
Color. System Dayight View

Clck Next to contine.

Setting initialization confirmation screen (color and brightness adjustment)

1)  When adjusting color, use the [Auto] option to optimize adjustment for the screen overall, or the [Target Setting] option
when configuring a target (standard) projector.

@ Auto Screen Adjustment.

Camera Select Projector Layout Camera Sating

Select the Color Matching setting mode.
®@hAuto

Oergetseting (= Target settng mode canrot b selected when stacking.)

Click Start to begin Color Matching adjustment.

Projection Setting Sereen Setting
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2) If you select the [Target Setting] option, also select the projector that is to be the target.
® When you click the target projector number, the number and its frame change to red.

® Click the [Restore] button to restore the last previously set configuration.

® Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project

their numbers on the screen when you click the [Identify] button.

2 Click [Start].

©) Auto Screen Adjustment

Camera Select Projector Layout Camera Seting

Select the Color Matching setting mode.
Omuto
@Targetsettng  ( * Target setiing mode cannot be selected when stacking.)

Alow t decrease brightness of target projector by changing 7 Clors value.

Click the location of target projector on the layout chart below. (Target s shown i red.)

Clck Start to begin Color Matching adjustment.

Screen Setting

The projector positioning information is saved.

A progress bar appears, and Auto Screen Adjustment for color and brightness adjustment starts.

@ Auto Screen Adjustment.

0% [1/7] processing.

87 sec elapsed.

x

® To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

Auto Screen Adjustment

oK

Do you want to interrupt auto adjustment?

Cancel
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3 A message indicating that Auto Screen Adjustment is complete appears.
Click [OK].
If [Geometry, Edge Blending, Color Matching] was selected in "Starting Auto Screen Adjustment and selecting the
adjustment item" (page 118) and [Adjust using the camera] was selected in the black level adjustment screen (page
124), go to the procedure of “m Black Level Adjustments” (page 136)".
In the case of other than the above, auto screen adjustment is finished.
® To restore the conditions from before adjustment, select [Before Adjustment]. If you select [After Adjustment] after
selecting [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.

You can check each color on the screen.

Select Color OFF ~

(®) After Adjustment () Before Adjustmen

® The following message appears if Auto Screen Adjustment could not be completed and must be performed again.

To perform Auto Screen Adjustment for color and brightness correction again, click [Continue]. To exit Auto Screen
Adjustment, click [Finish].

Auto Screen Adjustment

The following adjustment could not yet complete in this condition.
L\ Red,Green,Blue,Cyan, Yellow, White @

You can check each color on the screen.

Select Color [ | White v——@

Do you want to continue to get better results?

Continue Finish

(D Colors for which Auto Screen Adjustment was not completed are displayed here.
(® Here you can confirm the adjustment results for the selected color on screen.

® A message appears if Auto Screen Adjustment fails due to overexposure.

If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.

® If Auto Screen Adjustment for color and brightness adjustment is performed again and fails to complete, a message will
appear. Click [OK] to exit Auto Screen Adjustment.

In such cases, perform adjustment manually in the main screen of “Geometry Manager Pro”.
&= “Adjustment and Settings — Color Matching / Color Adjustment” (page 89)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® When you click the [X| button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment >

Do you want to exit aute adjustment?

o [EE]

® The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time
you configure the settings.
® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.
& “Adjustment and Settings — Brightness Control” (page 86)
&= “Adjustment and Settings — Color Matching / Color Adjustment” (page 89)
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Auto Screen Adjustment Auto Screen Adjustment procedure

B White Balance Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Next].

When you click [Next], the projector settings will change to those displayed on this screen. For the setting with a check
box, adjustment can be made without changing that setting by clearing the check box.
® To return to the previous screen, click [Back].

@ Auto Screen Adjustment. X

Camera Select Projector Layout Camera Seting Projection Setiing Screen Setfing

NOTICE: White Balance adjustment wil begin soon.
Do not aperate the projectors other than this application while the auto adjustment is working.

~The folawing projector setings wil be setin advance,
You can change these settings after auto adjustment finshed.

Picture Gamma =22
“Depending on the projector mode, setting and input signal, this setting may not be possble
Dynamic s / Dynamic Contrast =oFF
A —orr
Brightness Control —orr
Brightness Control Gain = 100%
Light Output =Max Light Output Level

~Before starting auto adjustment, please confirm the following settings are adjusted for al projectors,

Picture Mode Tt

Contrast White Gain
Brighiness System Dayight View
Color.

~IF the input signal changed after auto adjusiment, White Balance setting nil be deared

Clck Next to continue.

Setting initialization confirmation screen
(White Balance Adjustments)

1)  When adjusting color, use the [Auto] option to optimize adjustment for the screen overall, or the [Target Setting] option
when configuring a target (standard) projector.

@ Auto Screen Adjustment. X
Camera Select Projector Layout Camera Setting Settng
Select the White Balance setting mode.
@huto
OTargetsettng  ( * Target setting mode cannot be selected when stacking.)

Clck Start to begin White Balance adjustment.
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2) If you select the [Target Setting] option, also select the projector that is to be the target.
® When you click the target projector number, the number and its frame change to red.
® Click the [Restore] button to restore the last previously set configuration.
® Click the [Identify] button to verify the actual projector positions on the projection screen. Each projector will project
their numbers on the screen when you click the [Identify] button.

©) Auto Screen Adjustment X

Camera Select Projector Layout Camera Seting Projecion Setting Screen Setting

Select the White Balance setting mode.
o
@Targetsettng  ( * Target setiing mode cannot be selected when stacking.)

Alow t decrease brightness of target projector by changing White Salance vakie

Click the location of target projector on the layout chart below. (Target s shown i red.)

Clck Start to begin White Balance adjustment.

® White balance is adjusted by configuring the [Picture]-[Color Temperature]-[USER1]-[White Balance High] values.

@ In order to manually pre-configure white balance for the target projector, change the [White Balance High] settings as
described earlier.

® The results of white balance adjustment are saved to the projector for each input signal. When the input signal is
changed, do the adjustment again.

® With some projectors that use single-chip DLP, the color matching setting is forcibly set to OFF when white balance is
adjusted. Refer to the operating instructions of the projector.

2 Click [Start].

The projector positioning information is saved.
A progress bar appears, and Auto Screen Adjustment for white balance starts.

@ Auto Screen Adjustment. X

50% [1/ 1] processin g 61sec elapsed.
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Auto Screen Adjustment Auto Screen Adjustment procedure

® To cancel Auto Screen Adjustment, click [Abort].
Click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

N

3 A message indicating that Auto Screen Adjustment is complete appears.
To exit Auto Screen Adjustment, click [OK].

® To restore the conditions from before adjustment, select [Before Adjustment]. If you select [After Adjustment] after
selecting [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.

[ o ]

You can check each color on the screen.

Select Color OFF ~

(®) After Adjustment () Before Adjustmen

® The following message appears if Auto Screen Adjustment could not be completed and must be performed again. To
perform Auto Screen Adjustment for white balance again, click [Continue]. To exit Auto Screen Adjustment, click [Finish].

Auto Screen Adjustment

The following adjustment could not yet complete in this condition.
White
1N

You can check each color on the screen,

Select Color |:| White V__®

Do you want to continue to get better results?

| Continue | | Finish |

(D Here you can confirm the adjustment results for the selected color on screen.

® A message appears if Auto Screen Adjustment fails due to overexposure.

If the screen is too bright or there is a strong light present, overexposure may occur. In such cases, click [OK] and
configure settings again.

® If Auto Screen Adjustment of white balance is not completed a second time, a message is displayed. Click [OK] to
complete Auto Screen Adjustment.

In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.
& “Adjustment and Settings - Picture” (page 103)
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Auto Screen Adjustment Auto Screen Adjustment procedure

® When you click the [X| button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment
appears.
To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment >

Do you want to exit aute adjustment?

o [EE]

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of
“Geometry Manager Pro”.
& “Adjustment and Settings - Input Signal Adjustments” (page 97)

m Black Level Adjustments

1 When the following confirmation screen appears, check the content displayed and click [Start].

When you click [Start], the projector settings will change to those displayed on this screen.
® To return to the previous screen, click [Back].

@ Auto Screen Adjustment. X

NOTICE: Black Level adjustment wil begin soon.

Do not aperate: the projectors other than this application while the auto adjustment is working.

- oFF

Click start to begin Black Level adjustment.

Setting initialization confirmation screen
(black level adjustment)
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Auto Screen Adjustment

Auto Screen Adjustment procedure

® A progress bar appears, and Auto Screen Adjustment for black level adjustment starts.

@) Auto Screen Adjustment.

Running Warped Detect Grid..

65 sec elapsed.

® To cancel Auto Screen Adjustment, click [Abort].
Click [OK] when the following screen appears.

Auto Screen Adjustment

QK

Do you want to interrupt auto adjustment?

: Cancel 4

2 A message indicating that Auto Screen Adjustment is complete appears.

Click [OK].

If [Geometry, Edge Blending] or [Black Level] was selected in “Starting Auto Screen Adjustment and selecting the

adjustment item” (page 118), Auto Screen Adjustment is complete.

® To restore the conditions from before adjustment, select [Before Adjustment]. If you select [After Adjustment] after
selecting [Before Adjustment], the displays are returned to the conditions from after Auto Screen Adjustment completion.

Auto Screen Adjustment

Adjustment completed.

You can chedk each color on the screen.

Select Caolor - Bladk w

(®) After Adjustment

Select Black Level Area
(®) Geometry Linked

i) Before Adjustment

*The adjusted black level iz set only in the video display area.
Recommended when projecting within the frame of the screen.

() Geometry Unlinked

*The adjusted black level setting is set not only inside the video display area

but also outside the area.
Recommended when projecting on a wall without a screen frame.
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Auto Screen Adjustment

Auto Screen Adjustment procedure

® For a model that allows you to specify the area of black level adjustment, the correction area of black level adjustment is
switched to allow you to check the adjustment result when you select [After Adjustment].

[Geometry Linked]:
after geometry correction.
[Geometry Unlinked]:
video display area.

Switches to the state with black level adjustment performed only inside the video display area

Switches to the state with black level adjustment performed in area also including outside the

The elevated blacks of overlapping parts outside the video display area can be made less

visible.

If the projector layout has two or more projectors placed vertically or horizontally, a message indicating that the
adjustment result may be inappropriate appears if you select [Geometry Unlinked]. If you click [OK], the [Geometry

Unlinked] setting is reflected.

If a model that does not allow you to specify the area of black level adjustment is included, it does not support this

function.
® The following message appears if Auto Screen Adjustment could not be completed and must be performed again.
To perform Auto Screen Adjustment for black level correction again, click [Continue]. To exit Auto Screen Adjustment for
black level correction, click [Finish].
Auto Screen Adjustment
The following adjustment could not yet complete in this condition.
Black
N
You can check each color on the screen.
Select Color || | White v
Do you want to continue to get better results?
® A message appears if Auto Screen Adjustment fails due to the impact of external lighting, etc.

An error occurs if the surroundings are too bright or the brightness is changed. In such cases, click [OK] and configure

settings again.

Click [OK] to exit Auto Screen Adjustment for black level correction.
In this case, perform adjustments manually in the main screen of “Geometry Manager Pro”.

@ “Adjustment and Settings - Edge Blending” (page 71)

If Auto Screen Adjustment for black level correction is performed again and fails to complete, a message will appear.

® When you click the x button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment

appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

Auto Screen Adjustment

CK

Do you want to exit aute adjustment?

Cancel

x

® The projector layout information configured during Auto Screen Adjustment is stored until the next time you configure the

settings.

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of

“Geometry Manager Pro”.
& “Adjustment and Settings - Edge Blending” (page 71)
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Auto Screen Adjustment Auto Screen Adjustment procedure

Screen Setting

1 Configure the screen type, overlap areas, and cursor layout in the screen setting screen.

Screen type Number of cursors

@ Auto Screen Adjustment. X

[Auto Cursor] /
[Cursor Reset]

—[Live View]

——Screen display settings

0 <z x

Cursor— ——[the last / the second last /

the third last]

Screen setting window —

[Restore]

e 2 . I [Edge Blending Width]

< pixel [ 10.%]

Click Start to begin Geometry +Edge Blending adjustment

= ol

Screen setting screen

1) Specify the screen type and number of cursors.

® Select the screen type that matches the shape of the screen. Set the number of cursors according to the shape or
curvature of the screen.
[Flat]: Flat screen
[Horizontal Curve]: Screen that is curved in the horizontal direction
[Vertical Curve]: Screen that is curved in the vertical direction
[H-V Curve]: Screen that is curved in the horizontal or vertical direction

® The number of cursors that can be selected is a total of 300, with 2 to 100 per side when [Flat] is selected and 3 to
100 per side when other than that is selected.

When the software transitions to this screen, a number of cursors calculated from the number of projectors and layout
information is set automatically. This value is merely supposed to serve as a guide. Change it to match the shape or
curvature of the actual screen.
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Auto Screen Adjustment Auto Screen Adjustment procedure

2) Position the cursors in the screen setting window according to the shape of the screen.

® Select whether to check cursor positions in the actual screen or in a screen on an image captured by the camera.
[Projector]: Actual screen
[Camera]: Screen on an image captured by the camera

® \When using multiple cameras, there is the method to check each one in the image captured by each camera, and
the method to check in a large image created by stitching each of the images into one.
If you want to check in each image, the image of the camera selected in the list is displayed in the screen setting
window.
If you want to check in a stitched image, click the [Stitched Image View] button to display a stitched image in a
separate screen. In this case, the cursor positions will be reset.

Auto Sereen Adjustment X

SqeenType  Flat ~ CrossCursars  Hi 4 (S w3 B Auto Gursor

Click [OK] to close the separate screen and return to the previous screen.

@ If you click the [Enlarged View] button, the image displayed in the screen setting window is displayed in a separate
screen.
You can change the cursor layout, screen type, and number of cursors on the enlarged view screen.
Click [OK] to close the separate screen and return to the previous screen.

® The magnification rate (fit the entire image in the screen setting window, 1/2x of the actual image, or 1x of the
actual image) of an image captured with a camera can be selected using the slider.

® \When an image captured with a camera is displayed in the screen setting window, the selection state cursor is
displayed in red, and the other cursors in yellow.

® Position each cursor by dragging them or by using the arrow keys on the keyboard. When using the keyboard,
pressing an arrow key while a cursor is selected moves the cursor 8 dots, pressing an arrow key while holding the
Ctrl key moves the cursor 1 dot, and pressing an arrow key while holding the Alt key moves the cursor 64 dots.

@ You can select the next cursor by pressing the Tab key, or the previous cursor by pressing the Tab key while
holding the Shift key.

® When positioning the cursors while viewing the actual screen, you can also select cursors using the number keys
on the keyboard.
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Auto Screen Adjustment Auto Screen Adjustment procedure

® The cursors can be positioned automatically by determining the position of the screen from the captured image and
projection position. Click the [Auto Cursor] button to open the auto cursor layout screen.

Auto Cursor X
L. Confirm that the calculated cursor positions are appropriate in the resut mage, and cick Next.
o elow dots, an asreenine in
diust the thresh and dick Recalc

P

jd and
i necessary.

and detect the
iarized image, ncr
e

m the binarized image.

image, the area outside the red frame wil be masked,

e screen detection area, When g 2 outsic
t areas due to lighting, cick and crag the ed frame to adiust the position and size.

v CossCusars H: 41T W 215 threshod 135 0 I 255

Auto cursor layout screen

The following are displayed in the [Result Image] window.

Red frame: Area to detect the position of the screen (Screen Detection Area).

Green frame: Automatically detected screen area

Yellow points: Cursor positions detected based on the screen area
Change the screen shape and number of cursors as necessary.
If the screen area is not detected properly, adjust [threshold] so that there is no blurring or missing parts in the
screen area in the [Binarized Image] window.
If there is lighting, reflections, etc., the calculations of cursor positions may be incorrect. Adjust [Screen Detection
Area] in the [Result Image] window to exclude other than the necessary area. Then, click the [ReCalc] button to
recalculate the cursor positions and update the [Result Image] window.
Click [Next] to confirm the cursor positions and go to the cursor position manual adjustment screen.

Auto Cursor Result x

Adiust the aursor s needed and press the Apply button.

Cursor position manual adjustment screen
In the cursor position manual adjustment screen, finely adjust the cursor positions that you confirmed in the
previous screen. Click [Apply] to reflect the adjustment results and return to the previous screen.

@ If the cursor layout was previously configured and adjusted, you can restore up to the three most recent cursor
layout configurations using the [Restore] button. Select [the last], [the second last], or [the third last] from the pull-
down menu to select the configuration you want to restore, and click the [Restore] button.

® To return all cursors to their original positions, click [Cursor Reset] button.
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Auto Screen Adjustment procedure

® When positioning the cursors while viewing the actual screen, the maximum number of cursors that are projected
on the screen at one time is 100. Up to two digits can be be displayed for numbers on the screen, and the 100th,
200th, and 300th cursors will be displayed as "0." For example, when you want to select the 101st cursor, press the
Tab key while the 100th cursor is selected, or enter "101" using the keyboards number keys.
The cursors that are projected are switched in groups of 100 in different colors. Cursors 1 to 100 are displayed in
yellow, 101 to 200 in cyan, and 201 to 300 in magenta.
® The cursor can be selected and moved while checking the live view images. Click [Live View] and configure the

settings in live view.
& “Live View” (page 147)

® The cursor can be selected and moved using a gamepad. A function can be assigned to each button of the
gamepad by clicking the [KeyConfig] button.
& “Operation by Gamepad” (page 152)
3) To configure the horizontal and vertical overlap areas, enter the values in the [Edge Blending Width] fields.
® The [Edge Blending Width] values are set the same for all projectors.
® You can also use the sliders to specify values.
® A percentage value that corresponds to the configured pixel count appears in the percent display.

® To configure the overlap areas automatically, place check marks next to || Auto of [Horizontal] and [Vertical]. The
values resulting from automatic configuration appear in a message after adjustment is complete.

2 If the content being projected has margins and you want to set the margin area, select the check box next to
[Enable] by [Margin Setting] in the screen setting screen, and then click [Setting].

® Setting a screen margin makes it easier to set the position of cursors when making screen settings.
® Setting of straight margins is possible. Setting of curved margins is not possible.

@) Auto Screen Adjustment.

[ Au o
Horizontal [192 1= pinel [ 10 %] 1 Vet 0 2| poel[0%

Click Start to begin Geometry + Edge Blending adjustment

Screen setting screen
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Auto Screen Adjustment

Auto Screen Adjustment procedure

® The margin setting screen opens.

Select the type for margin with [Margin Type] and then set the margin size as a numeric value.

@ Auto Screen Adjustment

Margin type

AutoMasking [OFF -

Auto Masking

—[Restore]

Margin setting

Opixel

Click OK to continue.

D
—
[ == j——[Reset]
Ops = ge fil

—— [Open]

® Select the margin type.

Margin setting screen

[Horizontal]: Horizontal margins at the top and bottom of the image

[Verticall:

[Custom]:  Margins other than the above

Vertical margins at the left and right sides of the image

® To use Auto Masking together with margins, configure [Auto Masking].

[OFF]:

Auto Masking is not performed.

[PC-1/PC-2/ PC-3]: Auto Masking is enabled.

[Auto Masking] will only be applied if the upgrade kit (ET-UK20) has been applied to the selected projector. Some

models do not support this function.
& “Activation” (page 12)

® Specify margins on each side individually. Select either [%] or [pixel] for [Scale] and enter the overall size of the projected
content (including margins) in terms of the percentage or number of pixels. Note that the total margin that can be set on

any given side cannot exceed 60%.

If [pixel] is selected for [Scale], change the numerical value for [Total resolution] according to the overall content size.

[ =}

[10,00%]
Scale
%
®bixel
30 2
Total resolution I:
[2.50%]

H: | 3340 2
1200 2

Vi

96 =( [2.50%]

96 5 [2.50%]

T= Total resolubon of the content image is required. )

0 5| [0.00%]
120 -2

[10.00%]

290 -2
[20.00%]

05 [0.00%]

® Click the [Restore] button to restore the margins to the last previously set configuration.
® Click the [Reset] button to return the configured margin size to the initial value (about 5%).
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Auto Screen Adjustment Auto Screen Adjustment procedure

® Click the [Open] button to reads reference image files (files with the extension .bmp or .jpeg).

® \When done setting the margins, click [OK].
Display returns to the screen setting screen.

3 Click [Apply].
To save the projector positioning information, click [Apply].

® A progress bar appears, and Auto Screen Adjustment for geometry correction and edge blending starts.
® To return to the previous screen, click [Back].

@) Auto Screen Adjustment.

Camera Select Projector Layout Camera Seting Projection Sefting

Please wait Lnt the adjustment results are ransferred.

Ttmay take several minutes.

50 % processin g 5 sec elapsed,

® To cancel Auto Screen Adjustment, click [Abort].
In such cases, click [OK] when the following screen appears.

Auto Screen Adjustment

Do you want to interrupt auto adjustment?

N

When you are making adjustments for 2 or more cameras, an error will be displayed if you click [Start] in the state in which
the number of cursors in the direction that the cameras are arranged is the number of cameras or less. Set a number of
cursors that is at least one more than the number of cameras.
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Auto Screen Adjustment Auto Screen Adjustment procedure

4 When Auto Screen Adjustment is successfully completed, the following message appears.

If you selected the [¥] Auto check box in [Edge Blending Width], the values resulting from automatic configuration are
displayed.

@ Auto Screen Adjustment. X

Pattem Black Level Area
Check the adjustment resul.

oFF ~ Geometry Linked
Edge Blending Width : 96 pixel

Edge Blending
on -

Select the location to store adjustment dats, and dick next to continue.
Adjustment data will be stored in the projector.

O None Orct Orc2 Orc3

tortion of the projected image,
ng”.
ojection are, dick "Back to Screen Setting”,

Back to Camera Setting Back to Sereen Setting

Select [PC-1], [PC-2], or [PC-3] as the storage location to save the adjustments in the projector, or select [None] to not
save the adjustments.

If you want to revise the adjustments, you can return to the camera setting screen by clicking [Back to Camera Setting] or
return to the screen setting screen by clicking [Back to Screen Setting].

When the adjustments are complete, you can display a test pattern or set Edge Blending to ON/OFF.

If [Geometry, Edge Blending, Color Matching] or [Geometry, Edge Blending] was selected in auto screen adjustment and
all of the projectors for which adjustments were made support the area selection function of black level adjustment, you
can switch the black level adjustment area.

If [Geometry, Edge Blending] was selected in “Starting Auto Screen Adjustment and selecting the adjustment item” (page
118) and [Set temporary value] or [Use current settings] was selected in the black level adjustment screen (page 124),
click [Next] to save the adjustments in the projector. Auto screen adjustment is complete.

If [Geometry, Edge Blending, Color Matching] was selected in “Starting Auto Screen Adjustment and selecting the
adjustment item” (page 118), click [Next] to save the adjustments in the projector and prepare for color and brightness
correction. Go to the procedure of “a Color Matching Adjustments” (page 129).

In the case of other than the above, click [Next] to save the adjustments in the projector and prepare for black level
adjustment. Go to the procedure of “m Black Level Adjustments” (page 136).
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® A message appears if Auto Screen Adjustment fails. In such cases, check the content of the message, click [OK], and

configure settings again.

To return to the screen from step 1 (& page 139), click [OK].

Auto Screen Adjustment

e Adjustment failed

correctly.
Please check the following.

screen?

[2004]

Projected pattern on the RED frame pertien could not be detected

- Does the preview image at the Camera Setup Page contain the whole

- Is a large part of the projected image on the screen?
- Is there no bright ambient light on the screen?

s Auto Screen Adjustment

® Capture a test shot, and verify that the entire screen
fits within the image display window. (& page 126)

Adjustment failed

The projection area with the RED frame portions on the screen could
not be adjusted.

Please adjust the position of the projection area or the position of
the cross cursors at the Projection Setting.

- The RED frame portions should cover the screen properly.

- The RED cross cursors should overlap with the GREEN cursors,
[2006]

® Verify that a large portion of the projected image to be

adjusted fits within the screen.

® Check that the camera and screen are as close as
possible to directly facing each other.

® Even if there is a setting that exceeds the geometric distortion correction limit of the projector, the adjustment results will

® Check the position of the image that is projected on
the screen.

be sent to the projector. Bear in mind, however, that in such cases the projected images may lose their shape.

® When you click the button at the top right of the screen, a confirmation screen for canceling Auto Screen Adjustment

appears.

To exit Auto Screen Adjustment, click [OK]. To return to the previous screen, click [Cancel].

® The projector layout and cursor layout information configured during Auto Screen Adjustment is stored until the next time

you configure the settings.

® To perform detailed adjustment after using Auto Screen Adjustment, perform adjustments manually in the main screen of

“Geometry Manager Pro”.

Auto Screen Adjustment

Do you want to exit aute adjustment?

o (e

Pt

&= “Adjustment and Settings - Geometry Correction” (page 57)
&= “Adjustment and Settings - Edge Blending” (page 71)
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Live View

Settings can be configured when, for example, it is difficult to go to the site or checking is difficult because the distance from
the screen is far, by making installation adjustments while looking at live view images shot with a camera.

@ Installation of the Auto Screen Adjustment plug-in software must be complete to use the live view function.
&= “Installing the “Auto Screen Adjustment plug-in software™ (page 8)

® The cameras that can be used with live view are the cameras compatible with Auto Screen Adjustment and some cameras
that can connect to the LAN. For details on compatible cameras, check the information found on the software download
page after logging in to PASS on the following website.
https://panasonic.net/cns/projector/pass/

Live View Preparation

H Camera connection

Use a USB cable or LAN cable to connect the camera to the computer.

Live View Procedure

Camera Search screen

Search for the camera to use in the live view.

Camera Search *

Connection Setting

®—— USB connected camera

@—— |:| Network connected camera (Integrated camera)

. | 192 . 168 . 0 . 18 |

(§) ————— [JEnd PAddress: | : : - |

@ : Search | Exit

@ USB connected camera

Select this when searching for a camera connected by USB.
@ Network connected camera

Select this when connecting with a camera connected by LAN. The IP address needs to be specified.
@ IP Address

Enter the IP address of the camera to connect. To search for the camera to connect, enter an IP address for which to start
the search.

(@) End IP Address

To search for the camera to connect, select the check box and enter the IP address for which to end the search.
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@ Search / Connect

When a search for the camera to connect is performed, the search starts according to the entered information.

When a search for the camera to connect is not performed, an attempt is made to connect with the camera according to
the entered information and the Live View screen appears if the connection is successful.

If the connection is successful, the Camera Search screen closes.

(®) Exit

Cancel the connection with the camera and close the Camera Search screen.

Camera List screen

When the camera search is completed, the Camera List screen appears.

Camera List >
] Maodel
O) [¥] Camera1 AW-HE70(192. 168.0.98)
[] cCamera2  AW-HE7D(192.158.0.99)
D Camera 3 AW-HETO(192. 165.0, 100)
Q—————— selectall Clear Al —Q
@—————  Back ——®

@ List of cameras to connect

Displays a list of cameras that were detected by the search.

(2 selectAll

Select all the detected cameras.

3 clearAll

Clear the selection of all detected cameras.

@ Back

Return to the Camera Search screen.

(5B) ok

Connect with the selected cameras and display the Live View screen.

148



Live View

Live View Procedure

Live View screen

If the connections with the cameras are established correctly, the Live View screen appears.
If you resize the window, the Live View screen is also resized while maintaining the aspect ratio. However, it cannot be made
smaller than the original window.

@

@
®
@
®
®
@

© @

Camera list

Live View : AW-HE70(192.168.0.99)

D Model

AW-HE7D(192. 168.0.98)
AW-HE70(192. 168.0.59)
AW-HE7D(192. 168.0. 100)

Camera 1

Camera 2

Camera 3

177

Add

Exit

Preset

Zoom

Focus

Tit

Brightness

e
%10 - + _@
Auto @
Near O.T.AF Far
A
<« » ®
v
—
Auto
. @
= a— )

When cameras with LAN connections

Displays a list of the cameras connected with this application.

Live View screen

This shows live view images of the selected camera.

Preset

Move the camera to the pan, tilt, focus, and zoom settings of the selected preset position.

Zoom

Set the camera zoom.

Focus

Set the camera focus.

Pan Tilt

Set the camera panliilt.

Brightness

Set the camera brightness.

WEB Setting

Open the Web browser to configure the camera settings.

The preset settings of the camera need to be configured from the Web browser screen.

Add

Add a camera.

Single/Multi Selection

Switch live view display to a single camera only or multiple cameras.

Exit

Close this screen and exit live view.
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Live View

Live View Procedure

@ Resolution

Set the resolution of live view images. The setting is fixed to [VGA].

Even if you change the resolution, the display size of the Live View screen does not change.

Live View : D5500/D5600

D Model
Camera 1 AW-HE70(192.168.0.98)

D5500/D5600
Camera3  AW-HE7D(192.168.0.100)

®Single
O Multi

Resolution

Area

Manual

Near

When cameras with USB connections

Display is enlarged or reduced to fit this range.

@ Focus

Set the camera focus.

Mode:

Set the focus operation mode.

Area:
Set the AF area.

Manual:

Adjust the focus when [Mode] is [AF-S].

® When focus adjustment is performed, the operation may not be noticeable due to the corresponding amount of
change being extremely small.

® This is disabled when [Mode] is [Manual]. Adjust the focus by turning the focus ring of the lens when this mode is

set.

150



Live View Live View Procedure

You can also check the live view images of multiple cameras at the same time.

Live View : Multi-screen X

o} Model Camers 1 Camera 2

Cameral  AW-HE70{192.158.0.98) |
Camera2  AW-HE70(192.168.0.99) |
Camera3  AW-HE7D(192.168.0.100)

Camera 3
-
— \ . -

- -
O single ol

@ i

Exit

® Live view continues even if Auto Screen Adjustment is started.
However, live view images may temporarily disappear during various shooting with the Auto Screen Adjustment function.
® The live view images of all of the cameras in the camera list are displayed in the live view of multiple cameras.

However, when there are multiple cameras with USB connections connected, the following restrictions apply to the live view

of multiple cameras.

- If a camera with a USB connection is selected immediately before switching to the live view of multiple cameras, the live
view images of the cameras with USB connections that were not selected will be displayed all black.

- If a camera with a LAN connection is selected immediately before switching to the live view of multiple cameras, the live
view images of the cameras with USB connections except the camera with a USB connection that has the smallest ID
number will be displayed all black.

® Display with live view of multiple cameras is slow compared with live view of a single camera.
® The live view images of multiple cameras cannot be resized even by resizing the window.
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Operation by Gamepad

Operation using a gamepad is supported for some functions of this application. This enables intuitive operation since you do
not need to make adjustments while alternately looking at the projected images and computer screen.

® Operation by gamepad is supported for the following functions. Operation for functions other than the following requires a
computer keyboard and mouse as previously.
- Image correction by control point operation in the editing area during geometry correction
- Cursor selection and movement during auto screen adjustment

® Operation by gamepad is supported for cursor selection and movement during auto screen adjustment by all models that
support the Auto Screen Adjustment function, but it is only supported for image correction by control point operation in the
editing area during geometry correction by some models.

® Only a gamepad that is compatible with XInput can be used. Operation is not guaranteed for other APlIs or for functions
extended by individual makers.

Gamepad Operation Preparation

H Projector connection

Use a LAN cable to connect the projector to the computer.

B Gamepad connection
Connect the gamepad to the computer.

® For details on how to connect the gamepad to the computer, refer to the operating instructions of the gamepad.
@ If multiple gamepads are connected, only the one that was connected first can be used with this application. If the gamepad
being used is disconnected, only the subsequently connected gamepad can be used.
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Operation by Gamepad Gamepad Operation during Geometry Correction

Gamepad Operation during Geometry Correction

You can use a gamepad to perform image correction by control point operation in the editing area during geometry correction.
The function assignment for each key of the gamepad can be customized to make the gamepad easier to use.

Key Config screen

Change the function assignment for each key of the gamepad from the Key Config screen.

?

Key Config x

A LEFT SHOULDER START

®—— Select a single point - Back Test Pattern ~ Change correction amount v——®
] RIGHT SHOULDER BACK

@—— Select multiple points v Next Test Pattern v Switch lock status v——
X V] LEFT TRIGGER

@—— Next Grid Lines | b Move up select point ~ Change Grid Resolution X v——@
¥ DOWN RIGHT TRIGGER

@__ Back Grid Lines | = Move down select point ~ Change Grid Resolution ¥ v——
LEFT THUMB LEFT SELECT STICK MODE

@—— Undo v Move left select point ~ LEFT STICK / RIGHT STICK

Move Cursor/Warp Point v——@

RIGHT THUMB RIGHT CURSOR SPEED

®__ Redo ~ Mave right select point ~ 3 I ——

Set Load Save

@ A

Select the operation for when the [A] button is pressed.

B

Select the operation for when the [B] button is pressed.

x

Select the operation for when the [X] button is pressed.

<

Select the operation for when the [Y] button is pressed.

LEFT THUMB

Select the operation for when the left thumbstick is pushed in.
RIGHT THUMB

Select the operation for when the right thumbstick is pushed in.
LEFT SHOULDER

Select the operation for when the left shoulder is pressed.
RIGHT SHOULDER

Select the operation for when the right shoulder is pressed.

uUpP

Select the operation for when the up button of the directional pad is pressed.

®@ Q @©@ @ ® © ©

©® ©

DOWN

Select the operation for when the down button of the directional pad is pressed.
LEFT

Select the operation for when the left button of the directional pad is pressed.

RIGHT

Select the operation for when the right button of the directional pad is pressed.

® ©
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Operation by Gamepad

Gamepad Operation during Geometry Correction

(3 START
Select the operation for when the [START] button is pressed.

(4 BACK

Select the operation for when the [BACK] button is pressed.

(5 LEFT TRIGGER

Select the operation for when the left trigger is pressed.

RIGHT TRIGGER

Select the operation for when the right trigger is pressed.

@

® The following functions can be assigned to [A] to [RIGHT TRIGGER].

Function

Description

Select a single point

Select one control point or one area.

Select multiple points

Select multiple control points or multiple areas while keeping the already selected
control point selected.

Move up select point

Move the position of the selected control point up by one grid.

Move down select point

Move the position of the selected control point down by one grid.

Move left select point

Move the position of the selected control point left by one grid.

Move right select point

Move the position of the selected control point right by one grid.

Switch lock status

Switch between lock and unlock for all grid intersection points.

Change correction amount

Change the correction amount of the control point.

Previous Test Pattern

Change to the previous test pattern.

Next Test Pattern

Change to the next test pattern.

Previous Grid Lines

Change to the previous grid line display color.

Next Grid Lines

Change to the next grid line display color.

Change Grid Resolution X

Increase the number of grid lines in the horizontal direction by one.

Change Grid Resolution Y

Increase the number of grid lines in the vertical direction by one.

Switch Transfer Mode

Switch between [Manual Transfer] and [Auto Transfer].

Send data Transfer the correction data when [Auto Transfer] is [OFF].
Undo Undo.
Redo Redo.

Move Cursor to Default

Select the top left grid intersection point and align the mouse cursor.

Unable

Disable the button.

® The same function can be assigned to multiple buttons.

SELECT STICK MODE

Select the operations for when the left and right thumbsticks are lowered.

Move Cursor/Warp Point: Move the mouse cursor with the left thumbstick and perform control point correction with the
right thumbstick.

Warp Point/Move Cursor: Perform control point correction with the left thumbstick and move the mouse cursor with the
right thumbstick.

CURSOR SPEED

Specify the speed of mouse cursor movement.

Inputrange: 1to 5
Set

Reflect the current function assignment for each key and close this screen.
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Operation by Gamepad Gamepad Operation during Geometry Correction

@ Load

Load a file containing the function assignment for each key.

@ Save

Save the function assignment for each key to a file.

Specify [Unable] for a button to which you do not wish to assign a function (disable the button). However, you cannot disable
the function assignment of when the left and right thumbsticks are lowered.

For the gamepad key layout, refer to the following diagram. Please note that the layout may differ depending on the maker.

LEFT TRIGGER RIGHT TRIGGER
A —
[ +— RT

LEFT SHOULDER RIGHT SHOULDER

LEFT THUMBSTICK

UP/DOWN/LEFT/RIGHT RIGHT THUMBSTICK

Operation method

m Selecting the control points

To select a single control point, perform the following operation.

1 Move the mouse cursor to the grid intersection point that you wish to select with a thumbstick.
2 Click the button with [Select a single point] assigned.

3 The intersection point specified by the mouse cursor is selected as the control point. At this time, a white O
appears at the same position on the projected image. If a control point is already selected, it is deselected.

Screen in this software (control point selected) Projected image with control point selected
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Operation by Gamepad Gamepad Operation during Geometry Correction

To select multiple control points, perform the following operation.

1 Move the mouse cursor to the grid intersection point that you wish to select with a thumbstick.

2 Click the button with [Select multiple points] assigned.

3 The intersection point specified by the mouse cursor is selected as the control point. At this time, white O
appear at the same positions on the projected image. If a control point is already selected, a control point is

added without deselecting that control point.

4 Repeat steps 1 to 3 for the control points you wish to select.

To select the control points of one vertical or horizontal line, perform the following operation.

1 Move the mouse cursor onto a line between two grid intersection points with a thumbstick.

2 Click the button with [Select a single point] assigned.
3 All intersection points existing on the line are selected as control points. At this time, white O appear at the
same positions on the projected image. If a control point is already selected, it is deselected.

To add control points of one line while a control point is already selected, click the button with [Select multiple points] assigned
instead in steps 1 to 3 above.

To select control points with area specification, perform the following operation.

1 Move the mouse cursor to a place near a grid intersection point you wish to select with a thumbstick.
Move the cursor while holding down the button with [Select a single point] assigned to enclose an area.

2
3 Release the held down button.
4

The grid intersection points included in the rectangular area enclosed by moving the cursor are selected as the
control points. At this time, white O appear for the number of selected intersection points at the same positions
on the projected image. If a control point is already selected, it is deselected.

To add control points with area specification while a control point is already selected, hold down the button with [Select
multiple points] assigned instead in steps 1 to 4 above.

Area selection cannot be performed if an already selected control point exists below the mouse cursor when selecting an area.
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Operation by Gamepad Gamepad Operation during Geometry Correction

B Moving (correcting) the control points

When a control point is selected, move the control point by lowering the thumbstick with control point correction assigned in
any direction.

A control point normally moves in 1-pixel increments, but the amount of movement when the thumbstick is lowered can be
changed by clicking the button with [Change correction amount] assigned. At this time, a red (coarse adjustment: 4 pixels) or
green (fine adjustment: 0.2 pixels) line is displayed around the white [ at the control point on the projected image.

When normal movement amount When coarse adjustment When fine adjustment

When [Auto Transfer] is OFF, the corresponding information can be reflected in the projected image by clicking the button with
[Send data] assigned or clicking [Manual Transfer] on the application screen.

B Locking/unlocking control points

Clicking the button with [Switch lock status] assigned locks or unlocks all grid intersection points in one go.
If this operation is performed while there is a grid intersection point locked at even one place, it is unlocked.

The locked grid intersection points are indicated by black B at the same positions on the projected image.

If you select a single locked grid intersection point or multiple locked grid intersection points, just the selected control point(s)
will be unlocked and selected as a new control point(s).

If control point selection is performed on a line between multiple locked control points, none of the control points will be
unlocked.
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Operation by Gamepad Gamepad Operation during Auto Screen Adjustment

B Changing the control points

When the button with [Move up (down/left/right) select point] assigned is clicked while just one control point is selected, the
control point selection position changes by moving one grid up (down/left/right).

® While multiple control points are selected, the control point positions will not change even if you perform this operation.
® If the destination for control point movement is locked, that control point is kept locked.
® If some error occurred or a state that needs to be checked occurred during operation, you will be notified by the gamepad
vibrating.
- When the control point movement amount was too large (= image correction amount was too large) while the [Alert
Distortion] check box is selected
- When the button with [Change Grid Resolution X] (or [Change Grid Resolution Y1]) assigned is clicked while the number
of horizontal grids has reached the limit
- When an error occurred with communication between the projector and PC

Gamepad Operation during Auto Screen Adjustment

You can use a gamepad to perform cursor selection and movement during auto screen adjustment.
The function assignment for each key of the gamepad can be customized to make the gamepad easier to use.

Key Config screen

Change the function assignment for each key of the gamepad from the Key Config screen.

Key Config x
A up
@—— Mave down Cross Cursor ~ Move up Cross Cursor ~ _—®
B DOWN
®—— Mave right Cross Cursor ~ Mave down Cross Cursor ~ _—
k3 LEFT
@—— Mave left Cross Cursor ~ Move left Crass Cursor ~ _—®
¥ RIGHT
@__ Move up Cross Cursor ~ Move right Cross Cursor ~ _—
LEFT THUMB BACK.
@—— Select forward Cross Cursor Unable i _—®
RIGHT THUMB
@—— Select back Cross Cursor ~
CHANGE CROSS CURSOR SPEED
Please choose from the following button combinations.
FAST-5LOW FAST-5LOW
LS : LEFT SHOULDER LT : LEFT TRIGGER.
F——RSATASLT | RS : RIGHT SHOULDER. RT : RIGHT TRIGGER
Set Load Save

i
|
@®

6__

A
OF

Select the operation for when the [A] button is pressed.

@ B

Select the operation for when the [B] button is pressed.

3 x

Select the operation for when the [X] button is pressed.

@ Y

Select the operation for when the [Y] button is pressed.

(5) LEFT THUMB

Select the operation for when the left thumbstick is pushed in.
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Operation by Gamepad Gamepad Operation during Auto Screen Adjustment

(6) RIGHT THUMB

Select the operation for when the right thumbstick is pushed in.
@ up
Select the operation for when the up button of the directional pad is pressed.

DOWN

Select the operation for when the down button of the directional pad is pressed.

©

LEFT

Select the operation for when the left button of the directional pad is pressed.

RIGHT

Select the operation for when the right button of the directional pad is pressed.

1) BACK

Select the operation for when the [BACK] button is pressed.

® The following functions can be assigned to [A] to [BACK].

© ©

Function Description
Move up Cross Cursor Move the selection state cursor up.
Move down Cross Cursor Move the selection state cursor down.
Move left Cross Cursor Move the selection state cursor left.
Move right Cross Cursor Move the selection state cursor right.
Select next Cross Cursor Select the next cursor.
Select previous Cross Cursor Select the previous cursor.
Unable Disable the button.

® The same function can be assigned to multiple buttons.

(12 CHANGE CROSS CURSOR SPEED

Select what combination of the left and right shoulders and triggers to assign changing the selected cursor movement
speed.
The cursor movement speed increases or decreases by performing operation while pressing the keys specified here.

@ Set

Reflect the current function assignment for each key and close this screen.

®

Load

Load a file containing the function assignment for each key.

@ Save

Save the function assignment for each key to a file.

@ Start of adjustment is assigned to the [Start] button so another function cannot be assigned.

® Cursor movement is assign for the operation when the left and right thumbsticks are lowered so another function
cannot be assigned.

® Specify [Unable] for a button to which you do not wish to assign a function (disable the button). However, you cannot
disable the function assignment of the left and right shoulders and triggers.
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Operation by Gamepad Gamepad Operation during Auto Screen Adjustment

Operation method

Position the cursors according to the shape of the screen while checking the images projected on the actual screen.

B Selecting a cursor

Select the next cursor by clicking the button with [Select next Cross Cursor] assigned, and select the previous cursor by
clicking the button with [Select previous Cross Cursor] assigned.

® Moving cursor

Move the position of the selected cursor up (down/left/right) by clicking the button with [Move up(down/left/right) Cross Cursor]
assigned. Also, move the position of the selected cursor by lowering either the left or right thumbstick in any direction.
Ordinarily, movement is 8 dots, but you can move the selected cursor 64 dots by performing the selected cursor movement
operation while holding down the button for which movement at high speed is assigned and move the selected cursor 1 dot

by performing the selected cursor movement operation while holding down the button for which movement at low speed is
assigned with [CHANGE CROSS CURSOR SPEED].

When positioning of the cursors is completed, start auto screen adjustment for geometry correction and edge blending by
clicking [START] button of the gamepad.

Selecting the screen type, changing the number of cursors, and setting the edge blending and margin areas are not possible
with a game pad. Configure the settings using a computer keyboard and mouse as previously.
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Frequently Asked Questions

Check the following points once more before requesting repair.

Projector is not recognized.

Has the projector’s power been turned on?

Is the projector supported by the software application? &= “Projectors supported” (page 10)
Have the units been connected properly? &= “Preparation” (page 10)

Has the projector’s network been set up correctly? &= “Setting the Projector” (page 11)
Has an attempt been made to connect 100 or more projectors?

No connection can be made between my projector and my computer

® \When Windows Firewall has been detected

1.

© N O

Enter “Windows Defender Firewall” in the search box of the taskbar and select [Windows Defender Firewall] in the results.
Is this software registered in [Allow an app or feature through Windows Defender Firewall]?

If it is not, add this software in [Allow an app or feature through Windows Defender Firewall].

® Adding procedure

Enter “Windows Defender Firewall” in the search box of the taskbar and then select [Windows Defender Firewall] in
the displayed search results.

When the <Windows Defender Firewall> window appears, click [Allow an app or feature through Windows Defender
Firewall].

When the <Allow apps to communicate through Windows Defender Firewall> window appears, click [Change settings]
— [Allow another app...].

When the <Add an app> dialog box appears, select [Geometry Manager Pro] and click the [Add] button.

If [Geometry Manager Pro] is not in the list, click [Browse], select [GeometryGUI.exe], and click [Open]. [Geometry
Manager Pro] or [GeometryGUI] appears in the [Apps] column.

[Geometry Manager Pro] or [GeometryGUI] appears in the [Allowed apps and features] column.

Select [Private] or [Public] for the network you want to allow connection to and click to select the check box.

Click [OK] in the <Allow apps to communicate through Windows Defender Firewall> window.

This software will now be added to the Windows Defender Firewall's exception application list.

<When another firewall has been detected>

Are any firewall-containing applications installed?

If any applications which contain firewalls are installed, the installation may not complete.

(The firewall function may activate without launch of the application if the application has already been installed.)
If this occurs, firewall settings must be changed in order to allow connection to the network.

See the User’s Manuals for all applications containing firewalls to perform these settings.

Messages that appear when an attempt to uninstall or update the software is made

<Is the "Warning 1910. Could not remove ..." message displayed?>

If an NVIDIA driver is installed on the computer, the following message may appear.

Geometry Manager Pro Ver.1.1.11.0 ﬂ

I ‘Warning 191 0Could not remaowe Shortcut Geometry Manager
Frolnk. werify that the shortcut file exists and that you can
access it.

Click [OK] to continue an uninstall or update procedure.
Although uninstalling the software will also remove the desktop shortcut icons, they will be regenerated when you start
up the computer next time. Manually delete the shortcut icons.
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Frequently Asked Questions

Files cannot be saved.

® Has an attempt been made to save a file that includes values that exceed the range which can be set in the projector?
® Is there enough free memory on the hard disk?
® Do you have the authority to access the folder in which the file is to be saved?
® Does a message appear to notify you that a file required for file saving is damaged?
Perform the following procedure because a file required to generate the data to save is damaged.
1. Open the following folder.

2. Move any file without an extension in the folder to another location. If a warning is displayed to notify you that it is a system file,
select "Yes" to continue the process.
If there are multiple "S-*-*-*-*-*" in the "RSA" folder, perform the following procedure for all of the folders.

3. Execute saving of the setting file (with .prjs or .prjc extension) or the file (with .ugk extension) used for “Multi Monitoring &
Control Software”.

4. Return any file moved in step 2 to its original folder.
If a file overwrite confirmation message appears, select to skip overwriting.

Image correction cannot be performed.

® Have settings been sent to the projector that exceed the range which can be set in the projector?

® Has the projector’s power been turned on?
Some items cannot be set if the projector’s power is not on.

® Are the projector’s input connectors set correctly, and have the correct signals been input?
Some items cannot be set depending on the input connector settings, the types of signals input and whether or not
signals are present.

The bitmap used for masking purposes cannot be loaded.

® Has an attempt been made to load bitmap data which is not in the 1-bit monochrome format?

® Does the bitmap have the appropriate size?
Bitmaps smaller than 8 x 8 pixels and bitmaps larger than 1920 x 1200 pixels (when the resolution of the projector is
1920 x 1200 dots or 1400 x 1050 dots) or 4096 x 2400 pixels (when the resolution is other than the aforementioned)
cannot be used for masking.

Cannot connect to the camera (Auto Screen Adjustment).

® |s the camera turned on?

® |s the camera connected to the computer properly?

® |s there a large number of data files stored on the SD card inserted in the camera?
If camera connection fails, try removing the SD card and performing the camera connection settings again.

@ If there is any SD card inserted in the computer or there is any device other than a camera connected via USB, remove
them all and then reconfigure the settings.

Auto Screen Adjustment does not start.

® You may not be able to execute Auto Screen Adjustment depending on the projector's settings. For details on
operations restricted by the projector's settings, check the information found on the software download page after
logging in to PASS on the following website.
https://panasonic.net/cns/projector/pass/

The image does not fit exactly on flat screens (Auto Screen Adjustment).

® The projected image may not match the edges of the screen exactly if the screen is sagging.
If the top and bottom edges are off:
In the screen setting screen, set the screen type to [Horizontal Curve], and specify at least 3 cursors according to the
shape of the screen.
If the left and right edges are off:
In the screen setting screen, set the screen type to [Vertical Curve], and specify at least 3 cursors according to the
shape of the screen.
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Frequently Asked Questions

Geometry correction results in an images that appears curved (Auto Screen Adjustment).

® This occurs on soft curved screens and on screens with heavy sag.
Correction is performed so that the image appears straight from the point of view of the camera.
Position to the camera so that it is as close as possible to directly facing the screen.

An exposure adjustment error occurs on the camera (Auto Screen Adjustment).

® If the projector is too bright or the screen's gain is high, for example, an exposure adjustment error may occur during

camera settings configuration.
In such cases, attach an ND filter to the camera lens, or lower the brightness of the projector before performing

adjustment again.
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Trademarks

® Microsoft and Windows are registered trademarks or trademarks of Microsoft Corporation in the United States and/or other
countries.

® The terms HDMI, HDMI High-Definition Multimedia Interface, HDMI Trade dress and the HDMI Logos are trademarks or
registered trademarks of HDMI Licensing Administrator, Inc.

® Other company names, product names or other names noted in this manual are trademarks or registered trademarks of the
respective companies. Note that ® and TM marks are not indicated in the text of this manual.

® Unauthorized use or reproduction of part or all of this software and manuals is strictly prohibited.
® Panasonic Connect Co., Ltd. cannot be held liable for any effects resulting from the use of this software and manuals.
® Panasonic Connect Co., Ltd. reserves the right to revise this software specifications and manual contents without notice.

Panasonic Connect Co., Ltd.

Web Site : https://panasonic.net/cns/projector/
© Panasonic Connect Co., Ltd. 2024
W0524AMO -PS
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